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Introduction 
 Infusing Technology into Social Studies is an exciting professional development resource 
for middle and high school teachers. Whether used as a self-study guide or as part of an 
integration course, this innovative approach enables teachers to integrate technology into 
their curriculum after working through the process. 
 
This guide leads social studies teachers through the design, creation and implementation 
of a technology-infused lesson that is based on teachers’ existing instructional plans. As a 
first step, the teacher works through one or several of the 10 included classroom-ready 
sample projects. After review of the samples, a step-by-step guide for the creation of an 
original integrated project follows and includes suggestions for considering teaching 
style, classroom needs, available technology tools, curriculum requirements and relevant 
standards. The organization of the course is flexible, adaptable and builds on teachers’ 
strengths and content knowledge. 
 
Infusing Technology in to Social Studies includes: 
 

 Practical advice for maximizing the benefits from every session 
 

 Ten standards-based projects for use as both samples and as actual classroom 
projects 

 
 Suggestions for adapting the project-creation process to individual teacher needs 

and styles 
 

 A range of Internet resources for social studies and professional development 
 

 A sample student assessment rubric 
 

 Reference and resource material for the software applications used to create 
projects 

 
 A glossary of technology terms 

 
Teachers who are interested in integrating technology into their curriculum will find no 
better resource than Infusing Technology into Social Studies. 
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Required Materials 
 
PC with at least 128 MB of RAM and Internet access 
 
CD-ROM drive 
 
Floppy, Zip or CD-R/W drive 
 
Infusing Technology into Social Studies 2007 course book and CD 
 
Microsoft Office 2007Professional (includes Access, Excel, PowerPoint, Publisher and 
Word) 
 
Microsoft SharePoint Designer 2007 
 
Internet Explorer or Netscape Navigator 
 
Printer (color, if available) 
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Organization of the Course Materials 

Course Book 
The course book is divided into an introduction and four sections containing practical 
advice and simple techniques. 

The Introduction presents an overview of the course and introduces the software 
applications used in each sample project. 

The Sample Projects section includes 10 fully developed technology projects that are 
ready for immediate use in the classroom. The model projects are practical, clearly 
outlined and adaptable to different grade levels. They present a range of technology 
skills and software applications. Each project includes a teacher guide and a student 
handout. The teacher guide includes specific project preparation, evaluation, extension 
activities and enrichment activities. In addition each guide cites relevant standards from 
the National Council for Social Studies (NCSS) and technology standards established by 
the International Society for Technology in Education (ISTE). Projects requiring Internet 
resources include useful Web sites. In addition, a Project Analysis Form provides a 
series of evaluative questions to gauge the effectiveness and usefulness of technology-
infused lessons. 

The Project Creation section is a step-by-step guide through the process of creating, 
developing and implementing original technology projects. It also provides assessment 
tools for evaluating projects. 

The Internet section contains a broad range of excellent professional development and 
social studies resources found on the World Wide Web. 

The Appendices consist of reference material for the software applications on which the 
projects are based, as well as a glossary of useful technology terms. 

CD Contents 
Electronic templates and lesson samples in Office 2007 version. 

Hyperlinks included in the course book 

File-based versions of rubrics and evaluation models 
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Software Applications 
Microsoft Access 2007* A relational database program, Microsoft Access 

integrates and organizes data so that information can be 
found quickly and easily. Users can modify and explore 
existing templates to build an understanding of database 
functions and importance. 

Microsoft Excel 2007* This comprehensive spreadsheet program enables users to 
analyze, report and share data. Microsoft Excel can be 
used to manipulate and analyze data within a spreadsheet, 
as well as create tables, charts and graphs to display 
information.  

Microsoft SharePoint 
Designer 

Microsoft SharePoint Designer allows users to create and 
manage Web pages and sites in an easy-to-learn format. 

Internet Explorer 7.0† This Web browser allows users to connect to the Internet 
and access a wide variety of information. Internet 
Explorer 7.0 enables users to access search engines and 
directories, view Web sites and gain a thorough 
understanding of the Internet. Netscape Navigator may be 
substituted. 

Microsoft PowerPoint 2007* With Microsoft PowerPoint, users can create multimedia 
presentations to illustrate and deliver ideas. 

Microsoft Publisher 2007* This desktop publishing program incorporates a grid 
system that splits parts of the page, providing users with a 
canvas for placing words and pictures. Functions allow for 
manipulation of images, text and graphics. 

Microsoft Word 2007* With this wordprocessing application, users may edit and 
format text, create tables, insert graphics, design headers 
and footers and link information between documents. The 
program features automatic spelling and grammar 
functions as well as Internet capabilities. 

 
*These programs are bundled as part of Microsoft Office 2007 Professional. 
†Internet Explorer is bundled as part of Windows .  It is also available for download at www.microsoft.com.  
 
Microsoft Office 2007 Professional is available in the following languages: Arabic, Basque, Brazilian, 
Chinese-Simplified, Chinese-Traditional, Croatian, Czech, Danish, Dutch, English, French, German, 
Greek, Hebrew, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese, Russian, Slovak, 
Slovenian, Spanish, Swedish, Thai, Turkish and Vietnamese. 
 

For Further Information: 
Microsoft Corporation 

One Microsoft Way 
Redmond, WA 98052-6399, USA 

Sales: (800) 426-9400 
Technical Support: (800) 936-4900 

http://www.microsoft.com 
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Course of Self-Study 

The first step of this course is to review the book. Glance through the sections and skim 
any projects that seem particularly applicable or interesting.  

Set aside approximately two hours for the first session. The experience with the 
technology (and project sampling) during the first session will help gauge the time 
needed for future sessions. The session schedule suggested here should be considered 
only as a guide. Adapt it as needed. 

1. Work through one of the model projects from Module 1 and use the 
Project Analysis Form to note any response. If time permits, sample 
additional projects that require different software applications. 

2. Design a project using the guidelines found in Module 2. Make an 
electronic template if applicable, then create a student handout using those 
found in the sample projects as models. Check the steps by following the 
directions outlined on the student handout. Make any necessary 
adjustments to the project or the handout, then finalize the documentation. 

3. Prepare the project for use in the classroom. Set up the network and 
prepare floppy disks as needed. Make copies of the materials, such as 
handouts and assessment tools. 

4. Implement the project in a classroom setting and have the students work 
through it. Encourage them to work on their own or collaboratively, as 
appropriate. 

5. When the students have finished the project, evaluate its effectiveness by 
using the provided Project Evaluation Rubric, then modify and revise the 
project as necessary. 
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Course Support 
The Futurekids Web site provides further information about the Infusing Technology 
Self-study series. Log on to www.futurekids.com and on the Products page under 
Teacher Curriculum, choose the Infusing Technology link.  

The Customer Service Desk can be reached during the hours of 9 a.m. to 5 p.m. PST at 
(800) 765-8000. 

For e-mail assistance, please direct questions to products@futurekids.com. 
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Module 1: Sample Projects 
This section includes ten fully developed technology projects that introduce one or more 
software applications. In addition, each lesson includes an Internet-based research 
component. Glance over the brief descriptions below as well as the Organizational 
Approaches section on pages 10-11 to decide which project to sample first. Set aside 
approximately two hours for the first self-study session. 

Project Descriptions 

Project 1:  Currency Conversion 

• Microsoft Excel 2007 

• Microsoft Word 2007 

Use the Internet to research and download information about currency conversions. 
Develop a spreadsheet and make charts using information from the Internet, then create a 
report detailing the observations about currency conversion and incorporate conversion 
charts. 

Project 2:  Countries E-Collage  

• Microsoft PowerPoint 2007 

• Microsoft Publisher 2007 

• Microsoft Word 2007 

Use desktop publishing software to create a collage illustrating an ancient civilization, a 
renaissance European country or a contemporary society. Include pictures of important 
people, places and things from the selected country during the specified era. After 
completing the collages, incorporate them into a PowerPoint presentation to be viewed 
and discussed by the class. 

Project 3:  Historical Speeches  

• Microsoft Publisher 2007 

• Microsoft Word 2007 

Use the Internet to locate a famous speech, study it, then answer questions concerning 
content and context to produce an article using desktop publishing applications. 
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Project 4:  Trading Cards 

• Microsoft Publisher 2007 

Use desktop publishing software to create a set of five two-sided trading cards based on a 
time period or a particular event studied in class. The cards will be organized according to 
common thematic areas such as government, culture or politics. Each card will include a 
picture or other graphic on one side and an explanation or description on the other. The 
supplied template will provide a format for the cards, as well as an example of a finished 
card. Use the Internet to find appropriate images and data to complete the cards. 

Project 5:  Chamber of Commerce Web Site  

• Microsoft SharePoint Designer 2007  

Develop a multi-page Web site based on a historical period and place and modeled on a 
representative Chamber of Commerce site. The first phase of the project will involve an 
Internet search for typical town or city sites. Then create a Web site, choosing a specific 
historical time period and location. Gathering information for the Web sites will involve 
further Internet research. 

Project 6:  Ancient Connections Newspaper 

• Microsoft Word 2007 

Use research and creativity to develop the front page of a newspaper that depicts an 
important event in an ancient civilization. Articles should reflect the values, customs and 
significant issues of a specific society during the time period of the specified event. 

Project 7:  Women in History  

• Microsoft Word 2007 

After extensive Internet-based research, use Word to prepare a short research paper about 
the famous historical woman of their choice. Consult various writing-related Web sites for 
step-by-step help with outlining, researching and writing their papers. 

Project 8:  Quality of Life Comparison  

• Microsoft Word 2007 

• Microsoft Excel 2007 

Gather information and compare the quality of life between several countries at differing 
stages of development. After gathering the relevant data, they will analyze and explain 
the various differences they discover and present the data in several formats. 
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Project 9:  Monarchs Database  

• Microsoft Access 2007 

• Microsoft PowerPoint 2007 

Use or modify the supplied database to develop a substantial source of information about 
European ruling monarchs from the 16th century to the present. Use the Internet to locate 
information about different monarchs and expand the database so that it contains enough 
entries to be useful for comparison. Filter the data to compare several rulers and create a 
PowerPoint presentation illustrating the differences. 

Project 10:  Presidential Biography  

• Microsoft PowerPoint 2007 

Perform Internet research to gather information about a former United States president. Use 
this information to create a multimedia presentation about the president’s life, as well as his 
accomplishments during his time in the White House. Afterward, present the multimedia 
reports to the class. 
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Personalizing the Course of Study 

Optimize the self-study sessions by organizing the examination of the projects to fit 
specific needs. It is possible to focus the study by software application, project type or 
personal interests.  

Possible Organizational Approaches: 
Software Application  

Explore one application at a time by sampling several projects that require the same 
software. 

Microsoft Word 

• Project 1 Currency Conversion (with Excel) 
• Project 2 Countries E-Collage (with Publisher and PowerPoint) 
• Project 3 Historical Speeches (with Publisher) 
• Project 6 Ancient Connections Newspaper 
• Project 7 Women in History 
• Project 8 Quality of Life Comparison (with Excel) 

Access 

• Project 9 Monarchs Database (with PowerPoint) 

Excel  

• Project 1 Currency Conversion (with Word) 
• Project 8 Quality of Life Comparison (with Excel) 

SharePoint Designer  

• Project 5 Chamber of Commerce Web Site 

PowerPoint 

• Project 2 Countries E-Collage (with Publisher and Word) 
• Project 9 Monarchs Database (with Access) 
• Project 10 Presidential Biography 

Publisher 

• Project 2 Countries E-Collage (with PowerPoint and Word) 
• Project 3 Historical Speeches (with Word) 
• Project 4 Trading Cards 
• Project 9 Monarchs Database (with Access) 
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Project Type 
Another effective approach is to choose projects that reflect teaching style or curriculum 
requirements. Classes studying specific areas of social studies will benefit from the skill-
based projects below. 

Economic Concerns 

• Project 1 Currency Conversions 

• Project 8 Quality of Life Comparison 

U. S. History 

• Project 3 Historical Speeches 

• Project 4 Trading Cards 

• Project 7 Women in History 

• Project 10 Presidential Biography 

World History 

• Project 2 Countries E-Collage 

• Project 3 Historical Speeches  

• Project 4 Trading Cards 

• Project 6 Ancient Connections Newspaper 

• Project 7 Women in History 

• Project 9 Monarchs Database 

City Government 

• Project 5 Chamber of Commerce Web Site 
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Project 1: Currency Conversion 
Teacher Guide 

Description: 

The students will use the Internet to research and download information about currency 
conversions. They will develop a spreadsheet and make charts using information from the 
Internet. The students will then create a report detailing their observations about currency 
conversion and incorporate their conversion charts. 

Grades: 7-10 

PA Academic Standards: 

Grade 9: 

6.2.9L Markets and the Functions of Governments: Explain how the price of 
one currency is related to the price of another currency (e.g., Japanese yen in 
American dollar, Canadian dollar in Mexican nuevo peso). 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Data from maps, graphs and tables 

Grade 12: 

6.2.12L Markets and the Functions of Governments: Analyze how policies and 
international events may change exchange rates. 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Data presented in maps, graphs and tables 

NCSS Standards: 
4. Use processes important to reconstructing and reinterpreting the past. 
5. Differentiate among various forms of exchange and currency. 
9. Use economic concepts to help explain historical and current developments 

in local, national or global contexts. 

NETS Performance Indicators (Grades 6-8): 

5. Apply productivity/multimedia tools and peripherals to support personal 
productivity, group collaboration and learning throughout the curriculum. 

8. Use appropriate technology to accomplish a variety of tasks and solve 
problems. 
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NETS Performance Indicators (Grades 9-12): 

2. Make informed choices among technology systems, resources and services. 

7. Routinely and efficiently use online resources to meet needs for 
collaboration, research, publications, communications and productivity. 

Internet Applications: 

This project will enhance Internet research skills and strengthen student understanding of 
resources available on the Web. 

Materials: 

Web browser and highlighter markers 
Microsoft Excel 2007 and Microsoft Word 2007 
CURRENCY CONVERSIONS SAMPLE.XLSX 
CURRENCY CONVERSIONS SAMPLE.DOCX 
 
Prerequisite Skills: 

Students should know how to perform Internet-based research. In addition, they should 
be familiar with Word and have basic Excel experience.  

Suggested Time Allotment: two class periods 

Process: 

Discuss the concept of currency conversion. Distribute the Currency Conversion: Student 
Handout and provide an overview. Allow the students time to research conversion 
information on the suggested Web sites. Encourage the class to select commonly known 
countries, as information on more obscure countries may be limited. They will choose 
one country’s currency to research and chart, then enter information from the Internet 
tables into a spreadsheet and construct their own chart. They will also create a Word 
document, importing the charts from Excel. Finally, the students will analyze the chart 
and answer questions about the information gained from their research.  

Evaluation: 

Evaluate the students on the sources they find on the Internet and the quality of their 
charts, focusing on comprehensiveness, appropriate design and effective presentation. 
In addition, assess the observation and higher-level thinking skills they demonstrate in 
their Word documents.  

Extensions: 

Have the students work in small groups to share information about their selected 
currencies with others. Direct them to return to the Web sites where they initially 
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located the conversion information. The students can enter their selected currencies and 
convert them to the currencies of other students in the group, then print off tables and 
compare the conversions. 

Technology Enrichment: 

Using the Word document created in this lesson, have the students review both the chart 
and their prior assertions about the causes of currency fluctuations. The students return to 
the Internet to find support for their theories and to research other possible causes for 
changes in the value of their selected currency. They can use Word to write a short report 
of their findings, and then develop a poster in Microsoft Publisher 2007 to advertise a 
business that converts and exchanges currency. 
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Currency Conversions 
Student Handout 

 Launch the Web browser and access the following Web sites to gather in-depth 
information on currency conversion: 

http://www.oanda.com 
http://www.exchangerate.com 

 After exploring the above sites, select the currency of one country. Later in the 
lesson, information on this country’s conversion rates will be needed to construct a 
spreadsheet using Microsoft Excel 2007. To gather the necessary information for this 
chart, return to the site: http://www.oanda.com. Find the Currency Tools heading on 
the left, and select FXHISTORY.  

 Scroll down and find the two lists of countries. Verify that the left-hand box is set to 
US DOLLAR, so that the conversion will be from U.S. currency. In the right-hand box, 
scroll down to find and select a country. 

 Conversions for three 1-year periods will be needed to create the Excel spreadsheet. 
Enter a starting date and ending date in the format shown for one year. Click GET 
TABLE. If no table appears, the information is unavailable for the selected time period. 
Print the table by selecting FILE → PRINT, then click the BACK button to return to the 
previous Web page. Repeat this process twice, entering different dates each time and 
printing the results. Choose dates occurring during a wide range of years, for example 
1975, 1987 and 1999. Exit the Web browser. 

 Select one table printed from the Internet, then choose the first date of each month 
and highlight it with a highlighting marker. Highlight the same days and months for 
the second and third tables. For example, 08/01/75, 08/01/87 and 08/01/99.  

 Launch Excel. Create a spreadsheet by entering Date in cell A1. Enter the dates 
(month and day only) in cells A2 through A13. Next, select column A, then from the 
HOME TAB in the NUMBER GROUP choose More Number Formats from the drop down 
list and in the Category box, choose DATE. Select a type that displays only month 
and day. Click OK. 

 In cell B1, enter the earliest year of the conversion table. In cells C1 and D1 enter the 
subsequent years. Begin with the earliest year. In column B, enter the conversion 
amounts highlighted on the table printed from the Internet. Continue the process, 
entering the highlighted amounts for the following years in columns C and D. 

 After entering the data, select cells B2 through D13. In the NUMBER GROUP choose 
More Number Formats, and in the Category box, choose CURRENCY. Next, click the 
SYMBOL drop-down arrow, and scroll down to the correct currency symbol. Choose 
OK. 
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 Make a chart to compare the information. Select cells A2 through D13 then from the 
INSERT TAB under CHARTS GROUP, click on LINE and choose the first chart type in the 
first row.  

 With the chart selected, on the DESIGN TAB under the DATA GROUP, choose SELECT 
DATA and under the box labeled Legend Entries (Series), highlight the SERIES and 
click on the EDIT button to enter the dates of the years for each of the three (3) SERIES. 
Click OK. 

 Click on the Chart Title, highlight the text and enter Currency Conversion – (country 
name, currency name). Click on the Axis title, highlight the text and enter Conversion 
from One US Dollar as the Y axis.  Next, click the LAYOUT TAB and under the LABELS 
GROUP, click AXIS TITLES.  Click Primary Horizontal Axis title → Title Below Axis.  
Enter Date as the X axis.  On the HOME TAB, click on the COPY button in the 
CLIPBOARD GROUP.  Save the file and exit Excel. 

 Launch Microsoft Word 2007. Press ENTER several times, then click on the HOME 
TAB, click on PASTE → PASTE SPECIAL and click on the PASTE LINK radio button and 
select the MICROSOFT OFFICE EXCEL CHART OBJECT from the list. Click OK.  Verify that 
the Excel chart appears in the new Word document. Resize the chart by positioning 
the cursor above one of the resizing handles appearing around the edges of the frame. 
When the cursor appears as a double-sided arrow, hold down the mouse button and 
drag to resize the chart. Double-click the chart to access editing features under the 
PAGE LAYOUT and FORMAT TABS. Select different areas of the chart and experiment 
with fonts, fill colors or patterns, line colors and widths, etc... Be certain that the 
stylistic choices do not make the information difficult to read. Save the Excel file and 
return to Word. 

 Create a WordArt title at the top of the document. From the INSERT TAB, choose 
WORDART, enter a title that includes the name of the country and its currency and 
click OK.  Adjust color, shape, fonts, etc. from the FORMAT TAB. Adjust the size and 
position as necessary. 

 Move the cursor below the WordArt title. List and answer the following questions: 

1. Which year showed the most fluctuation in currency values? The least? 

2. Suggest three factors that might have been responsible for the change. 

3. Of the three possibilities, choose the one that seems to be the most likely 
cause and explain why. 

 Save and print the file, then exit Word and Excel. 
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Project 2: Countries E-Collage 
Teacher Guide 

Description: 

The students will use desktop publishing software to create a collage illustrating an 
ancient civilization, a renaissance European country or a contemporary society. They will 
need to include pictures of important people, places and things from the selected country 
during the specified era. After completing the collages, the students will incorporate them 
into a Microsoft PowerPoint 2007 presentation to be viewed and discussed by the class. 

Grades: 7-9 

PA Academic Standards: 

Grade 9: 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Different historical perspectives 

• Data from maps, graphs and tables 

• Visual data presented in historical evidence  

8.1.9C Historical Analysis and Skills Development: Analyze the fundamentals 
of historical interpretation. 

• Reasons/causes for multiple points of view 

• Illustrations in historical documents and stories 

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical event (time and place) 

8.4.9B World History: Analyze historical documents, material artifacts and 
historic sites important to world history before 1500. 

NCSS Standards: 

1. Compare similarities and differences in the ways groups, societies and 
cultures meet human needs and concerns. 

3. Identify and describe selected periods and patterns of change within cultures. 

4. Identify and use processes important to reconstructing and reinterpreting 
the past. 
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NETS Performance Indicators (Grades 6-8): 

4. Use content-specific tools, software and simulations (e.g., environmental 
probes, graphing calculators, exploratory environments, Web tools) to 
support learning and research. 

8. Select and use appropriate technology to accomplish a variety of tasks and 
solve problems. 

NETS Performance Indicators (Grades 9-12): 

7. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision-making in content learning. 

Internet Applications: 

This project will enhance Internet research skills and strengthen student awareness of 
resources on the Web. 
 

Materials: 

Web browser 

Microsoft Publisher 2007, Microsoft PowerPoint 2007 and Microsoft Word 2007 

ANCIENT COLLAGE.PPTX, RENAISSANCE COLLAGE.PPTX and CONTEMPORARY 
COLLAGE.PPTX 

Prerequisite Skills: 

Students should be proficient in performing Internet-based research. They should also 
have experience with Publisher and PowerPoint. 

Suggested Time Allotment: three class periods 

Process: 

Ensure that the template folder, which includes the ANCIENT COLLAGE.PPTX, 
RENAISSANCE EUROPEAN COLLAGE.PPTX and CONTEMPORARY COLLAGE.PPTX PowerPoint 
templates are installed on each computer. Before introducing the activity, create a sign-up 
sheet with 10 civilizations/countries for each category. Discuss and provide examples of 
ancient civilizations, European countries during the Renaissance and contemporary 
societies, then direct the students to sign up for one country from the category of their 
choice. Display a sample collage and review its components and attributes. Announce the 
eventual inclusion of all student collages in a PowerPoint presentation. 
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Evaluation: 

Evaluate the students on the sources they find on the Internet. Assess the information and 
elements included in the collage, as well as its design and overall appearance. 

Extensions: 

After viewing the PowerPoint presentations as a group, compare and contrast the 
graphical items included on the slides for the three different time periods. Use a flip chart 
to create a list of similarities and differences for the class during the discussion. 

Technology Enrichment: 

Using previous Internet resources, have the students expand their one-page collage into a 
separate PowerPoint presentation based on the selected civilization or country. 
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Countries E-Collage 
Student Handout 

 Before opening the Web browser, identify keywords related to the civilization or 
country selected from the sign-up sheet. Launch the Web browser and initiate an 
Internet search for information concerning the topic. 

 Save photos and other graphics for the collage by positioning the pointer on the 
desired image, then right-clicking the mouse button. Choose SAVE PICTURE AS, select 
the appropriate folder and click SAVE. 

 While browsing, search for important people, dates, quotes, inventions, sounds and 
other appropriate information. Bookmark useful sites. Launch Microsoft Word 2007. 
Copy and paste useful information from the Internet into the Word document to use in 
preparing the presentation. Highlight pertinent information on a Web page and choose 
EDIT → COPY. Return to the Word document and select PASTE from the CLIPBOARD 
GROUP on the HOME TAB. 

 Task-switch between the Web browser and Word by holding down the ALT key and 
pressing ESCAPE, or by selecting the desired application in the Quick Launch toolbar at 
the bottom of the window. Review the material discovered on the Internet. Make a 
sketch on paper of the layout of the collage, i.e., the location of title, graphics and text. 

 Minimize Word and launch Microsoft Publisher 2007. Click on BLANK PAGE SIZES 
under POPULAR PUBLICATION TYPES and decide which layout would work best for the 
collage.  Double-click on the chosen layout. 

 Click the WORDART tool        in the left-hand Formatting toolbar and select a Word 
Art Style → OK.  Enter the text to display the name of the civilization or country → 
OK. Experiment with shapes and fonts by using the drop-down arrows for each 
category. 

 Use the PICTURE FRAME tool in the left toolbar  to make frames. Choose picture 
from file from the pop-up window. This will directly open up the Insert Picture 
dialogue box. Locate an image previously saved from the Internet exploration, then 
click INSERT to add it to the collage. Repeat the process for each image. Remember 
to create a new frame for each graphic. 

 To add text, select the TEXT FRAME button in the left toolbar , then hold down the 
mouse button and drag to create a text box. Maximize Word. Copy important words, 
quotes or phrases and paste them in the text boxes in the Publisher document. Task-
switch between the applications as shown above. Notice that the PASTE OPTIONS 
Smart Tag will appear in Publisher 2007, which allows you to keep prior formatting 
if desired. When finished, exit Word. 
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 In Publisher, use WordArt or experiment with different fonts, sizes and colors by 
selecting FORMAT → FONT. Add borders and fill text boxes with colors and patterns 
by selecting the FILL COLOR   button and choosing FILL EFFECTS. 

 To make the e-collage more visually interesting, select a graphic or a text box. Click 
the ROTATE button  in the top bar and rotate the box to different angles. Repeat this 
process with as many boxes as desired. 

 Further improve the appearance of the collage by layering graphics and text boxes. 
Select a text or graphic, then select the desired orientation from the drop-down arrow 

next the BRING TO FRONT tool  on the Standard toolbar. 

 Save the collage. Name the file according to the selected topic, then exit Publisher. 

 Launch Microsoft PowerPoint 2007. Click on the MICROSOFT OFFICE button and 
choose OPEN, then find the appropriate template: ANCIENT COLLAGE.PPTX, 
RENAISSANCE COLLAGE.PPTX or CONTEMPORARY COLLAGE.PPTX and click OPEN. From 
the HOME TAB, click on NEW SLIDE under the SLIDES GROUP. Choose the blank slide.  

 From the DESIGN TAB, explore various style options.  

 Minimize the PowerPoint presentation and launch Microsoft Publisher 2007. Select 
FILE → OPEN, then locate and open the collage file. Choose EDIT → SELECT ALL, then 
EDIT → COPY.  

 Maximize the PowerPoint presentation in the Quick Launch toolbar. Navigate to the 
appropriate slide, then click on the HOME TAB → PASTE SPECIAL → PICTURE to add the 
collage to the presentation. Adjust and resize as necessary.  

 Add a transition to the slide by clicking on the animations tab and from the transition 
to this slide group, select the desired type, sound and speed of slide transition.  

 Save the file and exit PowerPoint and Publisher. 
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Project 3: Historical Speeches 
Teacher Guide 

Description: 

The students will use the Internet to locate a famous speech, study it, then answer questions 
concerning its content and context. The students will then act as magazine correspondents, 
reporting the event and producing an article using desktop publishing applications.  

Grades: 8-11 

PA Academic Standards: 

Grade 9: 

5.1.9M Principles and Documents of Government: Interpret the impact of 
famous speeches and writings on civic life (e.g., The Gospel of Wealth, 
Declaration of Sentiments). 

8.1.9A Historical Analysis and Skills Development: Analyze chronological 
thinking. 

• Context for events 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Literal meaning of historical passages 

8.1.9C Historical Analysis and Skills Development: Analyze the fundamentals 
of historical interpretation. 

• Illustrations in historical  documents and stories 

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical questions  
• Primary sources 
• Secondary sources 

Grade 12: 

5.1.12M Principles and Documents of Government: Evaluate and analyze the 
importance of significant political speeches and writings in civic life (e.g., Diary 
of Anne Frank, Silent Spring). 

8.1.12A Historical Analysis and Skills Development: Evaluate chronological 
thinking. 

• Context for events 
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8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Literal meaning of historical passages 

8.1.12C Historical Analysis and Skills Development: Evaluate historical 
interpretation of events. 

• Illustrations in historical stories and sources 

8.1.12D Historical Analysis and Skills Development: Synthesize historical 
research. 

• Historical questions  
• Primary sources 
• Secondary sources 

NCSS Standards: 

4. Identify and use processes important to reconstructing and reinterpreting 
the past. 

8. Explain and apply concepts such as power, role, status, justice and influence 
to the examination of persistent issues and social problems. 

NETS Performance Indicators (Grades 6-8): 

8. Select and use appropriate tools and technology to accomplish a variety of 
tasks and solve problems. 

10. Research and evaluate the accuracy, relevance, comprehensiveness and bias 
of electronic information sources concerning real-world problems. 

NETS Performance Indicators (Grades 9-12): 

7. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 

Internet Applications: 

This project will develop and enhance Internet research skills and will strengthen student 
knowledge of resources available on the Web. 

Materials: 
Web browser 
Microsoft Word 2007 and Microsoft Publisher 2007 
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Prerequisite Skills: 

The students should have experience working with Word and Publisher. In addition, they 
should also understand Internet-based research methods. 

Suggested Time Allotment: two class periods 

Process: 

The students will use the Internet to locate a famous historical speech. Allow them to 
choose a speech that interests them, perhaps limiting their choices to a particular time 
period or region. The students will copy and paste the speech into a Word document, then 
highlight important ideas and concepts. Next, they will develop an outline for their 
magazine articles using the list of questions below. (Be sure to discuss the vocabulary 
and issues involved in these questions.) 

1. Who is the intended audience? 

2. Does the speech appeal to logic or emotion? 

3. Is the tone of the speech demagogic or idealistic? 

4. What is the historical backdrop of the speech? 

The students will then act as journalists who experienced the speech in person. They will 
save information concerning the speechmaker and related graphics from the Web. Using 
Publisher, the students will create a magazine article, complete with text and graphics. 

Evaluation: 

Evaluate the students on the sources they discover on the Internet. Use the magazine 
article to assess writing skills and overall understanding of the context and content of the 
speech. In addition, consider the visual impact and layout of the article. 

Extensions: 

Assemble the students according to speeches that share similar subject matter or time 
periods. Direct them to discuss their magazine articles with the group, focusing on 
similarities and differences of the opinions presented in the speeches. 

Technology Enrichment: 

Group students by similar time periods or themes. Ask them to use Publisher to create a 
magazine incorporating the speeches they have studied and other related articles. 
Encourage them to create a cover design and include several period- or subject-
appropriate advertisements in their magazine. 
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Historical Speeches 
Student Handout 

 Launch Microsoft Word 2007, then minimize the window. 

 Open the Web browser and use the following hyperlinks to locate historical speeches. 

http://www.historyplace.com/speeches/previous.htm 

http://www.law.ou.edu/hist 

http://www.hpol.org/ 

 Skim through speeches that appear interesting, then select one. Highlight the entire 
text and select EDIT → COPY. Select the Word document in the Quick Launch toolbar 
at the bottom of the screen and choose PASTE from the CLIPBOARD GROUP on the HOME 
TAB. Verify that the speech now appears in Word. Notice the PASTE OPTIONS Smart 
Tag will appear in Word 2007, which allows the user to keep prior formatting if 
desired. 

 Reformat the text as necessary. Select the HIGHLIGHT tool  in the FONT GROUP 
on the HOME TAB, then click the drop-down arrow and select a light color. Read 
through the speech, highlighting important phrases and keywords. Save and print the 
document and then exit Word. 

 Acting as a journalist of the time who experienced the event, plan and create a 
magazine article. Make a sketch of a possible layout, including titles, text and pictures. 

 Develop an outline for the written portion of the article. Be certain to address the 
following questions about the speech: 

Who is the intended audience?  
Does the speech appeal to logic or emotion?  
Is the tone of the speech demagogic or idealistic?  
What is the historical backdrop? 

 Launch Microsoft Publisher 2007. Click on BLANK PAGE SIZES under POPULAR 
PUBLICATION TYPES and decide which layout would work best for the collage.  

Double-click on the chosen layout.  Click the WORDART tool in the left Formatting 
toolbar, select the shape of your choice and click OK. Enter the title of the article and 

click OK. Click on the FORMAT WORDART tool on the WordArt toolbar. In the 
COLORS AND LINES TAB, click on the drop-down arrow under Fill Color and Line 
Color to change the color of the WordArt.  Click OK. 
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 Referring to the sketched layout, determine how many columns will be needed for the 
publication. Select ARRANGE → LAYOUT GUIDES. Under GRID GUIDES, choose the 
desired number of columns and/or rows and click OK. Use these lines for text and 
graphics placement. 

 Select the TEXT tool , in the left toolbar and insert a text box in the first column. 
Referring to highlights of the speech, write about the event. When the first column is 
filled, the overflow icon will appear at the bottom of the frame . This indicates 
there is more text than will fit in the current frame.  

 Decide if the text should continue into the next column on page one or into a new 
column on page two. Create a new text box in the next column on the first page or 
insert a second page by choosing INSERT → PAGE. Notice the same number of 
columns will appear on the next page.  

 On the first page, click the overflowing text frame, then choose the CREATE TEXT 
BOX LINK button  on the top toolbar. The pointer will turn into a pitcher.  
Click the new text frame (located on either page 1 or 2) and the remainder of the text 
will flow into it. Continue writing the article, creating and connecting new text 
frames as needed.  

 When the article is complete, write a column or editorial regarding the issues 
addressed in the speech. To complete the magazine article, return to the Web 
browser and search for related pictures and graphics. Save photos and other graphics 
by right-clicking the desired image, then choosing SAVE PICTURE AS. Images can also 
be collected from Clip Art or copied and pasted from a multimedia encyclopedia.  

 After gathering images, return to the Publisher document. Select the PICTURE FRAME 
tool  and choose PICTURE FROM FILE in the pop-up window to create a graphics 
frame. This will directly open up the Insert Picture dialogue box. Locate an image 
previously saved from the Internet exploration, then click INSERT to add it to the 
article. Repeat the process for each image. Remember to create a new frame for each 
graphic. 

 If only a portion of the picture is needed, select the graphic and choose the CROP 
PICTURE tool  from the Picture toolbar. Position the pointer on any frame handle, 
hold down the mouse button and drag inward to eliminate unnecessary portions of the 
image. Adjust the size and position of the picture as desired. If a picture interferes 
with text, select the picture, click on the TEXT WRAPPING tool      on the Picture 
toolbar and click TIGHT. When it asks you if you want Publisher to create a new wrap 
boundary, click YES.  

 When all pictures and text are complete, spend time making the article more visually 
appealing. For text or picture boxes, select FORMAT and experiment with borders, fill 
colors, fill patterns, shading and shadows. Highlight various text and try different 
fonts and colors. Save and print the file. Exit Publisher. 
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Project 4: Trading Cards 
Teacher Guide 

Description: 

The students will use desktop publishing software to create a set of five two-sided trading 
cards based on a time period or a particular event studied in class. They will organize the 
cards according to common thematic areas such as government, culture or politics. Each 
card will include a picture or other graphic on one side and an explanation or description on 
the other. The supplied template will provide a format for the cards, as well as an example 
of a finished card. The students will use the Internet to find appropriate images and data to 
complete the cards. 

Grades: 9-11 

PA Academic Standards: 

Grade 9: 

8.1.9A Historical Analysis and Skills Development: Analyze chronological 
thinking. 

• Context for events 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Data from maps, graphs and tables 
• Visual data presented in historical evidence  

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical event (time and place) 

Grade 12: 

8.1.12A Historical Analysis and Skills Development: Evaluate chronological 
thinking. 

• Context for events 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Data presented in maps, graphs and tables 
• Visual data presented in historical evidence 

8.1.12D Historical Analysis and Skills Development: Synthesize historical 
research. 

• Historical event (time and place) 
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NCSS Standards: 

1. Apply an understanding of culture as an integrated whole that explains the 
functions of language, literature, the arts, traditions, beliefs and values and 
behavior patterns. 

9. Analyze relationships between national sovereignty and global interests, in 
such matters as territory, economic development, defense, natural resources 
and human rights. 

NETS Performance Indicators (Grades 9-12): 

7. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 

Internet Applications: 

This project will use and enhance Internet research skills and help to familiarize students 
with resources on the Web. 

Materials: 

Web browser and Microsoft Publisher 2007 

SOCIAL STUDIES TRADING CARD.PUB template 

scissors, heavy card stock and glue or paste 
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Prerequisite Skills: 
Students should be familiar with desktop publishing, as well as the basic functions of 
Publisher. They also should be proficient in Internet-based research techniques. 

Suggested Time Allotment: three class periods 

Process: 

Make sure that the template folder is installed on all computers or the class server. Ask 
the students to open SOCIAL STUDIES TRADING CARD.PUB and note the different elements 
on the two sides of the cards. They will delete these elements and replace them with new 
information and graphic elements. Distribute the Trading Cards Student Handout and 
review the process. 

Evaluation: 

Evaluate the students on the originality of their ideas, as well as the quality of the images 
and data they select for their projects. Their final set of trading cards should reflect an 
understanding of key elements of the event or time period. 

Extensions: 

Have the students work in small groups to compare individual trading cards, make 
judgments on duplications and combine cards to produce a group set that provides an 
effective overview of the event or time period itself. 

Technology Enrichment: 

Ask students to produce a Microsoft PowerPoint 2007 presentation using the front part of 
the cards as slides. Direct them to create a recorded sound track, including music and a 
reading of the information on the back of the cards. 
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Trading Cards 
Student Handout 

 Decide on a historic time period or particular event as directed. This will be the 
focus of the five new trading cards to be created in this lesson. Choose a subject for 
each of the cards and consider what pictures or graphics would best reflect the 
subject. In addition, think about the type of information that would be appropriate for 
side two of each card. 

 Launch Microsoft Publisher 2007 and open the SOCIAL STUDIES TRADING CARD.PUB 
template. This is a sample of how each finished trading card should look. These 
elements will be deleted in the following steps, and new graphics and information 
will be provided on the selected topic. Choose FILE → SAVE AS and save the 
template under a new filename. Minimize Publisher. 

 Launch the Web browser and access a search engine to locate an appropriate picture or 
graphic for the first card. To save graphics, position the cursor above the appropriate 
image and right-click the mouse button. Choose SAVE PICTURE AS, click the correct 
location on the hard disk drive, then select SAVE. 

 Maximize Publisher and delete the picture frame from side one of the new template. 
Insert the new picture chosen for this card. Size it to fit the frame by positioning the 
cursor over one of the resizing handles that surround the image. To reposition the 
image, place the cursor on it until the four-way arrow appears. Hold down the mouse 
button and drag to the desired location. 

 Click the border on side one and delete it. Insert a new border from the Design 
Gallery that complements the image. Select INSERT → DESIGN GALLERY OBJECT, click 
BORDERS.  Double-click the desired border. Size the frame to fit side one of the card 
by following the same steps as above for resizing and repositioning an image. To 
change the color of the border, double-click on the portion of the border you wish to 
change. Make sure the COLORS AND LINES TAB is selected and choose a color under 
Fill Color. For additional choices, click on FILL EFFECTS.  

 Highlight the text in the larger text frame under the image on side one and delete it. 
Enter appropriate text to identify the image and to explain its historical significance. 
Highlight the text in the smaller text frame on the bottom of side one, then delete it, 
and enter related information as appropriate. 

 Format the color and pattern of the background and text boxes on side one to fit 
thematically and visually with the card. Adjust font size as appropriate. 

 Highlight the text on side two of the card. Enter a key concept of the era or event at 
the top of the card and include any additional information. Save the new trading card 
using a specific filename, such as DEBATE 2000-1. Note: The cards must be saved 
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individually, so change the number at the end of the filename for each new card. For 
example, for the above file, the name of the second card would be DEBATE 2000-2. 

 Repeat these steps for cards two through five. Review the appearance and content of 
each card and make any desired changes. Be certain that the stylistic choices do not 
make the information difficult to read. 

 Print all five cards on heavy stock. Make sure each of the cards is saved. Exit Publisher. 

 Cut and fold each card so that side one and side two are back to back, then paste the 
two sides together. 
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Project 5: Chamber of Commerce Web Site 
Teacher Guide 

Description: 

The students will develop a multi-page Web site based on a historical period and place 
and modeled on a representative chamber of commerce site. The first phase of the project 
will involve an Internet search for typical town or city sites. The students will then create 
their own Web sites, choosing a specific historical time period and location. Gathering 
information for the Web sites will involve further Internet research. 

Grades: 9-11 

PA Academic Standards: 

Grade 9: 

7.3.9A The Human Characteristics of Places and Regions: Explain the human 
characteristics of places and regions by their population characteristics.  

• Demographic structure of a population (e.g., life expectancy, fertility rate, 
mortality rate, infant mortality rate, population growth rate, the demographic 
transition model)  

7.3.9B Human Characteristics of Places and Regions: Explain the human 
characteristics of places and regions by their cultural characteristics. 

• Culture distribution (e.g., ethnic enclaves and neighborhoods) 

8.1.9A Historical Analysis and Skills Development: Analyze chronological 
thinking. 

• Context for events 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Data in historical and contemporary maps, graphs, and tables 
• Different historical perspectives 
• Data from maps, graphs and tables 
• Visual data presented in historical evidence  

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical event (time and place) 
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Grade 12: 

7.3.12A Human Characteristics of Places and Regions: Analyze the 
significance of human activity in shaping places and regions by their population 
characteristics. 

• Demographic trends and their impacts on patterns of population distribution 
(e.g., carrying capacity, changes in fertility, changes in immigration policy, 
the mobility transition model) 

8.1.12A Historical Analysis and Skills Development: Evaluate chronological 
thinking. 

• Context for events 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Data in historical and contemporary maps, graphs and tables 
• Different historical perspectives 
• Data presented in maps, graphs and tables 
• Visual data presented in historical evidence 

8.1.12D Historical Analysis and Skills Development: Synthesize historical 
research. 

• Historical event (time and place) 

NCSS Standards: 

1. Answer questions such as: What are the common characteristics of different 
cultures? How do belief systems, such as religion or political ideals, 
influence other parts of the culture? 

2. Understand historical roots and know how to read and reconstruct the past in 
order to develop a historical perspective. 

4. Understand how personal identity is shaped by one’s culture, groups and 
institutional influences. 

10. Understand how civic ideals and practices of citizenship are critical to full 
participation in society and is a central purpose of social studies. 

NETS Performance Indicators (Grades 9-12): 

2. Make informed choices among technology systems, resources and services. 

7. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 

10. Collaborate with peers, experts and others to contribute to a content-related 
knowledge base by using technology to compile, synthesize, produce and 
disseminate information, models and other creative works. 
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Internet Applications: 

Students will use their Internet research skills and work on Web design. 
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Materials: 
Web browser  
Microsoft SharePoint Designer 2007 

Prerequisite Skills: 
Students should have strong skills conducting Internet research by using a variety of search 
engines. In addition, they should be familiar with Web page design using SharePoint 
Designer 2007. 

Suggested Time Allotment: three class periods plus homework time 

Process: 

Explain to the students that many cities use Web sites to attract business and tourism. 
Discuss some of the advantages of this technique as a marketing tool. Distribute the 
Chamber of Commerce Web Site Student Handout and review the process with the 
students. Have them examine the picture of the sample home page on the handout for 
possible ideas. Suggest that the project will allow them to be creative and even humorous 
in their approach. 

Evaluation: 

Evaluate the students on the quality of their research, the format of their chamber of 
commerce Web site, and the accuracy of the information they develop for linked pages. 

Extensions: 

This project provides a natural segue to a discussion of the impact of environment and 
cultural mores on historical events. The students should consider how effectively they have 
reflected the period and the setting in their Web sites. 

Technology Enrichment: 

Ask the students to plan and design a home page for one of the major historical events 
from a selected period and region. They should think about which hyperlinks would be 
appropriate to include on the home page. 
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Chamber of Commerce Web Site 
Student Handout 

 Following the teacher’s instructions, choose a historical period and place for the 
subject of the Web site. 

 Launch the Web browser and initiate an Internet search for the chamber of commerce 
Web sites of several cities and towns. Take ample notes on the format of these pages. 

 Pay close attention to the types of introductory information, supporting topics, 
hyperlinks and graphics typically featured on many chamber of commerce Web sites. 
Bookmark the Web pages that will be most helpful. 

 Sketch a layout of the different elements of the home page to use as a guide. Take 
note of which hyperlinks will be included. 

 Launch Microsoft SharePoint Designer 2007. Click FILE → NEW → WEBSITE and 
on the WEBSITE TAB in the NEW dialog box, click ONE PAGE WEB SITE → OK.   

 Select VIEW, click NAVIGATION PANE and double-click the house icon. On the new 
page (DEFAULT.HTM), enter Chamber of Commerce Home Page. 

 
Sample of Gettysburg, Pennsylvania, Chamber of Commerce home page 

on the eve of the Civil War battle 
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 Using the sketched layout as a guide, enter the appropriate text, graphics, and design 

elements on the home page. Choose FORMAT → FONT to adjust spacing, font type, style 
and size. Select FORMAT → BORDERS AND SHADING to experiment with different border 
frame and fill options. Refer to the previously bookmarked Web sites for ideas. 

 Determine which elements of the home page will serve as hyperlinks to other pages 
on the Web site or to external Web sites in other locations. Then select VIEW and click 
NAVIGATION PANE.  

 Click the NEW DOCUMENT button  on the top toolbar to insert the number of pages 
under the home page. This number should represent the number of hyperlinks created 
on the home page. Note: When incorporating a link to a Web page outside of the site, 
be certain not to create a new page for that hyperlink. 

 Click the UNTITLED_1.HTM tab and enter the desired text, graphics and design 
elements on the blank page. Refer to the sketch as needed. Remember, this page is 
linked to the home page. It should provide detailed information about a particular 
subtopic of the overall Web site.  

 Click the DEFAULT.HTM tab to return to the home page (DEFAULT.HTM). Highlight the 
text or image that will provide the hyperlink to the newly formatted UNTITLED_1. 
Now click INSERT → HYPERLINK to create the appropriate hyperlink. 

 Repeat the previous two steps for each new hyperlink on the home page. If an 
external hyperlink will be included, be sure to enter the correct Web page address in 
the URL window in the Edit Hyperlink dialog box. 

 Choose FORMAT → PAGE TRANSITION to include special page transitions as desired.  
To insert sound or music, choose FILE → PROPERTIES and on the GENERAL TAB, select 
the BROWSE button in the BACKGROUND SOUND GROUP.  Locate the desired music or 
sound clip and click OPEN.  Make sure that the FOREVER checkbox is selected or 
choose a number in the Loop spin box, then click OK. 

 Rename each page in the Web site so it reflects the content that has been entered. For 
example, UNTITLED_1 might be renamed Business Opportunities. 

 Examine each page in the Web site and make any adjustments or changes to format, 
color, text appearance and size as desired. Remember, the stylistic choices should not 
make the information difficult to read. 

 Select FILE → SAVE ALL and enter an appropriate filename. While in Page view, select 
FILE → PREVIEW IN BROWSER and choose the appropriate Web browser.  Navigate 
through the website to ensure that the hyperlinks and formatting function correctly.  
Make any necessary adjustments or changes. Save any final changes and exit 
SharePoint Designer. 
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Project 6: Ancient Connections Newspaper 
Teacher Guide 

Description: 

The students will research and use their own creativity to develop the front page of a 
newspaper that depicts an important event in an ancient civilization. Their articles 
should reflect the values, customs and issues of a specific society during the time period 
of the specified event. 

Grade Levels: 7-10 

PA Academic Standards: 

Grade 9: 

7.3.9B The Human Characteristics of Places and Regions: Explain the human 
characteristics of places and regions by their cultural characteristics. 

• Ethnicity of people at national levels (e.g., customs, celebrations,  
languages, religions)  

• Culture distribution (e.g., ethnic enclaves and neighborhoods) 
• Cultural diffusion (e.g., acculturation and assimilation, cultural revivals of 

language) 

8.1.9A Historical Analysis and Skills Development: Analyze chronological 
thinking. 

• Context for events 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Data in historical and contemporary maps, graphs, and tables 
• Different historical perspectives 

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical event (time and place) 

Grade 12: 

7.3.12B The Human Characteristics of Places and Regions: Analyze the 
significance of human activity in shaping places and regions by their cultural 
characteristics. 

• Cultural conflicts (e.g., over language (Canada), over political power 
(Spain), over economic opportunities (Mexico)) 
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• Forces for cultural convergence (e.g., the diffusion of foods, fashions, 
religions, language) 

8.1.12A Historical Analysis and Skills Development: Evaluate chronological 
thinking. 

• Context for events 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Data in historical and contemporary maps, graphs and tables 
• Different historical perspectives 

8.1.12D Historical Analysis and Skills Development: Synthesize historical 
research. 

• Historical event (time and place) 

NCSS Standards: 

1. Explain how people from diverse cultural perspectives and frames of 
reference may interpret data and experiences differently. 

2. Identify and use processes important to reconstructing and reinterpreting 
the past, such as using a variety of sources, providing, validating and 
weighing evidence for claims, checking credibility of sources and 
searching for causality.  

5. Analyze group and institutional influences on people, events and culture. 

NETS Performance Indicators (Grades 6-8): 

5. Apply productivity/multimedia tools and peripherals to support personal 
productivity, group collaboration and learning throughout the curriculum. 

6. Design, develop, publish and present products (e.g., Web pages, videotapes) 
using technology resources that demonstrate and communicate curriculum 
concepts to audiences inside and outside the classroom. 

8. Use appropriate technology to accomplish a variety of tasks and solve 
problems. 

NETS Performance Indicators (Grades 9-12): 

5. Use technology for managing and communicating information (e.g., finances, 
schedules, addresses, purchases, correspondence). 

6. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision-making in content learning. 
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Internet Applications: 

Students will refine their research skills and become more proficient at Web design. 

Materials: 

Web browser 

Microsoft Word 2007  

NEWS SAMPLE.DOCX  

Prerequisite Skills: 

The students should have experience using a Web browser and Word. 

Suggested Time Allotment: two to three class periods 

Process: 

Distribute the Ancient Connections Newspaper: Student Handout and provide an overview 
of the project. Explain that the students will use the Internet to research a particular 
historical occurrence from an ancient civilization. They should get details about the time 
period and any societal issues related to the event. The students will then act as newspaper 
editors and reporters, designing the front page of a newspaper that might have been 
published at the time the incident took place. They will use their research and their own 
imaginations to create a credible artifact. When the projects are complete, distribute copies 
and have the students explain the content of their front pages to the class. Note: Print the 
NEWS SAMPLE.DOCX file to display as a sample, but do not distribute the file to the students. 

Evaluation: 
Evaluate the students on their research as well as the originality of the layout and 
presentation of “news” included in the project. 

Extensions: 
Suggest that the students take the front page designed by one of their classmates and 
write a related “lead article” for an edition of the newspaper to be published a week 
after the original. 

Technology Enrichment: 
Direct the students to locate additional information and graphics on their topic, then to 
convert their front page into a Web site by using Microsoft SharePoint Designer 2007. 
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Ancient Connections Newspaper 
Student Handout 

 Choose a historical event from an ancient civilization to use as the basis for the 
newspaper’s front page. Then launch the Web browser and access the following sites: 

http://eawc.evansville.edu 

www.multnomah.lib.or.us/lib/homework/anchsthc.html 

www.fordham.edu/halsall/ancient/asbook.html 

 Find useful information about the specific incident and the ancient civilization 
where it took place. Research facts about the event as well as information about 
daily life, politics, customs and important issues of the time. Bookmark useful Web 
pages for future reference. 

 Launch Microsoft Word 2007. Copy useful information from the Internet and paste it 
into the Word document. From the Web browser, simply highlight the data to be 
saved, then choose EDIT → COPY. Task-switch back to Word by holding down the ALT 
key and pressing the ESCAPE key, or by choosing the appropriate application in the 
Quick Launch toolbar at the base of the window. Next, in the Word document, choose 
PASTE from the CLIPBOARD GROUP on the HOME TAB.   The PASTE OPTIONS Smart Tag 
will appear in Word 2007, which allows the user to keep prior formatting if desired. 
To save graphics, position the cursor above the appropriate image and right-click the 
mouse button. Choose SAVE PICTURE AS, select the correct location on the hard drive, 
then click SAVE. 

 Task-switch back to Word using the steps outlined above. Be certain to write at least 
three “news” stories that relate to the event and include at least one graphic. Also 
include elements that are traditionally seen on the front pages of newspapers, such as 
a brief weather report or a small text advertisement. 

 Using newspaper style (emphasis on who, what, where, when and why), write the 
articles. Remember they should be approximately 250 words or less and based on fact 
rather than opinion. Some papers do include editorials (opinion pieces) on the front 
page, but these are always clearly titled Editorial. (Note: Headlines or titles will be 
created later in the lesson.) Press the ENTER key twice to add sufficient space between 
each article. Save the Word articles by clicking on the MICROSOFT OFFICE button and 
selecting SAVE AS. Enter ARTICLES.DOCX as the filename.  Click SAVE. 

 Now do the layout of the front page. In Word 2007, open a blank page by clicking on 
the MICROSOFT OFFICE button and choosing NEW. Notice that the NEW DOCUMENT 
Task Pane will open. Select Blank Document → CREATE. At the top of the page, enter 
the title, or masthead of the newspaper.  
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 Make sure it includes the city or town as part of the title. Highlight the title and from 
the FONT GROUP on the HOME TAB select the desired type style, size and color, then 
enter the name of the newspaper at the top of the page.  

 Highlight the text, then from the PARAGRAPH GROUP on the HOME TAB click on the 
CENTER button.  Press the ENTER key, then type the day of the week, date and year 
under the paper’s title. Reduce the type size for this line to 12 point following the 
steps on the previous page. Save the file as FRONTPAGE.DOCX. 

 To incorporate the images saved from the Internet, position the cursor in the desired 
position and on the INSERT TAB choose PICTURE from the ILLUSTRATIONS GROUP. 
Locate and double-click the file, and it should appear in the Word document. From 
the arrange group, click POSITION → MORE LAYOUT OPTIONS → TIGHT in the 
ADVANCED LAYOUT BOX TEXT WRAPPING TAB → OK.  Position the cursor on the 
photo, hold down the mouse button and drag to the desired position. 

 Usually the lead story in a newspaper is positioned in the right column. Decide which 
of the stories is most important, then click the ARTICLES.DOCX file at the base of the 
window to maximize it. Use the Edit menu to arrange the articles in the preferred order 
of appearance, with the lead story at the top of the page. Then highlight all of the text, 
and click the COPY button under the CLIPBOARD GROUP on the HOME TAB. Click the 
FRONTPAGE.DOCX file at the base of the window to maximize it, then position the 
cursor below the headline and click the PASTE button under the CLIPBOARD GROUP on 
the HOME TAB. 

 Decide on the number of columns for the front page: two or three. Highlight the text 
and from the PAGE LAYOUT TAB select COLUMNS on the PAGE SETUP GROUP.   Click the 
desired number of columns.  

 To create a banner headline across the top of the page, insert a rectangular text box 
between the masthead and the lead article. Enter the desired headline. With the text 
box still selected, go to the PAGE LAYOUT TAB and the ARRANGE GROUP and click on 
TEXT WRAPPING → TIGHT.  Next, with the text box still selected, go to the FORMAT 
TAB and click CHANGE SHAPE in the TEXT BOX STYLES GROUP.  Click NO OUTLINE.   

 Choose the font, style and size of the headline as shown on the previous page. Create 
headlines for the smaller articles using the same process, repositioning each text box 
as needed. Add another text box to include a small advertisement or announcement. 
Make any final adjustments to size and placement of text and graphics boxes. Make 
sure that the stylistic choices do not make the articles difficult to read. 

 Save and print the file, FRONTPAGE.DOCX. Exit Word. 
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Project 7: Women in History 
Teacher Guide 

Description: 

After extensive Internet-based research, the students will use Microsoft Word 2007 to 
prepare a short research paper about the famous historical woman of their choice. The class 
will consult various writing-related Web sites for step-by-step help with outlining, 
researching and writing their papers. 

Grade Levels: 9-12 

PA Academic Standards: 

Grade 9: 

8.1.9A Historical Analysis and Skills Development: Analyze chronological 
thinking. 

• Difference between past, present and future 
• Continuity and change 
• Context for events 

8.1.9B Historical Analysis and Skills Development: Analyze and interpret 
historical sources. 

• Different historical perspectives 
• Visual data presented in historical evidence 

8.3.9C United States History: Analyze how continuity and change has 
influenced United States history from 1787 to 1914. 

• Social Organization (e.g., social class differences, women’s rights and 
antislavery movement, education reforms) 

• Women’s Movement (e.g., roles in the Civil War, medical college for 
women, Seneca Falls Conference) 

Grade 12: 

8.1.12A Historical Analysis and Skills Development: Evaluate chronological 
thinking. 

• Sequential order of historical narrative 
• Continuity and change 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Different historical perspectives 
• Data presented in maps, graphs and tables 
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• Visual data presented in historical evidence 

8.3.12C United States History: Evaluate how continuity and change has 
influenced United States history from 1890 to Present. 

• Social Organization (e.g., compulsory school laws, court decisions 
expanding individual rights, technological impact) 

• Women’s Movement (e.g., right to vote, women in the war effort, Women’s 
Peace Party)  

NCSS Standards: 

2. Identify and use processes important to reconstructing and reinterpreting 
the past, such as using a variety of sources, providing, validating and 
weighing evidence for claims, checking credibility of sources and 
searching for causality.  

5. Analyze group and institutional influences on people, events and culture. 

6. Identify and explain the roles of formal and informal political actors in 
influencing and shaping public policy and decision making. 

8. Explain and apply concepts such as power, role, status, justice and influence 
to the examination of persistent issues and social problems 

NETS Performance Indicators (Grades 9-12): 

7. Routinely and efficiently use online information resources for collaboration, 
research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 

10. Collaborate with peers, experts and others to contribute to a content-related 
knowledge base by using technology to compile, synthesize, produce and 
disseminate information, models and other creative works. 

Internet Applications: 
The students will do focused searches on the Internet and gain experience in discriminating 
between resources of varying quality. 

Materials: 

Web browser and Microsoft Word 2007 

Prerequisite Skills: 

The students should be proficient in accessing Web sites and initiating an Internet search 
using a Web browse. They should also have experience creating documents in Word. 
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Suggested Time Allotment: three to four class periods 

Process: 

Distribute the Women in History Student Handout and provide an overview of the project. 
Consulting the Web sites on the student handout, the class will research various famous 
women throughout history. Give the students ample time to read about several historical 
figures before directing them to choose one for the topic of a short research paper. The 
students will also consult several Web sites for help on compiling the paper, from preparing 
an outline to making final revisions. They will ultimately produce a three- to five-page 
paper about the historical woman of their choice, in addition to a title page which includes 
an image that represents their topic and a brief statement explaining the rationale for their 
choice of subject. 

Evaluation: 

Evaluate students on the depth of their research and the quality of their work at each stage 
of the process. In addition, assess the overall effectiveness of their final products. 

Extensions: 

Ask the students to turn their research papers into Microsoft PowerPoint 2007 
presentations. Each section of their paper might translate to a single slide. Direct them to 
use the Internet to find other images to enhance their presentations. 

Technology Enrichment: 

Direct the students to review their PowerPoint presentations and consider ways to insert 
sound and movie files to supplement the content. Direct them to find appropriate files by 
using at least two major Internet search engines. Retain the best copies of the enhanced 
presentations to use as future teaching tools. 
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Women in History 
Student Handout 

 Launch the Web browser and consult the following sites: 

http://dir.yahoo.com/Arts/Humanities/History/U_S__History/By_Subject/
Women_s_History/People/ 

http://www.wic.org/bio/idex_bio.htm 

http://womenshistory.about.com/ 

 Take time to read the biographies of several historically important women before 
selecting a topic for the research paper. Locate specific information in the following 
areas: youth, education, roadblocks to success, personal accomplishments and later 
life. Bookmark useful Web sites for later use. 

 Launch Microsoft Word 2007. Task-switch between the Web browser and Word by 
holding down the ALT key and pressing ESCAPE, or by selecting the desired application 
in the Quick Launch toolbar at the bottom of the window. Copy and paste useful 
information from the Internet into the Word document to use in preparing the paper. 
Highlight pertinent information on a Web page and choose EDIT → COPY, then return to 
the Word document and click on the PASTE button in the CLIPBOARD GROUP on the HOME 
TAB. Notice in Word 2007, the PASTE OPTIONS Smart Tag, which allows the user to keep 
previous formatting as desired. Save the document as NOTES.DOCX. 

 Save at least one related graphic from the Internet by right-clicking the desired image, 
then choosing the appropriate command to save the picture to the hard disk drive. 
Select a picture of the subject or a related image. 

 Launch the Web browser and access the following sites to gather information for an 
outline of the writing process: 

http://www.ipl.org/teen/aplus/ 

http://www.geocities.com/Athens/Oracle/4184/ 

http://www.csuohio.edu/writingcenter/writproc.html 

 Maximize Word. Reread the research and prepare a thesis statement for the paper. 
Consult the above sites for more information on creating an effective thesis statement. 

 Click on the MICROSOFT OFFICE button and select NEW. The NEW DOCUMENT Task Pane 
will come up. Select BLANK DOCUMENT → CREATE. Using the information located on 
the Internet, prepare an outline of the paper. Consult the list of writing-related Web 
sites for specific help. The subtopics noted in the second step on the previous page 
should serve as the main points of discussion. Use the outline tool in Word by 



FUTUREKIDS, Inc.  Infusing Technology into Social Studies 2007 
  

Copyright © 2007 FUTUREKIDS, Inc.  47 

selecting VIEW → OUTLINE (on the DOCUMENT VIEWS GROUP). Save the document as 
WRITING PROCESS OUTLINE.DOCX. 

 Open another blank document and begin to write the paper. Press the TAB key to indent 
each paragraph. Remember to periodically save the file.  

 To double-space the text, hold down the CTRL key, then press the A key. Verify that all 
text is highlighted. Select FORMAT → PARAGRAPH and choose DOUBLE in the Line 
Spacing drop-down menu. Select FORMAT → FONT to experiment with different type 
styles, but make sure that the stylistic choices do not make the text difficult to read. 

 Consult the outline and the writing-related Web sites as needed for assistance. After the 
paper is complete, put it aside for a few hours or overnight if time permits. Then reread 
the paper. How might it be improved? Does the report present a thorough portrayal of the 
subject? Will the audience understand the historical significance of her contributions after 
reading the paper? Make any revisions necessary to enhance the paper. 

 Scroll to the beginning of the research paper and choose INSERT → BREAK, Next, 
select the PAGE BREAK radio button and press OK. Enter the title of the paper and 
your name. Highlight the text, then select FORMAT → PARAGRAPH. In the Alignment 
drop-down menu at the top of the dialog box, choose CENTERED. Include the picture 
saved from the Internet by selecting INSERT → PICTURE → FROM FILE. Navigate to 
the appropriate file and double-click to insert.  

 Right-click the image, then choose FORMAT PICTURE. Click the LAYOUT TAB, then 
choose SQUARE. Select CENTERED as the HORIZONTAL ALIGNMENT option, then choose 
OK. While holding down the SHIFT key, click the image. Hold down the mouse button, 
then drag to move the image up or down as appropriate. Resize the image by dragging 
one of the handles located around the frame. Below the photo, include a brief 
paragraph explaining why this historical figure was selected. Choose an appropriate 
font and type size. 

 Include page numbers by choosing INSERT → PAGE NUMBERS. Click the Position and 
Alignment drop-down arrows and make the appropriate selections. Be certain to 
deselect the SHOW NUMBER ON FIRST PAGE option so that no page number appears on 
the title page. 

 Save and print the file. Exit Word. 
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Project 8: Quality of Life Comparison 
Teacher Guide 

Description:  

The students will gather information and compare the quality of life among several 
countries at differing stages of development. After gathering the relevant data, the 
students will analyze and explain the various differences they discover and then present 
the data in several formats. 

Grades: 8-12 

PA Academic Standards: 

Grade 9: 

7.3.9A The Human Characteristics of Places and Regions: Explain the human 
characteristics of places and regions by their population characteristics.  

• Spatial distribution, size, density and demographic characteristics of 
population at the state and National level 

• Demographic structure of a population (e.g., life expectancy, fertility rate, 
mortality rate, infant mortality rate, population growth rate, the demographic 
transition model) 

7.4.9A The Interactions Between People and Places: Explain the impacts of 
physical systems on people. 

• How people depend on, adjust to and modify physical systems on a            
National scale (e.g., soil conservation programs, projects of The Corps of 
Engineers) 

Grade 12: 

7.3.12A Human Characteristics of Places and Regions: Analyze the 
significance of human activity in shaping places and regions by their population 
characteristics. 

• Spatial distribution, size, density and demographic characteristics of 
population at the international level 

• Demographic trends and their impacts on patterns of population distribution 
(e.g., carrying capacity, changes in fertility, changes in immigration policy, 
the mobility transition model) 

7.4.12A The Interactions Between People and Places: Analyze the impacts of 
physical systems on people. 

• How people depend on, adjust to and modify physical systems on 
international scales (e.g., resource development of oil, coal, timber) 
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NCSS Standards: 

3. Create spatial views and geographic perspectives of the world beyond 
through the study of people, places and human-environment interactions. 

7. Understand that because people have wants that often exceed available 
resources, a variety of ways have evolved to answer such questions as: What 
is to be produced? How is production to be organized? How are goods and 
services to be distributed? 

NETS Performance Indicators: (Grades 6-8) 

8. Use appropriate technology to accomplish a variety of tasks and solve 
problems. 

9. Demonstrate an understanding of concepts underlying hardware, software 
and connectivity, and of practical applications to learning and problem 
solving.  

NETS Performance Indicators: (Grades 9-12) 

7. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity 

8. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 

Internet Applications: 

This project will reinforce Internet research skills and strengthen student awareness of 
available online resources. 

Materials: 

Web browser, Microsoft Excel 2007 and Microsoft Word 2007  

QUALITY OF LIFE XLTX template 

Prerequisite Skills: 

Students should be familiar with creating spreadsheets and charts in Microsoft Excel 2007 
and should be comfortable using the Internet as a resource. 

Suggested Time Allotment: one to two class periods 

Process: 

The students will choose three countries in different stages of development to add to the 
spreadsheet provided on the template. Using the Internet, they will incorporate the new 
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data into the Excel spreadsheet and determine the average for all five countries in each of 
the categories. The class will then create a line chart that presents the differences among 
the countries. Finally, the students will examine the data about these countries and write a 
report that discusses how different factors impact the quality of life. They will complete 
the report by pasting the line chart from Excel into their Word document and presenting 
their findings to the class. 

Evaluation: 

Evaluate the students on their ability to find, integrate and interpret data about specific 
countries. Assess their ability to think critically and to analyze and discern patterns as 
they write their comparison. 

Extensions: 

Working in small groups, the students will compare and contrast trends they observed as 
well as their own conclusions. Have each group present an overview of similar and 
differing perspectives. 

Technology Enrichment: 

Ask students to choose one of the five countries from their spreadsheet and prepare a 
PowerPoint presentation to be delivered to the United Nations that presents at least four 
concrete steps to improve the quality of life. The students should incorporate Internet 
research, appropriate information and graphics, and effective presentation techniques. 
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Comparative Qualities 
Student Handout  

 Open the Microsoft Excel 2007 spreadsheet template QUALITY OF LIFE.XLTX. Note 
that it contains data on two countries, Nigeria and Venezuela, presented in six 
different categories (columns A through G).  

 Choose three other countries to include in the spreadsheet; one should be a developed 
country in Western Europe, one should be an Arab country in the Middle East, and 
one should be an Asian country (avoid choosing Japan, China or India). 

 Minimize the Excel worksheet and launch the Web browser. Begin an Internet search 
for data relating to the categories on the spreadsheet template. If the search does not 
produce the necessary information, visit the following Web sites for assistance: 

http://www.odci.gov/cia/publications/factbook/index.html 

http://www.prb.org/databycountry/ 

 Bookmark any Web sites that provide the information needed to complete the Excel 
worksheet for the three selected countries. 

 Minimize the Web browser and maximize the Excel worksheet. Enter the names of 
the three countries chosen in cells A4, A5 and A6.  

 Moving back and forth between the appropriate Web site and the worksheet, enter 
the correct data for each of the three countries in the appropriate columns. Now, 
click the MICROSOFT OFFICE button → SAVE AS, then save the expanded worksheet 
as WORLD QUALITY OF LIFE COMPARISON. 

 Highlight cells A1 through G6. Select INSERT and from the CHARTS GROUP choose 
LINE and click the first box in the top row. Change the appearance of the chart as 
appropriate. Save the workbook by clicking on the MICROSOFT OFFICE button and 
choosing SAVE. 

 Click on Sheet1, and highlight all cells A1 through G6.  Click on the SORT & FILTER 
button under the EDITING GROUP and choose CUSTOM SORT.  Sort the countries named 
in rows 2 through 6 based on the contents of one of the columns. Print out the sorted 
worksheet. Repeat the process for two more categories. After each sorting, print the 
revised worksheets. Pick categories that are related and provide insight into the 
overall quality of life in those countries (e.g., population, birth rate and life 
expectancy).
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 Using the data gathered in the previous step, consider the effect of these three factors 
on the quality of life and well being of the citizens of the chosen countries. 

 Open Word 2007 and write an opinion paper on the effects of these three factors. 
Consider whether there is a causal relationship among the different categories or 
whether the relationship is random. 

 Conclude the report with a statement of which country seems most desirable and 
which seems least desirable as a home. Explain how this conclusion was reached. 

 Minimize the Word report and maximize the Excel spreadsheet. Choose Chart1, and 
make a copy of the chart. 

 Maximize the Word report and paste the chart at the end of the text. Notice that the 
PASTE OPTIONS Smart Tag appears in Word 2007. Size the chart as appropriate. 

 Save the file and exit Word and Excel. 
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Project 9: Monarchs Database 
Teacher Guide 

Description: 

The students will use or modify the supplied database to develop a substantial source of 
information about European ruling monarchs from the 16th century to the present. They 
will use the Internet to locate information about different monarchs and expand the 
database so that it contains enough entries to be useful for comparison. The students then 
will filter the data to compare several rulers and create a Microsoft PowerPoint 2007 
presentation illustrating the differences. 

Grades: 10-12 

PA Academic Standards: 

Grade 12: 

8.1.12B Historical Analysis and Skills Development: Synthesize and evaluate 
historical sources. 

• Data in historical and contemporary maps, graphs and tables 
• Data presented in maps, graphs and tables 
• Visual data presented in historical evidence 

8.4.12A World History: Evaluate the significance of individuals and groups who 
made major political and cultural contributions to world history since 1450. 

• Political and Military Leaders (e.g., Askia Daud, Simon Bolivar,   Napoleon 
Bonaparte, Mao Zedong) 

8.4.12C World History: Evaluate how continuity and change throughout history 
has impacted belief systems and religions, commerce and industry, innovations, 
settlement patterns, social organization, transportation and roles of women since 
1450. 

• Europe  

NCSS Standards: 

6. Compare different political systems (their ideologies, structures and 
institutions, processes and political cultures) with that of the United States, 
and identify representative political leaders from selected historical and 
contemporary settings. 

9. Explain the conditions and motivations that contribute to conflict, 
cooperation and interdependence among groups, societies and nations. 
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NETS Performance Indicators (Grades 9-12): 

7. Routinely and efficiently use online information resources to meet needs for 
collaboration, research, publications, communications and productivity. 

8. Select and apply technology for research, information analysis, problem 
solving and decision-making in content learning. 

Internet Applications: 

Students will refine their Internet research skills and develop a greater awareness of 
resources on the Web. 

Materials: 

Web browser, Microsoft Access 2007, and Microsoft PowerPoint 2007 

MONARCHS DATABASE.ACCDB 
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Prerequisite Skills: 

The students should be familiar with Internet research tools. In addition, they should have 
basic Access skills and experience creating presentations in PowerPoint. 

Suggested Time Allotment: three periods plus homework time 

Process:  

Explain that the MONARCHS DATABASE.ACCDB template contains a database with seven 
fields. Two monarchs from the four different countries are already entered. Discuss the 
fields and decide if any need to be changed or modified. Distribute the Monarchs 
Database Student Handout and explain that the class will expand the database to include 
four more monarchs from each of the listed countries, and then add six monarchs from 
two other countries. The expanded database will include a total of 36 monarchs. Let 
students know that after completing the database, they will filter the data to compare 
attributes of the rulers. Finally, they will create a PowerPoint presentation that includes 
two of the monarchs. 

Evaluation: 

Evaluate students on the sources they find in the Web search, on which monarchs and 
countries they include, and on the criteria they use for filtering. In addition, assess the 
quality of the PowerPoint presentations. 

Extensions: 

Have students meet in small groups. Ask them to discuss the personal, political or social 
issues that contributed to the reign of the monarch they studied and develop a list of 
common causes. Regroup for a class discussion and create a class list of factors 
contributing to both a long and a short reign. 

Technology Enhancements: 

Using information from the database created in this lesson, have the students choose a 
royal family name to trace through the centuries. They should return to the Internet to 
research the rise and fall of the family. Using Publisher, the students will then create a 
poster on the history of the family and present the information to the class. 
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Monarchs Database 
Student Handout 

 Launch Microsoft Access 2007 and open the MONARCHS DATABASE.ACCDB template. 

MONARCHS DATABASE.ACCDB TEMPLATE 

Ruling Monarch Country Birth Lineage Length of 
Rule 

Number of 
Children 

Method of 
Accession 

George I Britain 1660 Hanover 13 2 death 
Anne Britain 1665 Stuart 12 17 succession 
Margrethe II Denmark 1940 Schleswig-Holstein 28 2 succession 
Frederick II Denmark 1534 Oldenburg 29 7 succession 
James Monaco 1689 de Estouteville 2 5 marriage 
Rainier III Monaco 1923 Grimaldi 51 3 succession 
Alexander III Russia 1845 Romanov 13 6 suicide 
Peter I Russia 1672 Romanov 43 11 succession 
 

 Decide if any of the fields need to be modified. Remember, if any fields are modified, 
the changes will affect the data for the monarchs already included. 

 Make changes to the database fields in the DATASHEET TAB function. Minimize 
Access. 

 Note that four countries are represented in the database, with two monarchs listed for 
each nation. In the following steps, add information about four new monarchs to each 
country’s listing. Then select two additional countries, and provide six monarchs for 
each of them. 

 Open the Web browser and consult the Web sites listed below to gather information 
about the two monarchs already named in the database. Locate four more monarchs 
for each country and enter information for each in the appropriate columns. 

http://www3.dcs.hull.ac.uk/public/genealogy/royal/catalog.html 

http://home.about.com/homework/index.htm  
(Enter “monarchs” in search box) 

http://britannia.com/history/monarchs 
(Search for “monarchs” “country name”.) 

 Use the links in the previous step or search for additional Web sites to gather needed 
information about six monarchs from two additional countries. Determine which links 
will be most useful and bookmark them. 
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 Enter the required information for the new monarchs to be added to the database. 
Remember that a total of six countries should be represented and each country should 
include six individual monarchs.  

 Modify the format, text, font size and background color of the database as desired. 
When the database appearance is satisfactory, click on the MICROSOFT OFFICE button 
→ SAVE and MICROSOFT OFFICE button → PRINT.  

 From the HOME TAB, perform a filter by selecting the LENGTH OF RULE (YEARS) field 
and choosing FILTER (from the SORT & FILTER GROUP).  CLICK NUMBER FILTERS → 
GREATER THAN → 15 → OK.  

 Check to see if the filter produced the desired data, then click the MICROSOFT OFFICE 
button → PRINT to print the newly filtered database. Save the filtered database as 
MONARCH FILTER.ACCDB. Remove the filter. 

 Repeat the same filtering process as above, but enter <15 in the Criteria box. Check 
the result, then print the second filtered database. Remove the filter and exit Access. 

 Using the two filtered database printouts, choose one monarch with a long reign 
(greater than 15 years) and one monarch with a short reign (less than 15 years). 

 Open the Web browser and return to the bookmarked sites from the beginning of the 
lesson. Find additional information pertaining to the two selected monarchs. 
Construct a Microsoft PowerPoint 2007 presentation. Next, collect data concerning 
the personal, political or social conditions that contributed to the short or long reign 
of the monarchs. 

 Gather graphics from the bookmarked sites to use in the PowerPoint presentation. To 
collect photos and other graphics, position the cursor over the appropriate image, 
right-click on the image and choose the appropriate command to save the picture to 
the hard disk drive.  

 Launch PowerPoint and create a presentation that includes information about the 
factors contributing to the respective reigns of the two monarchs. Include appropriate 
graphics, animation, and other visual and sound effects as desired. 

 Save the presentation as MONARCHS.PPTX. Exit PowerPoint. 
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Project 10: Presidential Biography 
Teacher Guide: 

Description: 

The students will perform Internet research to gather information about a former United 
States president. They will use this information to create a multimedia presentation about 
the president’s life, as well as his accomplishments during his time in the White House. 
Afterward, the students present their multimedia reports to the class. 

Grade Levels: 7–12 

PA Academic Standards: 

Grade 9: 

5.2.9D Rights and Responsibilities of Citizenship: Analyze political leadership 
and public service in a republican form of government. 

8.1.9D Historical Analysis and Skills Development: Analyze and interpret 
historical research. 

• Historical event (time and place) 
• Facts, folklore and fiction 
• Historical questions  
• Primary sources 
• Secondary sources 
• Conclusions (e.g., History Day projects, mock trials, speeches) 

8.3.9A United States History: Identify and analyze the political and cultural 
contributions of individuals and groups to United States history from 1787 to 
1914. 

• Political Leaders (e.g., Daniel Webster, Abraham Lincoln, Andrew Johnson) 

8.3.9B United States History: Identify and analyze primary documents, material 
artifacts and historic sites important in United States history from 1787 to 1914. 

• Documents (e.g., Fugitive Slave Law, Treaty of Guadalupe Hidalgo, 
Emancipation Proclamation) 

Grade 12: 

5.2.12D Rights and Responsibilities of Citizenship: Evaluate political 
leadership and public service in a republican form of government.  

8.1.12D Historical Analysis and Skills Development: Synthesize historical 
research. 

• Facts, folklore and fiction 
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• Historical questions  
• Primary sources 
• Secondary sources 
• Conclusions  (e.g., Senior Projects, research papers, debates) 

8.3.12A United States History: Identify and evaluate the political and cultural 
contributions of individuals and groups to United States history from 1890 to 
Present. 

• Political Leaders (e.g., Theodore Roosevelt, Woodrow Wilson, Franklin D. 
Roosevelt)   

8.3.12B United States History: Identify and evaluate primary documents, 
material artifacts and historic sites important in United States history from 1890 to 
Present. 

• Documents (e.g., Treaty of Versailles, North Atlantic Treaty, Neutrality 
Acts)  

• 20th Century Writings and Communication (e.g., Coolidge’s “The Business 
of America is Business,”  King’s “I Have A Dream,” Armstrong’s “One 
Small Step for Man”) 

NCSS Standards: 

6. Use processes important to reconstructing and reinterpreting the past. 

7. Identify and use processes important to reconstructing and reinterpreting 
the past. 

8. Identify and explain the roles of formal and informal political actors in 
influencing and shaping public policy and decision making. 

NETS Performance Indicators (Grades 6–8): 
5. Apply productivity/multimedia tools and peripherals to support personal 

productivity, group collaboration and learning throughout the curriculum. 

6. Design, develop, publish, and present products (e.g., Web pages, videotapes) 
using technology to demonstrate and communicate curriculum concepts. 

7. Collaborate with peers, experts and others using telecommunication and 
collaborative tools to investigate curriculum-related problems, issues and 
information and to develop solutions. 

NETS Performance Indicators (Grades 9-12): 
7. Routinely and efficiently use online resources to meet collaboration, 

research, publications, communications and productivity needs. 

8. Select and apply technology for research, information analysis, problem 
solving and decision making in content learning. 
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10. Collaborate with peers, experts and others to contribute to a content-related 
knowledge base by using technology to compile, synthesize, produce and 
disseminate information, models and other creative works. 

 

Internet Applications: 
Students will enhance their Internet-based research skills and become more familiar 
with Web resources. 
 
Materials: 
Web browser 
Microsoft PowerPoint 2007 
Presidential Biography Sample.pptx 
 
Prerequisite Skills: 
The students should have experience using a Web browser to conduct Internet research. 
They should also be familiar with PowerPoint. 
 
Suggested Time Allotment: three class periods 
 
Process: 
Distribute the Presidential Biography Student Handout and provide an overview of the 
project. Explain that the students will perform Internet research on the past president of 
their choice, collecting data on his youth, education, accomplishments and later life. They 
will create a multimedia report based on this information and present it to the class. 
 
Evaluation: 
Evaluate the students on the clarity and completeness of their multimedia presentations, 
as well as the quality of the oral presentations. 
 
Extensions: 
Suggest that the students use Microsoft SharePoint Designer 2007 to create a Web page 
from the data they discovered during preparation of their PowerPoint presentations.  
 
Technology Enrichment: 
Have the students animate the objects on each slide. To do so, click on the ANIMATIONS 
TAB. Select the desired text or object and click CUSTOM ANIMATIONS in the ANIMATIONS 
GROUP. A Task Pane will appear on the right. Click on the text or object you wish to 
animate and click on ADD EFFECT in the Task Pane. Choose the effect option you want. 
Click on the drop-down arrow next to Start and select AFTER PREVIOUS to set the timing. 
Change the speed to MEDIUM. Repeat these steps for each slide in the presentation. 
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Presidential Biography 
Student Handout 

 Launch the Web browser and access the following sites as necessary: 

http://gi.grolier.com/presidents/aae/prescont.html 

http://www.ipl.org/ref/POTUS/ 

http://www.pbs.org/wgbh/amex/presidents 

http://www.americanpresidents.org/ 

 Determine which president the report will feature. Locate information in the 
following areas: youth, education, presidential accomplishments and later life. 

 Launch Microsoft Word 2007. Task-switch between the Web browser and Word by 
holding down the ALT key and pressing ESCAPE, or by selecting the desired 
application in the Quick Launch toolbar at the bottom of the window.  

 Copy and paste useful information from the Internet into the Word document to use in 
preparing the presentation. Highlight pertinent information on a Web page and choose 
EDIT → COPY. Return to the Word document and click the PASTE button under the 
CLIPBOARD GROUP on the HOME TAB. The PASTE OPTIONS Smart Tag will appear, 
which allows the user to keep previous formatting. 

 Save graphics from the Internet by right-clicking the desired image and choosing the 
appropriate command to save the picture to the hard disk drive. 

 After accumulating information and graphics, create a multimedia presentation. 
Launch Microsoft PowerPoint 2007.  

 From the HOME TAB, click on LAYOUT in the SLIDES GROUP.  Select the TITLE ONLY 
slide. Choose the Click to add title text box and enter a title for the presentation. 
Format the text. 

 Insert an image saved from the Internet or a graphic from the clipart library. To insert 
a previously saved image, from the INSERT TAB, click on PICTURE from the 
ILLUSTRATIONS GROUP. Locate and select the desired file and click INSERT. To add 
clipart, choose INSERT → PICTURE → CLIP ART. In PowerPoint 2007 the INSERT CLIP 
ART Task Pane will appear to the right. Enter related text in the SEARCH FOR box and 
press ENTER. Locate and select the desired image and click to insert the graphic. 
Resize and reposition the graphic as needed. 
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 To create a new slide, from the HOME TAB, under the SLIDES GROUP, click NEW SLIDE 
DROP DOWN button. Select the TITLE AND CONTENT slide.  

 Choose the Click to add title text box and enter Youth. Select the Click to add text box 
and enter information about the president’s early life. Insert a graphic for the slide as 
well. 

 Repeat the last two steps to insert additional slides entitled Education, Presidential 
Accomplishments and Later Life. 

 Click on the DESIGN TAB and under the THEMES GROUP select the theme of choice to 
apply the design to all of the slides. Apply a transition to each slide by clicking on the  
ANIMATIONS TAB and from the TRANSITION TO THIS SLIDE GROUP, select the DESIRED 
TYPE, SOUND AND SPEED OF TRANSITION.  Click on the APPLY TO ALL button in the 
TRANSITION TO THIS SLIDE GROUP.  

 Format the slides as desired. 

 Preview the presentation by clicking on the VIEW TAB and clicking SLIDE SHOW under 
PRESENTATION VIEWS. 

 Save the file and exit PowerPoint. 
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Project Analysis Form 

Use this form to analyze the sample project and take notes as it is being evaluated. 

1. Do the Teacher Guide and Student Handout provide the information and 
instruction needed to understand the project? Are the required skills appropriate 
for the students? 

2. Describe the online research portion of the project. Is it a practical way to gather 
the necessary data? Why or why not? 

3. Is the template format clear and useful? Does it provide an appropriate foundation 
for the development of the presentation? 

4. Does the project provide for student creativity? Will it engage student interest? 

5. Other comments? 
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Module 2 - Project Creation 

Planning a social studies technology lesson is similar to planning a traditional language 
arts lesson. Common steps include the identification of the purpose of the lesson, the 
development of the appropriate approach and the creation of an evaluation instrument. 
The technology lesson is supplemented by the integration of applicable technology 
standards, software applications, and, in many cases, Internet resources. 

This course provides a variety of tools to enable users to create technology projects easily 
and efficiently. Two key aids are the Steps to Create a Social Studies PowerPoint 
Presentation on pages 68-70, which demonstrates the thinking and development of a 
hypothetical project, and the Process Planning Questions found on pages 71-72.  

The International Society for Technology in Education (ISTE) has developed 
performance indicators known as the National Educational Technology Standards 
(NETS). When planning a technology project, use these standards to assess the level of 
technology performance in each lesson. The standards may be found on pages 73-74. 

A Sample Rubric for Student Performance Review is included on page 76. 

The process provided is meant to point teachers in the right direction of successful project 
development. Feel free to adapt it as needed. 
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Project Creation Process 

Step-by-Step Guide Model Project 

Choose a central idea or 
focus for the project. 
 

The development and use of money as 
part of the economic system 

Determine the goals of the project. 
What will the student learn? How 
will this knowledge address the 
overall goals of the unit or 
curriculum? 
 

Students will gain understanding of how 
currency came into use, how it has influenced 
the economies of civilizations and how it is 
used today. They will identify and explain 
correlations between different world 
currencies, and demonstrate understanding of 
monetary systems in a broader context 

Identify what social studies 
learning objectives and 
standards the students will 
achieve through the project. 
 

NCSS Standards 
 
7. Power, authority, and governance: 

Understanding the historical development 
of structures of power, authority and 
governance and their evolving functions 
in contemporary U.S. society and other 
parts of the world is essential for 
developing civic competence. In 
exploring this theme, students confront 
such questions as: What is power? What 
forms does it take? Who holds it? How is 
it gained, used and justified? What is 
legitimate authority? How are 
governments created, structured, 
maintained and changed? How can 
individual rights be protected within the 
context of majority rule? In schools, this 
theme typically appears in units and 
courses dealing with government, politics, 
political science, history, law and other 
social sciences. 

8. Production, distribution and consumption: 
Because people have wants that often 
exceed the resources available to them, a 
variety of ways have evolved to answer 
such questions as listed on the following 
page. 
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 What is to be produced? 

 How is production to be organized?  

 How are goods and services to be 
distributed?  

 What is the most effective allocation of 
the factors of production (land, labor, 
capital and management)?  

In schools, this theme typically appears in 
units and courses dealing with economic 
concepts and issues. 

Consider how these 
objectives have been 
achieved in previous years 
without the use of 
technology. 

In previous years, the students have 
participated in class discussions, done 
library research and written essays on 
the topic. 
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Selecting Software Applications 
There are many ways to determine which software applications would best address the 
purpose and objectives of a project. 

One approach is to first decide the objectives of the lesson and then brainstorm how 
each software application could be used to achieve them.  

The examples below were created in this manner. Some software applications lend 
themselves to certain types of projects naturally, while others are more difficult to adapt 
to the same objectives. Considering all the available software applications, and the 
achievement of lesson objectives through the different structures inherent to them, will 
aid in the creation of interesting and unusual projects.  

Another way to decide which software applications to use is to consider which 
applications the students need to learn or practice and to create a project specifically 
designed to enhance skills in those applications. For example, if the students need to 
work with Excel, they might benefit from a project that involved the creation of graphs. 

Possible Projects 

Use Access to build a database of historic 
methods of exchange of value for goods 
and services. Data might include the items 
themselves, their source, their perceived 
value and the cultures which used them. 
The creation of the database could result in 
a comprehensive tool for comparing the use 
of monetary equivalents and currency in the 
different systems studied during the year. 

Use PowerPoint to make presentations about the 
development of currency systems. The students 
might explore the Internet to discover 
illustrations, documents and other material 
relative to this issue. Presentations could include 
images of the currency types and illustrations of 
the on-going evolution of these systems. 

Use Excel to track how value items have 
evolved over a period of time to become the 
currency systems used today. Enter data 
about the use of these systems on both an 
official and everyday level. When all the 
data is entered, create a chart that reflects 
these changes. 

Use Publisher to design a short booklet featuring 
the contemporary currency units and explaining 
the relative impact of these monetary systems on 
world commerce. 

Use SharePoint Designer to build a Web 
site that includes illustrations of the 
valuable items exchanged, the evolution to 
monetary units and explanations of the 
changes. Add links to Internet sites about 
money systems and economics. 

Use Word to create a table of currency systems 
that includes their relative value (as compared to 
the dollar, for instance), their impact on world 
economies, and their desirability in the 
marketplace. An example might be to consider 
the impact of the new European Common Market 
Euro on other currencies. 
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Steps to Create a Social Studies PowerPoint  
Presentation  

 

Outline a logical progression 
of steps to create the project. 

 
1. Define the parameters of the presentation, 

such as the minimum number of required 
pages and the amount of class time that 
will be dedicated to making and 
presenting the project.  

2. Identify the main highlights and 
objectives of the lesson.  

3. Sketch, outline, or map the structure of 
the project. Decide what each page will 
contain. Use animation, sound, video, 
graphics, links and text as elements of 
the presentation. 

4. Create two working files to hold all the 
components of the presentationa 
digital file on the computer and a 
physical file for notes and  sketches of 
the project  

5. Outline and store the text elements in the 
digital file. 

6. Search for resources on the Internet. 
Make necessary copies for the digital 
file, carefully noting their sources. 

7. Gather other needed resources such as 
video clips, hard copies and clip art. File 
resources in the digital and physical files 
as needed. 

8. Create the presentation using the 
resources gathered. Find or write 
additional material as needed to 
complete the project. 

9. Test the presentation to ensure that all 
inserted media, links and other details 
work as anticipated. Make needed 
adjustments and/or corrections. 

10. Give presentation. 
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Create the project using a specific 
plan and keep detailed notes on 
each step. These notes will form 
the foundation for the student 
handout. 

Using the Project Creation 
Guidelines, construct the PowerPoint 
presentation. Keep careful notes 
detailing the steps in the process. 
 

Decide on a reasonable time 
frame for student completion of 
the project. 

Two class computer lab sessions and 
two homework assignments will be 
dedicated to this PowerPoint 
presentation. 

Finalize the student handout, 
taking care that the directions are 
sequential and easily understood. 

Proof, test, and revise the Student 
Handout as needed. 

Consider what background 
information and activities should 
be presented in class before 
students embark on the project. 

Examine such topics as the “The History of 
Money” and world monetary systems by 
assigning reading and leading class 
discussions. 

Develop an assessment rubric 
or instrument to evaluate 
student performance on the 
project. (Refer to sample on 
page 69) 
 

Refer to the ISTE performance 
indicators that support the project’s 
technology objectives, the provided 
project evaluation rubric (page 73) 
and other appropriate criteria to 
develop an evaluation instrument to 
assess the content and technology 
usage of the project. 

ISTE Performance Indicators 
(Grades 9-12) 
7. Routinely and efficiently use online 

information resources for 
collaboration, research, 
publications, communications and 
productivity. 

10. Collaborate with peers, experts, 
and others to contribute to a 
content-related knowledge base by 
using technology to compile, 
synthesize, produce and 
disseminate information, models 
and other creative works. 
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Analyze whether additional 
technology applications will 
enhance the effectiveness of 
the project. 

Students will use a projector for their 
presentations to the class They also 
will be expected to turn in a hard 
copy of their resources in correct 
bibliographic form, prepared in 
Word. 

Present at least one 
technology enhancement of 
the project to foster further 
learning. 

Have students keep a “timesheet” in 
Excel to track how much time they 
spend on each step of the project. 
After all the projects have been 
presented, have students examine and 
compare their “timesheets”. Lead a 
discussion to examine time spent and 
results achieved and to explore 
methods students can use to improve 
their next projects. 

Consider ways to extend the 
project by using related ideas 
for discussion or development. 

Have students create their own 
PowerPoint projects with templates, 
a teacher guide and a student handout 
for another literary work they will 
study. Students can exchange, 
develop, present and critique each 
other’s projects. 

Review and evaluate the 
effectiveness of the proposed 
project. Consider the 
questions listed on the right: 

Will the students be able to follow 
the handout successfully without 
the use of a template?  

Will the discussion suggested in 
the “Process” section of the 
Teachers Guide provide sufficient 
context for the students to 
understand the purpose of the 
project? How might the discussion 
be changed or expanded?  

How can this project assist the 
students to better understand the 
global functions of currency?  

Does the project allow for 
sufficient student creativity? Will 
it engage student interest?  

Other comments? 
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Social Studies Creation Process Questions 

Directions:  

Before producing a technology project, consider and respond to each of the following 
questions. Use the information as a guide in the creation process. 

1. What specifically is to be accomplished with this project? 

2. What social studies learning objectives will the students achieve with this project? 

3. Have these objectives been achieved in the past without using technology? If so, 
how? 

4. Which software applications would enliven, enrich, simplify or promote these 
objectives?  

5. How will the use of Internet resources impact this project? 
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6. Will an electronic template be required? How complete should it be? 

7. What is the logical progression of steps to work through the project? 

8. Approximately how long should the project take to complete? 

9. How will the results be evaluated? 

10. Are there ways to extend this project to foster further learning? Can other technology 
applications enhance its effectiveness? 
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International Society 
for Technology Education (ISTE) 

National Educational Technology Standards 

Grades 6-8  
All students should have opportunities to demonstrate the following:  

Numbers in 
parentheses following 
each performance 
indicator refer to the 
standards category to 
which the performance 
is linked. The 
categories are as 
follows: 

1. Basic operations 
and concepts  

2. Social, ethical 
and human 
issues  

3. Technology 
productivity 
tools  

4. Technology 
communications 
tools  

5. Technology 
research tools  

6. Technology 
problem-solving 
and decision-
making tools  

Prior to the completion of Grade 8, students: 

1. Apply strategies for identifying and solving routine hardware 
and software problems that occur during everyday use. (1)  

2. Demonstrate knowledge of current changes in information 
technologies and the effect those changes have on the 
workplace and society. (2)  

3. Exhibit legal and ethical behaviors when using information and 
technology, and discuss consequences of misuse. (2)  

4. Use content-specific tools, software, and simulations (e.g., 
environmental probes, graphing calculators, exploratory 
environments, Web tools) to support learning and research. (3, 
5) 

5. Apply productivity/multimedia tools and peripherals to support 
personal productivity, group collaboration and learning 
throughout the curriculum. (3, 6)  

6. Design, develop, publish and present products (e.g., Web 
pages, videotapes) using technology resources that demonstrate 
and communicate curriculum concepts to audiences inside and 
outside the classroom. (4, 5, 6)  

7. Collaborate with peers, experts and others using 
telecommunications and collaborative tools to investigate 
curriculum-related problems, issues and information, and to 
develop solutions or products for audiences inside and outside 
the classroom. (4, 5) 

8. Select and use appropriate tools and technology resources to 
accomplish a variety of tasks and solve problems. (5, 6)  

9. Demonstrate an understanding of concepts underlying hardware, 
software and connectivity, and of practical applications to 
learning and problem solving. (1, 6) 

10. Research and evaluate the accuracy, relevance, appropriateness, 
comprehensiveness and bias of electronic information sources 
concerning real-world problems. (2, 5, 6) 
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National Educational Technology Standards, continued 
 

Grades 9-12  
All students should have opportunities to demonstrate the following: 

Numbers in 
parentheses following 
each performance 
indicator refer to the 
standards category to 
which the performance 
is linked. The 
categories are as 
follows:  

1. Basic operations 
and concepts  

2. Social, ethical 
and human 
issues  

3. Technology 
productivity 
tools  

4. Technology 
communications 
tools  

5. Technology 
research tools  

6. Technology 
problem-solving 
and decision-
making tools  

Prior to the completion of Grade 12, students: 

1. Identify capabilities and limitations of technology resources 
and assess the potential of these systems and services to address 
personal, lifelong learning and workplace needs. (2)  

2. Make informed choices among technology systems, resources 
and services. (1, 2)  

3. Analyze advantages and disadvantages of widespread use and 
reliance on technology in the workplace and in society as a 
whole. (2)  

4. Demonstrate and advocate for legal and ethical behaviors among 
regarding the use of technology and information. (2)  

5. Use technology for managing and communicating 
personal/professional information (finances, schedules, 
addresses, purchases, correspondence). (3, 4)  

6. Evaluate technology-based options, including distance and 
distributed education, for lifelong learning. (5)  

7. Routinely and efficiently use online information resources to 
meet needs for collaboration, research, publications, 
communications and productivity. (4, 5, 6)  

8. Select and apply technology for research, analysis, problem-
solving and decision-making in content learning. (4, 5) 

9. Investigate and apply expert systems, intelligent agents and 
simulations in real-world situations. (3, 5, 6) 

10. Collaborate with peers, experts and others to contribute to a 
content-related knowledge base by using technology to 
compile, synthesize, produce and disseminate information, 
models and other creative works. (4, 5, 6) 
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Electronic Templates 
Use the selected software program to create the data file that students will need to begin 
their projects. When the template is complete, give the file a descriptive name and save it 
on the server or on disk(s) such as a floppy disk or a CD-R. In most Microsoft programs, 
such files can be saved as templates with extensions that describe them. To save the file 
as a template, choose FILE → SAVE AS. Add the file name and choose the correct 
extension from the drop-down button labeled Save as type. 

The template extensions for each software program are as follows: 

Access   (*.accdb) 

Excel   (*.xltx) 

SharePoint Designer (*.tem) 

PowerPoint  (*.potx) 

Publisher  (*.pub) 

Word   (*.dotx) 

Project design, the software application selected and logistical considerations will dictate 
how students use the templates.  

In general, expect students:  

1. To copy the template, assign a name to the copy and use the copy. 

2. To open their template, use it to complete the project and save it under a new 
filename.  

3. Students will open the template, then immediately use the SAVE AS command to 
save the file with a new name. By following these instructions, they make and save 
a copy of the template simultaneously. This will avoid the overwriting of the 
original file. 

Please note that Access only allows information to be saved in the format of a table, form 
or report, so the templates must be copied and renamed. 
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A Sample Rubric  
for Student Performance Review 

 
A rubric consists of two sections, the first of which is a performance-criteria checklist 
where the students are evaluated in several areas. The second section provides the teacher 
a space to make specific comments about the student’s performance. When completing 
the rubric, teachers will need to reflect on classroom observations and experiences as well 
as review student work and the skills checklist. After doing so, they should make a 
determination and place an “X” in each of the appropriate cells. The checklist and 
comments should help the teacher to make a fair evaluation of the student’s work.  

Unsatisfactory 

An “unsatisfactory” mark should be rare. This designation is reserved for the student who 
rarely completes assignments, participates in activities or complies with peers. 

Needs Practice 

A new student would fall into this category. The continuing student who acquires few of 
the course skills and requires significant assistance should also receive this designation. 

Satisfactory 
A “satisfactory” mark should be reserved for the student who attains most course skills 
and completes most projects. Some additional practice may be needed in a few areas, but 
overall progress is acceptable. 

Mastered 

“Mastered” indicates that a student has completed all of the projects and has attained all 
course skills and objectives. This student can perform tasks automatically.  

Superior 
Few students will attain the “superior” mark. This is for the student who exceeds 
expectations. For example, a superior student may apply multimedia skills to create 
innovative projects. 
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Student Performance Review 

Student:        Date:     

Reviewer:        Grade:    
 

Performance Criteria 1 
Unsatisfactory 

2 
Needs Practice 

3 
Satisfactory 

4 
Mastered 

5 
Superior 

Social Studies Skills 
 Strengthens targeted skills 
 Achieves stated lesson objectives 
 Understands how specific lesson 

fits into the larger whole 

 

 

   

Computer Skills 
 Effectively navigates menus and 

executes commands 
 Understands software application 

functions 
 Selects appropriate software to 

complete a given task 
 Demonstrates facility with 

hardware 

     

Participation and 
Teamwork 

 Actively participates in class 
discussions 

 Works cooperatively with 
classmates 

 Collaborates with partner 

     

Project Completion 
 Follows activity directions 
 Completes all steps in an activity 
 Fulfills project requirements 

     

 

Comments:            
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Project Self-evaluation Rubric 
 
Name:           

Date: ______________    Project Title:         
 

 
Evaluation Criteria 
 

1 
Unsatisfactory 

2 
Needs Practice 

3 
Satisfactory 

4 
Mastered 

5 
Superior 

Goals and Objectives 
 Purpose clearly articulated 
 Learning objectives achievable 

through project 
 Relevance of project to social studies 

content 

     

Software  
 Appropriate software applications 

utilized 
 Software capabilities enhance 

project 

     

Content Enhancement 
 Critical thinking skills emphasized 
 Creative and original approach to 

content or skills established 
 Active interaction with content 

necessary 

     

Student Involvement 
 Strong encouragement of originality 

and creativity 
 Engagement of student interest and 

enthusiasm 
 Potential for further exploration 

     

Integration of Technology 
 Technology essential to achieve 

learning objectives 
 New perspectives resulting from 

technology use 
 Strengthening of student technology 

skills  

     

Comments:            
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Module 3: The Internet 
History 

The Internet originated in a U.S. Department of Defense Project called ARPANET 
(Advanced Research Projects Agency Network). Established in 1969, ARPANET was 
designed to provide a secure communications network for organizations engaged in 
defense-related research. The key to its functionality was the TCP/IP (Transmission 
Control Protocol/Internet Protocol), which standardized addressing systems and 
communications protocol. In time, the National Science Foundation (NSF) networked 
ARPANET into the NSFNet. The two joined systems were able to handle more traffic than 
had been manageable previously, carrying data at the rate of 45 million bits per second. 

Today, the NSF continues to maintain the backbone of the network. Internet protocol 
development is governed by the Internet Architecture Board, and the naming of computers 
and networks is administered by InterNIC (Internet Network Information Center). 

World Wide Web 
Until 1989, the Internet was used primarily for e-mail and transferring files electronically. 
At that time, Tim Berners-Lee and his colleagues at CERN (in English, the European 
Particle Physics Laboratory) in Switzerland created the HyperText Transfer Protocol 
(http), which standardized communication between servers and clients. They then 
developed the first text-based Web browser released in 1992. The World Wide Web was 
rapidly accepted because of the creation of a Web browser called Mosaic, developed in 
the United States at the University of Illinois and released in September 1993. In April 
1994, the first large-scale commercial release of a Web browser, Netscape Navigator, 
revolutionized how the Internet was used. Millions of computers now use the Internet 
through the World Wide Web. 
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Searching on the Web 

There are two types of tools that can be used to search the World Wide Web: search 
engines and directories. Search engines explore the Web to find matches for keywords 
entered by the user. Directories are hierarchical subject indexes where users can choose 
headings, subheadings and topics. Many search engines now contain search directory 
features and vice versa. 

When searching for broad general information, first use a directory. For more specific 
information, use a search engine.  

Keywords are text entered by the user into a search engine or directory. Found matches 
(known as hits) appear in a list. To get an idea of what keywords users are currently 
entering, view Metaspy at http://www.metacrawler.com/info.metac/searchspy. These 
sites display keywords that people have entered to search with the WebCrawler search 
engine. If any of the listed keywords are clicked, the search results for those keywords will 
be displayed. 

Note: Because of potentially encountering mature content, it is best to view these sites 
outside the classroom setting. 

Keyword Search Assistance 

Certain word combinations assist in narrowing or broadening a Web search. They are 
called Boolean Operators, named after the English mathematician George Boole, the 
first person to incorporate logic into mathematics. This algebra of logic, called Boolean 
algebra, is considered a fundamental step in the computer revolution. The following 
words are useful for searches: 

AND  searches for all the keywords entered 

AND NOT cannot contain the word following  

OR  searches for at least one of the words 

Parentheses used for Boolean queries; e.g., “fruit AND (banana OR apple)” would 
search for (“ ”) sites containing the keywords “fruit” and “banana” or 
“fruit” and “apple.” Make sure to use all caps for Boolean operators and to 
leave a space on either side. 
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Standards and Performance Indicators 
on the Web 

International Society for Technology in Education 

The International Society for Technology in Education (ISTE) is a nonprofit professional 
organization dedicated to promoting appropriate uses of information technology in the 
support and improvement of learning, teaching and administration in K–12 and teacher 
education. Information about the National Educational Technology Standards (NETS) 
Project and the National Center for Preparing Tomorrow’s Teachers to Use Technology 
(NCPT3) is available at the ISTE site: 

http://www.iste.org/ 

National Council for the Social Studies 
The National Council for the Social Studies (NCSS) is devoted to improving the teaching 
and learning of social studies at all levels of education. For many years, the NCSS has 
provided a forum for the profession, an array of opportunities for teachers to continue 
their professional growth throughout their careers and a framework for cooperation to 
deal with issues that affect the teaching of social studies.  

http://www.ncss.org/ 

National Council for Accreditation of Teacher Education 

The National Council for Accreditation of Teacher Education (NCATE) is the 
profession’s forum to help establish high-quality teacher preparation. Through the 
process of professional accreditation of schools, colleges and departments of education, 
NCATE works to make a difference in the quality of teaching and teacher preparation 
today, tomorrow and for the next century. 

http://www.ncate.org/ 
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Web Addresses:  
Departments of Education 

U. S. Department  
of Education 

http://www.ed.gov/ 
Library > Education > K-12 Education > Government 
Policies > State Ed. Depts. 

 

State Departments of Education 
Alabama http://www.alsde.edu/ 
Alaska http://www.eed.state.ak.us/ 

Arizona http://www.ade.state.az.us/ 

Arkansas http://arkansased.org/ 

California http://www.cde.ca.gov/ 

Colorado http://www.cde.state.co.us/ 

Connecticut http://www.state.ct.us/sde/ 

Delaware http://www.doe.state.de.us/ 

District of Columbia http://www.seo.dc.gov/seo/site/default.asp 

Florida  http://www.fldoe.org/ 

Georgia http://www.doe.k12.ga.us/ 

Hawaii http://doe.k12.hi.us/ 

Idaho http://www.sde.state.id.us/Dept/ 

Illinois http://www.isbe.state.il.us/ 

Indiana http://www.doe.state.in.us/ 

Iowa http://www.state.ia.us/educate/ 

Kansas http://www.ksbe.state.ks.us/Welcome.html 

Kentucky  http://www.kde.state.ky.us/ 

Louisiana http://www.doe.state.la.us/DOE/asps/home.asp 

Maine http://www.maine.gov/education/ 

Maryland http://www.marylandpublicschools.org/msde 

Massachusetts http://www.doe.mass.edu/ 

Michigan http://www.michigan.gov/mde 
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State Departments of Education, (continued) 
 

Minnesota http://children.state.mn.us/mde/index.html 

Mississippi http://www.mde.k12.ms.us/ 

Montana http://www.opi.state.mt.us/ 

Nebraska http://www.nde.state.ne.us/ 

Nevada http://www.doe.nv.gov/ 

New Hampshire http://www.ed.state.nh.us/education/ 

New Jersey http://www.state.nj.us/education/index.html 

New Mexico http://sde.state.nm.us/index.html 

New York http://www.nysed.gov/ 

North Carolina http://www.dpi.state.nc.us/ 

North Dakota http://www.dpi.state.nd.us/index.shtm 

Ohio http://www.ode.state.oh.us/ 

Oklahoma http://www.sde.state.ok.us/ 

Oregon http://www.ode.state.or.us/ 

Pennsylvania http://www.pde.psu.edu/ 

Rhode Island http://www.ridoe.net/ 

South Carolina http://www.sde.state.sc.us/ 

South Dakota http://doe.sd.gov/ 

Tennessee http://www.state.tn.us/education/ 

Texas http://www.tea.state.tx.us/ 

Utah http://www.usoe.k12.ut.us/ 

Vermont http://www.state.vt.us/educ/ 

Virginia http://www.pen.k12.va.us/go/VDOE/ 

Washington http://www.sbe.wa.gov/ 
West Virginia http://wvde.state.wv.us/ 

Wisconsin http://www.dpi.state.wi.us/index.html 

Wyoming http://www.k12.wy.us/wdehome.html 
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Social Studies Lesson Plans on the Web 

The following Web sites provide lesson plans and links to other sites for the development 
of technology-infused social studies projects: 

About.com presents social studies lesson plans 
http://7-12educators.about.com/msub1plnsost.htm 
 
Lessonplanx.com offers 3,500 lesson plans and worksheets for all grade levels 
http://lessonplanz.com/Lesson_Plans/Social_Studies/ 
 
Site created by two college professors with a multitude of useful links 
http://www.sitesforteachers.com/ 
 
A no-frills, clear index of lesson plans in nearly 70 categories presented by Awesome 
Library.org 
http://www.awesomelibrary.org/Classroom/Social_Studies/Social_Studies.html 
 
An interactive site with a good cross-section of social studies lesson plans 
http://www.lessonplanspage.com/SS.htm 

 
The Discovery Channel’s lesson plan page has some excellent suggestions 
http://school.discovery.com/lessonplans/ 
 
Blue Web site includes lesson plans (many more geared to primary grades) and more 
http://www.kn.pacbell.com/wired/bluewebn/ 
 



FUTUREKIDS, Inc.  Infusing Technology into Social Studies 2007 

Copyright © 2007 FUTUREKIDS, Inc.  85 

Technology Integration Activities 

The following Web sites provide useful resources and information for general technology 
integration in the classroom: 

University of Virginia School of Education site on integrating technology and teaching 
http://www.teacherlink.org/ 
 
Educational Development Center site on leadership and the new technologies 
http://main.edc.org/newsroom/closer-look/edtech.asp 
 
Commercial site with a range of school technology news from Eschoolness.org 
http://www.eschoolnews.org/ 
 
Further reading and links from the University of Alberta in Canada 
http://www.quasar.ualberta.ca/edpy485/edtech/ 
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Professional Development Sites on the Web 

Technology Integration Activities 

The following Web sites provide useful resources and information for general technology 
integration in the classroom: 

Internet classroom projects from The Kentucky Educational Network Internet  
http://www.ket.org/Education/IN/projects.html 
 
University of Virginia School of Education site on integrating technology and teaching 
http://www.teacherlink.org/ 
 
Educational Development Center site on leadership and the new technologies 
http://main.edc.org/newsroom/closer-look/edtech.asp 
 
Commercial site with a range of school technology news from Eschoolness.org 
http://www.eschoolnews.org/ 
 
Further reading and links from the University of Alberta in Canada 
http://www.quasar.ualberta.ca/edpy485/edtech/ 
 
Interesting group of Web sites presented by UNESCO Regional Office for Asia 
and the Pacific 
http://www.unescobkk.org/index.php?id=171 
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Bulletin Boards 

(Also called Web Forums, Message Boards, Discussion Boards) 
 
Messages and threaded discussion contributions can be posted on Internet bulletin boards. 
A bulletin board service is an online community that can be visited at any time to discuss 
current topics or share ideas and advice. Most Internet service providers offer a 
discussion board service to their members and many message boards can be joined 
through special interest Web sites. Some links to Web forums with active discussion 
groups on educational issues are listed below. 

Teacher’s Net 
http://www.teachers.net/forum/ 

Teacherfocus Forums 
http://www.teacherfocus.com/ 
 
Teacher Talk Forums 
http://www.iub.edu/~cafs/ttforum/ttforum.html 
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ListServs 

ListServs are e-mailing lists administered by special interest groups and Web 
communities. Members may subscribe to the e-mail list. Those who subscribe can 
monitor topics, post questions and responses and gather a range of ideas from others 
interested in the same topic. On an active e-mail list, information is usually up-to-date 
and useful to members of the group or Web community.  

About.com: a source of newsletters about various educational issues and trends 
http://home.about.com/education/index.htm?PM=59_0204_T 
 
AskEric: archives of more than 20 educational lists 
http://ericir.syr.edu/Virtual/Listserv_Archives/ 
 
CataList: 47,172 public lists out of 169,278 LISTSERV lists  
http://www.lsoft.com/lists/listref.html 
 
Community Learning Network WWW home page. CLN is designed to help K-12 
teachers integrate technology into their classrooms 
http://www.cln.org/lists/home.html 
 
Washington State Educational Technology Support Center Listserv discussion group 
listing 
http://etsc.esd105.wednet.edu 
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Operating Systems: 
Hardware Basics 

Hardware: Physical components that comprise a computer system. 

Software: Applications that direct a computer to perform various operations. 

________________________________________________________ 

The two major hardware platforms are IBM compatibles (IBM clones or PCs) and 
Macintoshes.  IBM compatibles are made by such companies as IBM, Compaq, Dell, Hewlett-
Packard, Gateway, Acer, Micron and Toshiba.  Apple Inc. manufactures Macintoshes. 

________________________________________________________ 

Computers work on Base 2 numbers, instead of Base 10 and only know two possible states, on 
(1) or off (0), 

Computers store data as a 1 (one) or a 0 (zero).  This digit is known as a bit (binary digit). 
8 bits = 1 byte = 1 character 
1 kilobyte = 1 K = 1,024 bytes 
1 megabyte = 1 MB = 1,024 K = 1,048,576 bytes 
1 gigabyte = 1 GB = 1,024 MB = 1,048,576 K = 1,100,000,000,000 bytes 

________________________________________________________ 

A computer system contains input devices, processing components, storage devices and output 
devices. 

Input Devices 

Keyboard: Similar to a typewriter keyboard, with extra keys such as control (Ctrl), escape 
(ESC), alt, enter, arrow keys and function keys (F1, F2, etc.). 

Mouse: Small handheld device with a rotating ball underneath that when moved across a flat 
surface, such as a mousepad, relays signals to move the cursor on the screen. The mouse button 
is pressed to perform tasks. Similar devices include the trackball, track pad and track point.  
Mice are also available in optical and laser, in place of the conventional ball mouse. 

Scanner: Device that converts text or graphics from a printed page into an electronic file that can 
be stored or manipulated.  Flatbed and handheld scanners are the two main scanner types. 

Miscellaneous: Joysticks, touch screens, bar code readers, graphics tablets, digital cameras and 
microphones are also input devices. 
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Hardware Basics [continued] 

Output Devices 

Monitor: Video display unit.  Monitors can display at least 65,000 colors using 16 bit color.  
Typical monitors these days display using 32 bit color which is about 16.7 million colors.  

Printer: Device that allows users to obtain a hard copy of their documents.  Two main types of 
printers are inkjet and laser. Printer quality is determined by dots per inch (dpi). 

Speakers: Devices for audio output.  Speakers today can produce stereo-quality sound. 

________________________________________________________ 

Input and Output 

Modem (modulator demodulator): A mechanism that converts the digital data from the 
computer to analog signals (waves as tones) so that information can be transmitted over 
telephone or cable lines.  It also translates the incoming analog signals back to digital data.  A 
modem’s bps (bits per second) indicates how fast it can send and receive information.  Modems 
can be external or internal to the computer system. 

Peripherals: A term used to describe all input and output devices. 

________________________________________________________ 

Processing Components 

CPU (central processing unit): The speed of the microprocessor's internal clock, measured in 
megahertz (MHz), determines how many times it can transition between on (1) or off (0) each 
second.  This is a prime, though not the only, indication of processing speed and power as every 
transition indicates instructions being executed.  Pentium, Pentium II, Pentium III, Celeron and 
K6 are CPU type examples. 

ROM (read-only memory): Fundamental instructions required for the computer to operate that 
cannot be erased. ROM is recorded during the computer’s manufacturing. 

RAM (random-access memory): “Working memory” accessed when software is used. RAM is 
cleared when the computer is turned off and can be upgraded to increase the memory capacity. 
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Hardware Basics [continued] 

Storage Devices 

Floppy disk drive: A device that allows a computer to read from and write to the floppy disk.  
The 3.5-inch floppy disk holds 1.5 megabytes of data enclosed in a plastic case. Floppy disks use 
a magnetically coated flexible Mylar disk enclosed in a plastic case. 

Hard drive: A device that uses many rigid disks coated with magnetic material that are 
permanently mounted inside the encased part of the computer system.  Hard disks have much 
more data capacity than floppy disks and can be accessed more quickly.  External hard drives 
may also be purchased. 

Floppy disks and hard disks are magnetic storage media. 

CD-ROM (compact disc read-only memory): Information can be read from the disc but not 
written to it.  It uses optical storage techniques to store up to 650 MB of data. Information can be 
accessed from a CD-ROM faster than from a floppy disk but slower than from a hard drive. 

CD-ROM-RW (compact disc read-write): Information can be both written to and read from 
the disc. Optical storage techniques can store up to 700 MB of audio or data files.  CD-R discs 
can be recorded but are permanent and are often used for audio files; CD-RW discs can be erased 
and re-recorded but may only be used for data. 

ZIP Drive: Data can be stored on these “super” discs which hold 100 MB to 250 MB of 
information.  These devices are often external peripherals, but they can be internal. 

DVD (Digital Video Disc): DVD is becoming much more common due to the large storage 
capacity (over 4 GBs).  DVD is an optical disc storage media format that can be used to store 
high video and sound quality.  They resemble CDs but are encoded in a different format and a 
much higher density. 

USB Flash Drive: Flash memory data storage devices integrated with a USB interface. These 
are typically small, lightweight, removable and rewritable. Memory capacity typically ranges 
from 8 megabytes up to 64 gigabytes. 

 



FUTUREKIDS, Inc.                                          Infusing Technology into Social Studies 2007 Appendix 

A 4                    Copyright © 2007 FUTUREKIDS, Inc. 

Operating Systems: File Organization 
 

Back up (verb): the act of copying information to a disk 
Backup (noun): the information copied to a disk 

It is important to back up all new document files.  Files that have been backed up can be restored 
in case a file becomes corrupt (damaged).  

Backing up should be performed regularly.  Back ups should also be stored in a physically 
separate location from the main data to prevent loss from events that can cause the loss of the 
main data (i.e. fire, flood, earthquake). 

Utility applications can be purchased that contain features to help back up files. 

The Microsoft Windows backup utility can be launched by selecting START V ALL PROGRAMS V 
ACCESSORIES V SYSTEM TOOLS V BACKUP.  Depending on your version of Windows, this might 
be slightly different. 

Using Windows Explorer, files can be backed up manually by copying them to a floppy disk or 
to a networked drive. 

Be careful when replacing a file or folder with another of the same name.  In general, the newer 
version should replace the older.  When in doubt, it is prudent to save the new file with a slightly 
different file name so that important data is not lost.  

The following instructions apply to both Windows Explorer and My Computer. 

To select more than one file: 

1. Choose the first file. 
2. Hold down the CONTROL key. 
3. Select other files as desired. 
or 
1. Choose the first file. 
2. Hold down the SHIFT key. 
3. Select the last file, and all other files between the first and the last are highlighted. 

To move files from one location on a drive to another location on the same drive: 

1. Select the files. 
2. Drag the files to another location on the same drive. 
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File Organization [continued] 

To copy files from one location on a drive to a different drive: 
1. Select the files. 
2. Drag the files to another drive. 

To copy files from one location on a drive to another location on the same drive: 
1. Select the files. 
2. Press and hold down the CONTROL key. 
3. Drag the files from one location to another. 

To format a floppy disk: 
1. Insert the floppy disk into the floppy drive. 
2. Right-click the floppy drive and choose FORMAT from the pop-up menu. 
3. Choose the FULL radio button in the Format Type group. 
4. Click start. 
5. After the formatting is complete, select the CLOSE button when the summary appears. 
6. Close the Format Floppy window. 

Tips for Organizing the Hard Drive: 
1. Organize the hard drive by using Windows Explorer or My Computer. 
2. Use folders liberally to help categorize the files in a meaningful manner.  
3. Hard drive organization will likely change with time and experience.  Be certain to 

incorporate new techniques as they are learned. 
4. Attempt to determine the most efficient way to organize files and folders with respect to 

the potential tasks and users. 
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Word Processing Basics 
Word processing is the use of a computer application to create, edit, format and print 
documents.  

Common word processing programs today are Microsoft Word, WordPerfect, AppleWorks and 
WordPro. Word processing applications specifically designed for children include Storybook 
Weaver Deluxe, The Writing Center, Creative Writer and ClarisWorks for Kids. 

Word wrap is a word processing feature that automatically moves continuing text to the line 
below when the previous line becomes full. The ENTER key should be pressed only at the end of 
a paragraph to move the cursor to the next line.  

The paragraph symbol indicates the end of each paragraph but does not appear on the printed 
document. Other non-printing characters include a raised dot representing a space, and an 
arrow for a tab. Users may choose whether to display these non-printing characters. 

Word Processors today are WYSIWYG in format (pronounced wizzy-wig, short for What You 
See Is What You Get). The screen shows the appearance of the printed document. 

The main features of word processing can be categorized as either editing or formatting 
functions.  Editing features allow users to alter the content of text.  Formatting features affect 
how information appears within a document.  Formatting can be performed before the text is 
entered, while text is entered, or after the text is complete.  To format text after it has been 
entered, highlight the text, then choose the desired formatting options. 

Word processors allow users to access a variety of fonts. A font is an individual design of letters, 
numbers and punctuation characters. Many thousands of fonts exist. Fonts can be categorized as 
either serif or sans serif.  Serif refers to cross strokes at the end points of letters and numbers, and 
sans is French for without.  Compare the following: 

Courier New is an example of a serif font. 
Arial is an example of a sans serif font. 

Consider using a serif font for text in the body of a document because it is easier to read. Sans 
serif fonts are typically used for shorter amounts of text, such as titles. 

The size of a font is measured in points.  One inch is equal to 72 points, and one centimeter is 
equal to 28 points.  Font sizes of 10 or 12 point are common for text in the body of documents. 
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Word Processing Basics [continued] 
The font style refers to the defining characteristics that can be applied to fonts.  The most 
common font styles are italic, underline and bold.  In general, avoid applying multiple styles, 
such as bold and italics, to text.  

Bullets are symbols (often a solid circle or square) used to distinguish items in a list. Bullets are 
used when listing items of relatively equal importance.  Numbers can be inserted automatically 
to signify order in a list of items. 

Margins are the blank spaces at the top, bottom, left and right edges of a document. The word 
wrap feature keeps text within the specified margins. Most printers require margins of at least 
half an inch. 

Text alignment (also known as justification) refers to how text appears in relation to the left and 
right margins. Alignment applies to all of the text within a paragraph. Compare the alignment of 
the following three sentences. 

This sentence is left aligned. 
This sentence is center aligned. 

This sentence is right aligned. 

Other sentences in this document are justified (also known as full justification), meaning the text 
is aligned with both the left and the right margins. 

The header comprises the text or graphics that appear at the top of every page in a multi-page 
document. Text or graphics at the bottom of each page comprise the footer. Page numbers are 
often inserted into the header or footer.  It is possible to create different headers and footers for 
odd and even pages, as well as for the first page of a document. 

A footnote is a note of reference or a comment that appears at the bottom of a page. An endnote 
is a note of reference or a comment that appears at the end of the document. To let readers know 
that a footnote or an endnote exists for a particular section of body text, superscript numbers (or 
sometimes symbols) are inserted after the corresponding sentence. 

Clip art is a collection of previously created graphics that can be added to documents. 

Documents can be printed in different page orientations.  Portrait orientation refers to a printed 
page that is taller than it is wide.  Portrait orientation is the default printing option in almost all 
applications.  Landscape orientation is used to print a page that is wider than it is tall. 
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Word Processing Basics: 
Using Microsoft Word 2007 
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Using Microsoft Word 2007: 
Getting Started 

To open an existing document: 
1. From the MICROSOFT OFFICE button  in the top left corner choose OPEN. 
2. Locate the file and click OPEN. 

To create a new document: 
1. From the MICROSOFT OFFICE button choose NEW.   
2. Select BLANK DOCUMENT and click CREATE. 

To create a new document based on a template or a wizard: 
1. From the MICROSOFT OFFICE button choose NEW. 
2. Under Template Categories on the left, chose a document type.  For some templates 

you must have internet access. 
3. Select the desired document style and click CREATE. 

To display a document in Normal View: 
 From the VIEW TAB select DRAFT. 

To display a document in Print Layout View: 
 From the VIEW TAB select PRINT LAYOUT. 

To enlarge or to reduce the view of a document: 
1. From the VIEW TAB click the ZOOM button, then choose a percentage from the preset 

choices or a custom percent with the PERCENT drop-down box.  
2. Select the desired percentage.  Click OK. 

To hide or to show non-printing characters: 
 From the HOME TAB click the SHOW/HIDE button.   

To check spelling while typing: 
1. From the REVIEW TAB select SPELLING & GRAMMAR. The document will be auto checked for 

spelling and grammar. 
2. Word indicates possible spelling errors with wavy red underlines. To correct an error, right-

click a word with a wavy red underline, then select the appropriate correction listed in the 
pop-up menu. 
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Using Microsoft Word 2007: 
Inserting Text and Objects 

To insert a table: 
1. Position the cursor where the table will be added. 
2. From the INSERT TAB select the TABLE button.   
3. Highlight the appropriate number of cells from the menu. 
4. Click the left mouse button to insert the table into the document. 

To insert a picture from another file: 
1. Position the cursor in the location where the picture will be placed. 
2. From the INSERT TAB click on the PICTURE button.   
3. Locate and select the appropriate file, then click INSERT. 

To insert clip art: 
1. Position the cursor where the clip art will be added. 
2. From the INSERT TAB click on the CLIP ART button.   
3. Select the clip art to be added and click the insert clip button from the menu on the right side 

of the screen. 
4. Close the INSERT CLIP ART TAB. 
 
To insert SmartArt (Diagram): 
1. Position the cursor where the diagram will be added. 
2. From the INSERT TAB click on the SMARTART button.   
3. Choose a DIAGRAM TYPE and click OK. 

To insert WordArt: 
1. From the INSERT TAB click on WORDART. 
2. Choose a WordArt style and click OK. 
3. Enter and format the text, then click OK. 
4. Resize and reposition the WordArt as desired. 

To insert a page break: 
1. Position the cursor on the line below where the page break will be added. 
2. From the INSERT TAB click on PAGE BREAK. 
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Using Microsoft Word 2007: 
Inserting Text and Objects [continued] 

To insert page numbers: 
1. Position the cursor in the footer or where the page numbers will be inserted. 
2. From the INSERT TAB click on PAGE NUMBER. 
3. Make the desired selections from the Position and Alignment drop-down lists. 
4. The page number will be automatically added to the document. 

To create a header or a footer: 
1. From the INSERT TAB click on HEADER or FOOTER. 
2. From the drop-down list choose the HEADER style. 
3. To create a footer, click the GO TO FOOTER button in the NAVIGATION SECTION.   
4. Select the CLOSE button in the DESIGN TAB. 

To insert a footnote or an endnote: 
1.  From the REFERENCES TAB click on INSERT FOOTNOTE.   
2.  From the REFERENCES TAB click on INSERT FOOTNOTE.   

To insert a symbol not shown on the keyboard: 
1.  Position the cursor where the symbol will be added. 
2.  From the INSERT TAB click on SYMBOL. 
3.  From the drop-down menu, select the symbol or character to be inserted. 

To insert the current date and time in a document: 
1. Position the cursor where the date or time will be added. 
2. From the INSERT TAB click on the  DATE AND TIME logo.   
3. Choose the desired option from the Available Formats list, then click OK. 

Tip: To automatically update the date or time whenever a document is opened or printed, 
check the UPDATE AUTOMATICALLY option in the Date and Time dialog box when 
inserting the date or time. Otherwise, the document will print the original date or time. 
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Using Microsoft Word 2007: Editing 

To select all of the text in a document: 
1. From the HOME TAB click on SELECT.  
2. From the drop-down box click on SELECT ALL. 

To find a keyword or a phrase in a document: 
1. From the HOME TAB click on FIND.  
2. Enter the keyword or phrase in the Find What text box, and select FIND NEXT. 

Tip: The located text will be automatically highlighted.  To edit the text, close the Find and 
Replace dialog box and make the necessary changes. 

To replace a keyword or a phrase in a document: 
1. From the HOME TAB click on REPLACE.  
2. Enter the text to be replaced in the Find What text box. 
3. Enter the replacement text in the Replace With text box. 
4. Select FIND NEXT to locate the text. 
5. Choose REPLACE to make the change, then click FIND NEXT to continue or select CLOSE. 

Tip: If multiple occurrences of text are being replaced, choose the REPLACE ALL button. 

To view a specific page within a multi-page document: 
1. From the HOME TAB click on GO TO. 
2. On the GO TO tab of the Find and Replace dialog box, verify that page is selected in the GO TO 

WHAT list box. 
3. Enter the desired page number in the Enter Page Number text box, then click GO TO. 
4. Click the CLOSE button to close the dialog box. 

To copy text: 
1. Highlight the text to be copied. 
2. From the HOME TAB click on the COPY button.   
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Using Microsoft Word 2007: 
Editing [continued] 

To cut text from a document: 
1. Highlight the text to be cut. 
2. From the HOME TAB click on the CUT button.   

To paste text that has been copied or cut from a document: 
1. Position the cursor where the text is to be pasted. 
2. From the HOME TAB click on the PASTE button.   

Tip: The last text copied or cut to the Clipboard will be pasted. 

To undo the last action performed: 

1. Select the UNDO button  on the QUICK ACCESS TOOLBAR on the top left. 

To undo one or more previous actions: 
1. Select the drop-down arrow next to the UNDO button.   
2. Select the appropriate actions to be undone. 

To redo the last action undone: 
 Select the redo button  on the on the QUICK ACCESS TOOLBAR. 

To replace text manually: 
1. Highlight the text to be replaced. 
2. Enter the new text. 
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Using Microsoft Word 2007: Formatting 

To change the text font: 
1. Highlight the text to be changed. 
2. Select the appropriate font from the FONT drop-down list.   

To change the size of text: 
1. Highlight the text to be changed. 
2. Select a point size from the FONT SIZE drop-down list.   

To bold text: 
1. Highlight the text. 
2. Select the BOLD button  on the FONT GROUP of the HOME TAB.  

To italicize text: 
1. Highlight the text to be italicized. 
2. Select the ITALIC button  on the FONT GROUP of the HOME TAB. 

To underline text: 
1. Highlight the text to be underlined. 
2. Select the UNDERLINE button  on the FONT GROUP of the HOME TAB. 

To change the color of text: 
1. Highlight the text to be changed. 
2. Click the FONT COLOR drop-down arrow.   
3. Select the appropriate color from the menu. 

To center a paragraph of text: 
1. Highlight the text to be centered. 
2. Click the CENTER button  on the PARAGRAPH GROUP of the HOME TAB. 

To align a paragraph of text to the left margin:  
1. Highlight the text to be aligned. 
2. Click the ALIGN LEFT button  on the PARAGRAPH GROUP of the HOME TAB. 

To align a paragraph of text to the right margin: 
1. Highlight the text to be aligned. 
2. Click the ALIGN RIGHT button  on the PARAGRAPH GROUP of the HOME TAB. 
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Using Microsoft Word 2007: 
Formatting [continued] 

To justify a paragraph of text: 

1. Highlight the text to be justified. 
2. Click the JUSTIFY button  on the PARAGRAPH GROUP of the HOME TAB. 

To increase the indent of a paragraph: 
1. Highlight the text to be indented. 
2. Choose the INCREASE INDENT button  on the PARAGRAPH GROUP of the HOME TAB. 

To decrease the indent of a paragraph: 
1. Highlight the text to be changed. 
2. Choose the DECREASE INDENT button  on the PARAGRAPH GROUP of the HOME TAB. 

To change the vertical alignment of text in a document: 
1. From the PAGE LAYOUT TAB, open the PAGE SETUP box by clicking  in the bottom right 

corner of the PAGE SETUP GROUP.  This button is called the Dialog Box Launcher. 
2. On the LAYOUT tab, choose a VERTICAL ALIGNMENT from the drop-down box. 
3. Click OK. 

To change line spacing: 
1. Highlight the paragraphs to be changed. 
2. From the PAGE LAYOUT TAB, open the PARAGRAPH box by clicking  in the bottom right 

corner of the PARAGRAPH GROUP. 
3. On the INDENTS AND SPACING TAB, select an option from the LINE SPACING drop-down list. 
4. Click OK. 

To create a bulleted list from text:  
1. Highlight the text to be bulleted. 
2. Click the BULLETS button  on the PARAGRAPH GROUP of the HOME TAB. 

To modify a bulleted list: 
1. Highlight the bulleted list to be changed. 
2. Click the drop-down arrow on the BULLETS button on PARAGRAPH GROUP of the HOME TAB. 
3. On the BULLET drop-down, select a bullet. 
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Using Microsoft Word 2007: 
Formatting [continued] 

To create a numbered list from text: 
1. Highlight the text to be numbered. 
2. Click the NUMBERING button  on the PARAGRAPH GROUP of the HOME TAB. 

To modify a numbered list:  
1. Highlight the numbered list to be changed. 
2. Click the drop-down arrow on the NUMBERING button on the PARAGRAPH GROUP of the HOME 

TAB. 
3. On the NUMBER drop-down list, select the appropriate options. 

To add a border to a page in a document: 
1. From the PAGE LAYOUT TAB choose PAGE BORDERS. 
2. Select the desired options and click OK. 

To format text as columns: 
1. Highlight the text to be formatted as columns. 
2. Choose the COLUMNS button  on the PAGE LAYOUT TAB. 
3. Select the appropriate number of columns from the drop-down menu. 

To set a tab: 
1. Highlight the paragraphs to be formatted.  
2. Click the horizontal ruler at the desired location for the tab. 

Tip: If you do not see the ruler at the top of the screen, go to the VIEW TAB and click the 
checkbox next to RULER. 
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Using Microsoft Word 2007: 
Finishing Touches 

 
To check spelling and grammar: 
1. From the REVIEW TAB select SPELLING & GRAMMAR.  The document will be auto checked for 

spelling and grammar. 
2. Word indicates possible spelling errors with wavy red underlines.  To correct an error, right-

click a word with a wavy red underline, then select the appropriate correction listed in the 
pop-up menu. 

3. When a possible spelling or grammatical error has been located, make the necessary changes 
in the Spelling and Grammar dialog box and select CHANGE.  
Tip: To check spelling or grammar on a particular section of the document, highlight only 

that section before choosing the SPELLING & GRAMMAR button. 

To count the number of words in a document: 
 From the REVIEW TAB select WORD COUNT.    

To change the margins of a document:  
1. From the PAGE LAYOUT TAB select MARGINS. 
2. On the MARGINS drop-down, select the desired margin settings. 

To save a new document: 
1. From the MICROSOFT OFFICE button choose SAVE. 
 or 
1. Click the SAVE button  on the QUICK ACCESS TOOLBAR. 
2. Navigate to the appropriate location to store the document, enter a name for the document in 

the File Name box and select SAVE. 
Tip: To save the document in a new folder, click the NEW FOLDER button  before 

selecting SAVE.  

To save a document with the same name: 
1. From the MICROSOFT OFFICE button choose SAVE. 

or 
2. Click the SAVE button  on the QUICK ACCESS TOOLBAR. 
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Using Microsoft Word 2007: 
Finishing Touches [continued] 

 
To save a document with a new name: 
1. From the MICROSOFT OFFICE button choose SAVE AS. 
2. Navigate to the desired location and enter a new name in the File Name box. 
3. Click SAVE.  

To preview a document before printing: 
1. From the MICROSOFT OFFICE button choose PRINT then PRINT PREVIEW. 

or 
1. Click the PRINT PREVIEW button  on the QUICK ACCESS TOOLBAR. 
2. Select the CLOSE button to exit Print Preview. 

Tip: The PRINT PREVIEW button may have to be added by customizing this toolbar. 

To print a document: 
1. From the MICROSOFT OFFICE button choose PRINT. 
2. Enter the range of pages and the number of copies to be printed. 
3. Click OK. 

Tip: To print the whole document, click the PRINT button  on the QUICK ACCESS  
TOOLBAR. 

To print an envelope: 
1. From the MAILINGS TAB choose ENVELOPES.  
2. On the ENVELOPES tab, enter the envelope size under OPTIONS and click ok. 
3. Enter the delivery address and the return address (or select the OMIT check box) and click 

PRINT. 
Tip: To print an envelope for an existing letter, select the name and address within the text 

body, then follow the steps above and verify that the delivery address appears on the 
ENVELOPES tab. 

 

To close a document: 
 From the MICROSOFT OFFICE button choose CLOSE. 
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Additional Features in Microsoft Word 2007: 
 

Quick Access Toolbar: 
1. Tools or commands that are not as readily available as you would like can be easily accessed 

by adding them to the QUICK ACCESS TOOLBAR. 
2. To add a button right click on a feature in a tab, then click ADD TO QUICK ACCESS TOOLBAR.  

You may remove a button the same way, by right clicking and choosing REMOVE FROM 
QUICK ACCESS TOOLBAR. 
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Graphics Basics 
The term graphics refers to the use of a computer to create and modify images.  Microsoft Paint 
5.1 is an example of a graphics program.  Microsoft Office 2000 Professional contains graphics 
tools that are collectively known as Office Art.  The newest drawing tool to be added to the 
Microsoft family is called SmartArt, and is available in the Office 2007 Suite.  SmartArt graphics 
allow you to create process charts, radial charts, organization charts, and more.  More advanced 
graphics applications include Adobe Illustrator, Adobe Photoshop, CorelDRAW and Dabbler by 
Fractal Design. 

Common graphics file formats include: 

 *.bmp (Bitmap graphics), *.jpg (Joint Photographic Experts Group), *.gif (Graphics Interchange 
Format) and *.tif (Tagged-Image File Format). 

Painting Programs: 
The two basic types of computer graphics applications are paint programs and draw programs.  
Paint is an example of a paint program. 
1. Graphics are created by modifying pixels.  A pixel is a single point in a graphic 

image. 
2. Images are known as bitmap graphics (or raster graphics). 
3. Painting tools mimic such real-life art tools as a pencil, an eraser, an airbrush, a 

paintbrush and a paint bucket. 
4. Lines and shapes of varying thickness and color can be created. 
5. Any portion of the picture can be selected to be moved, resized, flipped or rotated. 
6. Clipart images can be inserted and modified. 
7. Graphics become distorted (pixelated) when enlarged. 
8. Painting programs are best suited for free-form artwork including delicate designs, 

shading and other artistic effects. 

Drawing Programs: 

Office Art is a set of drawing tools found in Microsoft Word 2003, Excel 2003 and 
PowerPoint 2003, and is accessible through the Drawing toolbar.  The Drawing toolbar is 
not available in most of Microsoft Office 2007, and has been replaced by the Ribbon. 
1. Images are known as object-oriented graphics (or vector graphics). 
2. The directional lines (vectors) that constitute a graphic are stored as mathematical 

formulas. 
3. Graphics are treated as separate objects. 
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Graphics Basics [continued] 
 

1. Graphics can be grouped and manipulated as one object or ungrouped and 
manipulated as separate objects. 

2. Graphics are created in separate layers that can be reordered. 
3. Graphics can be easily modified at any time. 
4. Lines and shapes of various thickness and color can be created. 
5. Objects can be selected and moved, resized, flipped or rotated. 
6. Clip art can be inserted and modified. 
7. Graphics do not become distorted when enlarged. 
8. Drawing programs are best-suited for projects using shapes and lines in which the 

ability to reposition and resize is important. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This circle was enlarged in a painting 
program.  Note the distortion. 

This circle was enlarged in a drawing 
program.  No distortion occurred. 

Handles corner handle: resizes the graphic 
both vertically and horizontally 

left- or right-side handle: 
resizes the graphic 
horizontally 

top or bottom handle: resizes 
the graphic vertically  



FUTUREKIDS, Inc.                                          Infusing Technology into Social Studies 2007 Appendix 

A 22                    Copyright © 2007 FUTUREKIDS, Inc. 

Graphics Basics: Sources of Graphics 

Original Work 
Graphics created from scratch are considered original artwork.  When time is limited, previously 
created graphics can be reused and modified.  Some benefits of creating original images include 
fostering artistic and creative skills, ensuring the complete ownership of the material (no 
copyright issues) and promoting exploration and discovery of the capabilities of the graphics 
tools.   Disadvantages include the time-consuming nature of creating original artwork, the 
difficulty of making realistic-looking images and the limitations of the graphics capabilities 
within some programs. 

Scanners 
Scanners are peripheral devices that convert artwork or text from a printed page to an electronic 
file which can be stored or manipulated in other programs.  The conversion process is known as 
digitizing.  The two main types of scanners are flatbed, which are similar to a photocopy 
machine, and handheld,  which are dragged across the page. Like printer quality, scanner quality 
is determined by its dpi (dots per inch).  Some advantages of scanning artwork include the 
abilities to use previously created images, to scan photographs and to personalize documents 
easily.  Some disadvantages include potential copyright violations, the length of time required to 
scan many images and the storage space demands that result from the large file sizes of scanned 
photographs and pictures. 

Digital Cameras 
A digital camera is similar to a regular camera in that a user points the lens of the handheld 
device at a subject, looks through a viewfinder and presses a button to take a picture.  A critical 
difference, however, is that a digital camera does not use film.  Instead, images are saved 
digitally and can be copied to a computer’s hard drive with a connecting cable.  Benefits of using 
a digital camera include the elimination of expensive and time-consuming film processing and 
scanning, the portability of the camera and low operating costs.  Some negative aspects include 
the high price of the camera, lower-quality pictures than film-based cameras, long downloading 
time and large hard drive space requirements. 
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Graphics Basics: 
Sources of Graphics [continued] 

Clip Art 
Clip Art is previously created digital artwork intended to be integrated into documents.  A 
collection of clip art is known as a clip art library.  To make it easier for users to browse and 
locate specific images, graphics in clip art libraries are often grouped in such categories as 
animals, food, household, maps and transportation.  When some applications, including 
Microsoft Word 2007 and Microsoft Publisher 2007, are installed, a clip art library is copied onto 
the computer’s hard drive.  With the exception of creating another clip art library, clip art can be 
used in any way without copyright violation.  There are CD-ROMs that contain clip art libraries 
of images either within a particular category or with an assortment of categories. 
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Desktop Publishing: Basics 
 

Desktop publishing is the process of using a computer to position text and graphics on a page to 
produce printed documents such as signs, newspapers, newsletters, magazines, brochures, 
banners, cards, calendars, letterheads, certificates, business cards, reports and resumes.  The term 
desktop publishing was coined in the mid-1980s with the arrival of the Apple Macintosh, page 
layout software and the laser printer.  For the first time, people could “publish” from their 
“desktop”, creating professional-looking printed materials at home. 

Examples of desktop publishing applications include Microsoft Publisher 2007, Adobe 
PageMaker and QuarkXPress. Other software packages with desktop publishing features include 
the Print Shop series (from Broderbund), Print Artist (from Sierra On-Line), The Children’s 
Writing and Publishing Center (from The Learning Company) and Corel Print House. 

 

 

 

 

 

 

 

 

 

 

 

Desktop Publishing Terminology 

Connect Text Boxes Toolbar Standard Toolbar 

Objects Toolbar 

Page navigation 
buttons 

Text 
wrapping

Layout 
guide 

Clipart 
Picture frame 

Scratch area 

Rulers 

Text frame 

Formatting Toolbar 
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Desktop Publishing Basics [continued] 
 

background: the layer in which text and images that appear in the same location on every page 
of a document are placed 

clip art: previously created digital artwork that is intended to be integrated into documents 

foreground: the layer in which the text and images that vary from page to page in a document 
are placed 

Greek text: a block of nonsensical text (representing the size and position of the actual text) used 
to evaluate the aesthetics of the page design 

grouping: joining together separate objects so the components can be manipulated as one object 

importing: the process of inserting text or graphics that originated in one program into another 
program 

landscape: the page orientation in which the page is wider than it is tall 

layers: invisible sheets on which users can place text or graphics so the objects are independent 
of other objects on other sheets 

layout: the process of arranging text and graphics on a page 

layout guides: nonprinting lines that can be helpful when placing text and graphics within a 
document  

linking: connecting text frames so that the excess text from the first frame flows into the second 
frame 

portrait: the page orientation in which the page is taller than it is wide 

picture frame: a movable and resizable placeholder for a graphic 

pull quote: a short phrase set in a larger type size that repeats information found within the 
article 

rulers: on-screen bars that measure the page horizontally and vertically 

scratch area: the nonprinting work area in which text and graphics can be placed before they are 
moved into a document 

text frame: a placeholder for text, which can be moved or resized 

text wrapping: the way that text flows around a graphic 

wizard: a Help feature that guides users through multistep processes to create common 
documents; including creating cards, newsletters, banners and resumes 
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Desktop Publishing:  
Using Microsoft Publisher 2007 

To create a new publication: 
1. Choose FILE V NEW. 
2. In the POPULAR PUBLICATION TYPES Task Pane, select the appropriate options to create the 

desired publication. 
3. When finished click CREATE.  

To create a bulleted list or a numbered list: 
1. Highlight the desired lines of text.  
2. Choose the BULLETS button  on the Formatting toolbar. 

Tip: To apply customized bullets, choose FORMAT V BULLETS AND NUMBERING. From the 
BULLETS tab, choose the desired bullet shape and size and select OK. 

To undo the last action: 
 Choose EDIT V UNDO. 

To insert page numbers on every page: 
1. Choose INSERT V PAGE NUMBERS. 
2. Select the POSITION and ALIGNMENT and click OK. 

To create a calendar, an advertisement, a coupon or a logo for an existing publication: 
1. Choose INSERT V DESIGN GALLERY OBJECT. 
2. On the OBJECTS BY CATEGORY tab, select CALENDARS, ADVERTISEMENTS, COUPONS or LOGOS 

from the Categories list.  
3. Choose the desired publication option in the menu to the right and click INSERT OBJECT. 
4. Resize and reposition the object and make any desired changes. 

Tip: You can double click on the desired publication option and it will be added to your 
document. 

To insert a new page: 
1. Select INSERT V PAGE. 
2. Enter and choose the desired options and click OK. 

To preview the document as it will be printed: 
1. Select VIEW 
2. Click on BOUNDARIES AND GUIDES to remove the checkmark. 
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Using Microsoft Publisher 2007 [continued] 

To change the orientation of a page: 
1. Select FILE V PAGE SETUP. 
2. In the BLANK PAGE SIZES group, select a page type. 
3. Choose a page option and click OK. 

To view the page at a specific percentage: 
 Click the ZOOM drop-down box on the Standard toolbar and choose a percentage. 

To view a different page within a document: 
 Click the appropriate PAGE NAVIGATION button at the bottom-left corner of the screen. 

Text Formatting and Editing        

To insert text: 
1. Click the TEXT FRAME tool  on the Objects toolbar. 
2. Drag to create a text frame. 
3. Enter text. 

To import text: 
1. Confirm that a text frame is selected. 
2. Choose INSERT V TEXT FILE. 
3. Navigate to and select the desired text file and click OK. 

To change the text font or text size: 
1. Highlight the desired text. 
2. Make the desired selections from the Font drop-down list or the Font Size drop-down list. 
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Using Microsoft Publisher 2007: 
Text Formatting and Editing [continued] 

To change the text style: 
1. Highlight the desired text. 
2. Choose the BOLD button , the ITALIC button  or the UNDERLINE button  on the 

Formatting toolbar. 

To change the color of text: 
1. Highlight the desired text. 
2. Select the FONT COLOR button  on the Formatting toolbar, then select a color. 

To change text alignment: 
1. Highlight the desired text. 
2. Select the LEFT button , the CENTER button , the RIGHT button  or the  

JUSTIFY button  on the Formatting toolbar. 

To link two text frames: 
1. Verify that a second frame already exists. If not, create one. 
2. Click the text frame containing the text. Confirm that the TEXT IN OVERFLOW button  is 

displayed on the frame’s bottom edge. 
3. Choose CREATE TEXT BOX LINK button  from the Connect Text Boxes toolbar on the top 

right. 
4. With the pitcher-shaped pointer , select the second text frame into which the overflow text 

should be placed.  

To change the number of columns in a text frame: 
1. Select a text frame. 
2. On the formatting toolbar choose the column button. 
3. Highlight the number of columns. 

To wrap text closely around an image: 
1. Select a graphic. 
2. Choose FORMAT V PICTURE. 
3. In the LAYOUT tab, select the features you desire and click OK. 
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Using Microsoft Publisher 2007: 
Text Formatting and Editing [continued] 

 
To insert the date or time into a text frame: 
1. Position the cursor in the desired location within a text frame. 
2. Choose INSERT V DATE AND TIME. 
3. Select an option from the Available Formats list. 
4. Choose the UPDATE AUTOMATICALLY check box if desired, then click OK. 

Graphics Formatting and Editing      

To insert clip art: 
1. Select the PICTURE FRAME tool  on the Objects toolbar. 
2. Choose the Clip Art logo  from the dropdown menu. 
3. Enter a keyword or keywords in the Search For Clips box, then press the GO. 
4. Choose the desired clip art image and it will automatically be entered into the document. 
5. Close the Insert Clip Art window. 

To insert a picture file: 
1. Select the PICTURE FRAME tool  on the Objects toolbar 
2. Choose PICTURE FROM FILE. 
3. Drag and create graphics frame. 
4. Navigate to and select the desired picture file from the Insert Picture box, then choose 

INSERT. 

To create a straight line: 
1. Choose the LINE tool  on the Objects toolbar. 
2. Click and hold down the mouse button to establish the line’s starting point, then drag to 

create the line. 
Tip: Holding down the SHIFT key while dragging the mouse can create horizontal, vertical 

and 45-degree angle lines. 

To create a straight line with one or two arrowheads: 
1. Select an existing line, or draw a new line. 
2. Choose the ARROW STYLE button  on the Formatting toolbar and choose an arrow style 

from the drop-down box. 
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Using Microsoft Publisher 2007: 
Graphics Formatting and Editing [continued] 

 
To change the thickness and color of a line: 
1. Select a line. 
2. Choose the LINE/BORDER STYLE button  on the Formatting toolbar.  
3. Select one of the displayed options in the menu, or choose MORE STYLES to select a customized 

line width, style and color.  

To create an oval: 
1. Select the OVAL tool  on the Objects toolbar. 
2. Drag the mouse diagonally to create an oval. 

Tip: Holding down the SHIFT key while dragging creates a circle. 

To create a rectangle: 
1. Click the RECTANGLE tool  on the Objects toolbar. 
2. Drag the mouse diagonally to create a rectangle. 

Tip: Holding down the SHIFT key while dragging creates a square. 

To create a custom shape: 
1. Select the CUSTOM SHAPES tool  on the Objects toolbar. 
2. Click the desired shape from the pop-up menu, then drag to create the shape. 

Tip: Holding down the SHIFT key while dragging creates a shape with the same horizontal 
and vertical proportions.  

To crop a bitmap image: 
1. Select an image. 
2. Click the CROP PICTURE tool  on the Picture toolbar. 
3. Drag a handle to crop the image. 
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Using Microsoft Publisher 2007: WordArt 
 

To insert WordArt: 
1. Click the WORDART FRAME tool  on the Objects toolbar.  
2. Select the WordArt shape, font and font size as desired, then click OK. 
3. Enter text into the Enter Your Text Here box, then click OK. 
4. Resize WordArt frame if needed. 

To change the style of the WordArt: 
1. Make sure the WordArt is chosen, and click EDIT TEXT on the WordArt toolbar. 
2. Use the BOLD button  to bold text and the ITALIC button  to italicize text. 
3. From the WordArt toolbar select the SAME LETTER HEIGHTS button  to make all of the 

letters the same height. 
4. To change the alignment of the WordArt text, click the JUSTIFICATION button  and select 

one of the alignment options. 
5. Select the CHARACTER SPACING button  to change the spacing between the letters. 

To change the orientation of the WordArt: 
1. Verify that the WordArt toolbar is open. If it is not displayed, click the WordArt. 
2. Select the WORDART VERTICAL TEXT button  to toggle the WordArt between Vertical and 

Horizontal. 
3. From the Arrange Menu choose ROTATE OR FLIP to rotate the WordArt at specified angles 

To change the color, shading, shadow and border for WordArt: 
1. From the Formatting menu choose the FILL COLOR button   to change the color of the 

text. 
2. Choose the LINE COLOR button  to change the color of the border around the text. 
3. Choose the SHADOW STYLE button   to add shadow to the WordArt. 
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Using Microsoft Publisher 2007: 
Working with Objects 

To group objects: 
1. Hold down the SHIFT key and click the objects to select them. 
2. Choose ARRANGE V GROUP OBJECTS. 

To ungroup an object: 
1. Confirm that the grouped object is selected. 
2. Choose ARRANGE V UNGROUP OBJECTS. 

To create a table: 
1. Select the  INSERT TABLE button  on the Objects toolbar. 
2. Drag to create a table frame of the desired dimensions. 
3. In the Create Table dialog box, enter the number of rows and columns, choose a table format 

and click OK. 
4. Enter information into the cells of the table, pressing the TAB key to move to the next cell. 

To change an object’s layer: 
1. Select an object. 
2. Choose the BRING FORWARD button   on the Standard toolbar. 

or 
1. Select an object. 
2. Choose ARRANGE V ORDER V BRING TO FRONT or ARRANGE V ORDER V SEND TO BACK. 

To move an object: 
1. Select an object. 
2. Position the pointer inside the object. 
3. When the pointer takes the shape of a quad arrow with a moving-truck icon, drag the object. 
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Using Microsoft Publisher 2007: 
Working with Objects [continued] 

To move an object in small increments:  
1. Select an object. 
2. Choose ARRANGE V NUDGE. 
3. Click one of the arrow buttons to move the object in the desired direction. 

Tip: Objects can also be nudged by holding down the ALT key and pressing one of the arrow 
keys on the keyboard. 

To duplicate an object:  
1. Select the object. 
2. Choose the COPY button  on the Standard toolbar or select EDIT V COPY. 
3. Choose the PASTE button  on the Standard toolbar or select EDIT V PASTE. 

Tip: Use the keyboard shortcut of CONTROL + C for the COPY command and CONTROL + V for 
the PASTE command.  

To resize an object:  
1. Select an object.  
2. Position the pointer on the handle. 
3. When the pointer takes the shape of a double arrow labeled resize, drag the handle. 

Tips: The corner handles resize the selection both horizontally and vertically.  The left- and 
right-side handles resize the object horizontally.  The top and bottom handles resize the 
object vertically.  Holding down the SHIFT key will keep the proportions of the object 
intact as it is resized. 

To fill an object with a solid color: 
1. Select an object. 
2. Choose the FILL COLOR button  on the Formatting toolbar and select a color or an option 

from the drop-down menu. 

To fill an object with a pattern: 
1. Select an object. Choose the FILL COLOR button  on the Formatting toolbar and 

select FILL EFFECTS. 
2. Click the PATTERNS tab and choose a pattern style. 
3. Make the desired selections from the FOREGROUND and BACKGROUND drop-down 

menus, then click OK. 
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Using Microsoft Publisher 2007: 
Working with Objects [continued] 

To fill an object with a gradient: 
1. Select an object. Choose the FILL COLOR button  on the Formatting toolbar and select fill 

effects. Click the GRADIENT tab and choose a gradient style. 
2. Make the desired selections from the Color 1 and Color 2 drop-down menus, then click OK. 

To add a border to an object: 
1. Select an object. Choose the LINE/BORDER STYLE button  on the Formatting toolbar. 
2. Choose one of the displayed line widths in the drop-down menu or select MORE LINES to 

customize the line width, style and color. 

To add a shadow to an object: 
1. Select an object. 
2. Choose SHADOW STYLE button.  

To flip an object: 
1. Select an object. 
2. ARRANGE V ROTATE OR FLIP V FLIP HORIZONTAL button  or ARRANGE V ROTATE OR FLIP 

V FLIP VERTICAL button.   

To rotate an object 90 degrees: 
1. Select an object. 
2. ARRANGE V ROTATE OR FLIP V ROTATE RIGHT button  or  ARRANGE V ROTATE OR FLIP 

V ROTATE LEFT button.   

To rotate an object any number of degrees: 
1. Select an object.   
2. ARRANGE V ROTATE OR FLIP V FREE ROTATE button.   
3. Rotate the object from the corners.  

To align objects: 
1. Select all of the objects to be aligned.  Choose ARRANGE V ALIGN OR DISTRIBUTE. 
2. Choose align left, align center, align right, align top, align middle or align bottom. 
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Multimedia Basics 
Multimedia can be defined as the use of two or more media elements, such as text, graphics, 
sound, animation and video.  Although a book containing text and graphics would be considered 
multimedia by this definition, most people consider television and computers typical multimedia 
environments.  The term hypermedia is often used as a synonym for multimedia. 

Common multimedia applications include Microsoft PowerPoint 2007, HyperStudio (by 
Knowledge Adventure) and Director (by Macromedia). For younger children, Kid Pix Studio 
Deluxe (by Broderbund) and Storybook Weaver Deluxe (by The Learning Company) are 
appropriate.  Other common multimedia applications are encyclopedias on CD-ROM including 
Microsoft Encarta, Grolier Multimedia Encyclopedia, Britannica CD and World Book 
Multimedia Encyclopedia. 

Many different media elements may be used when creating a multimedia presentation.  The 
following is a list of file extensions and file formats. 

 *.AVI (Audio Visual Interleave, a common Windows format for audio/video files) 
 *.MOV (a Macintosh-based audio/video file) 
 *.WAV (a Windows sound file) 
 *.JPG (Joint Photographic Experts Group, a graphics format often found on the World 

Wide Web) 
 *.GIF (Graphics Interchange Format, a graphics format often found on the World Wide 

Web) 
 *.BMP (Bitmap, a common format for Windows bitmap graphics) 
 *.WMF (Windows Metafile, a Windows object-oriented graphic) 
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Multimedia Basics [continued] 

Related Terms: 

animation: a series of still images displayed in rapid succession to create the illusion of 
movement 

branching slide: a slide that is linked to another slide in a presentation, providing users with a 
choice of which slide to view next 

digitalization: the process of transferring a film or video image to a format that a computer can use 

hot spot: an area on the screen that can be selected to trigger an action, such as playing a sound, 
animating a graphic or displaying a different slide 

medium: a single method used to communicate a message to an audience, including video, 
sound, text and graphics 

multimedia: a computer-based method of presenting information by using more than one 
medium of communication, such as text, graphics, sound and video 

slide: a screen in a PowerPoint presentation resembling an index card, on which users may 
arrange media elements 

Slide Master: a special slide that can be used to determine the layout and formatting of all slides 
in a presentation  

slide show: in presentation programs, several screens of information organized in a  
particular sequence  

stereo: sound that is recorded and played back on two or more channels 

storyboard: a series of panels on which a set of sketches is arranged for planning purposes 

transition: the special effect that occurs when one slide advances to the next in a presentation 

 

 

 

 

 

 



Infusing Technology into Social Studies 2007 Appendix                                          FUTUREKIDS, Inc. 

Copyright © 2007 FUTUREKIDS, Inc.  A 37 

Cut 

Paste 

Redo 
Line Spacing 

Text Direction 

Bold 

Italic 
Underline 

Microsoft Office 
Button UndoSave 

Copy 

Clear 
Formatting

Font Size 

Increase/Decrease 
Font Size

Bullets 

Numbering 

Decrease/Increase 
List Level 

Font Name 

Strikethrough 
Shadow 

Change 
 Case 

Align Left 

Center 

Align Right 

Font Color 

Character Spacing 

Justify 
Columns 

Align Text 

Convert 
To 

SmartArt 
Drawing Area 

Quick Access Toolbar 

Using Microsoft PowerPoint 2007 
  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Ribbon 

Microsoft Office Logo 

File Menu 



FUTUREKIDS, Inc.                                          Infusing Technology into Social Studies 2007 Appendix 

A 38                    Copyright © 2007 FUTUREKIDS, Inc. 

Using PowerPoint 2007: Getting Started 

To create a new presentation: 
1. From the MICROSOFT OFFICE button  in the top left corner choose NEW. 
2. In the NEW PRESENTATION Task Pane, select BLANK PRESENTATION, click CREATE. 
3. In the SLIDE GROUP of the HOME TAB, click on LAYOUT and select a slide layout for the first 

slide.  

To open an existing presentation: 
1. From the MICROSOFT OFFICE button in the top left corner choose OPEN. 
2. Locate the file to be opened and click OPEN. 

To create a new slide: 
 In the SLIDE GROUP of the HOME TAB, click on ADD SLIDE. 

To change the slide layout: 
1. In the SLIDE GROUP of the HOME TAB, click on LAYOUT and select a slide layout. 

2. This will only change the slide you are currently on. 

3. Choose a new master style in the VIEW TAB on the MASTER LAYOUT GROUP to change 
the style of all slides. 

To change the slide theme: 
1. In the THEMES GROUP of the DESIGN TAB, click on a theme. 

2. This theme will apply to all slides in the presentation. 

Tip: You can scroll through the theme options by pressing the down arrow on the 
right side of the themes box. 

 

 

 

 



Infusing Technology into Social Studies 2007 Appendix                                          FUTUREKIDS, Inc. 

Copyright © 2007 FUTUREKIDS, Inc.  A 39 

 

Using Microsoft PowerPoint 2007: 
Inserting Text and Objects 

To insert a text box: 
1. Choose the TEXT BOX tool  on the INSERT TAB. 
2. Hold down the mouse button and drag to create a text box. 

To insert clip art: 
1. Choose the CLIP ART tool on the INSERT TAB. 
2. Enter a keyword or keywords in the Search text box, then press GO. 
3. Choose the desired clip art image and it will automatically be added to the current slide. 
4. Close the CLIP ART Task Pane. 

To insert a picture from a file: 
1. Choose the PICTURE tool on the INSERT TAB. 
2. Navigate to the appropriate folder, select the file and click INSERT. 

To insert WordArt: 
1. Click the WORDART button  on the INSERT TAB. 
2. Select a WordArt style. 
3. Double click in the WordArt box to edit the text. 
4. You can format the WordArt on the FORMAT TAB. 
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Using Microsoft PowerPoint 2007: 

Inserting Text and Objects [continued] 

To insert a chart: 
1. Click the CHART button  on the INSERT TAB. 
2. Choose a chart style from the CREATE CHART box and click OK. 
3. Edit the chart’s contents in the Datasheet window. 
4. Click a blank space on the slide to return to the presentation. 
5. To close the Datasheet, go to the MICROSOFT OFFICE button in the top left corner 

choose CLOSE. 
6. You can edit the data by choosing the EDIT DATA SOURCE button on the DESIGN TAB. 

To insert a header or a footer: 
1. From the INSERT TAB choose HEADER & FOOTER.   
2. Select the desired options and click APPLY TO ALL. 

To insert the date and time: 
1. From the INSERT TAB choose DATE & TIME.   
2. Mark the checkbox next to Date and time and click APPLY TO ALL. 

Editing                                              

To cut text from a presentation: 
1. Highlight the text to be cut. 
2. Choose the CUT button  on the HOME TAB. 

To copy text: 
1. Highlight the text to be copied. 
2. Select the COPY button  on the HOME TAB. 
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Using Microsoft PowerPoint 2007: 
Editing [continued] 

To paste the most recently copied or cut text: 
1. Position the cursor where the text will be pasted. 
2. Choose the PASTE button  on the HOME TAB. 

To undo the last action: 
 Select the UNDO button  on the QUICK ACCESS TOOLBAR on the top left. 

To redo the last undone action: 
 Select the REDO button  on the QUICK ACCESS TOOLBAR. 

To delete a slide: 
1. In Normal View, display the slide to be deleted. 
2. Choose the DELETE button on the HOME TAB. 

To duplicate an object in the presentation: 
1. Select the object to be duplicated. 
2. From the HOME TAB click on the PASTE drop-down menu and choose DUPLICATE. 

Tips: Because clicking a text box once only positions the cursor, text boxes need to be 
clicked twice before the DUPLICATE command becomes available. To select more than 
one object at a time to be duplicated, hold down the SHIFT key while selecting objects. 

To find text in a presentation: 
1. Select FIND from the HOME TAB. 
2. In the Find What box, enter the text to be located and click FIND NEXT. 
3. After the text has been found, close the Find dialog box. 

To replace text in a presentation: 
1. Select REPLACE from the HOME TAB. 
2. In the Find What box, enter the text to be replaced. 
3. Enter the replacement text in the Replace With box and click FIND NEXT or REPLACE ALL. 
4. After the text has been replaced, close the Replace dialog box. 
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Using Microsoft PowerPoint 2007: 
Formatting 

To animate an object: 
1. Select the object to be animated. 
2. Click on the ANIMATIONS TAB and select the desired animation effect from the ANIMATE  drop-

down box. 
3. To add sound effects to an animation, choose a sound from the TRANSITION SOUND drop-down 

box. 

To format the slide color scheme: 
1. From the DESIGN TAB click on the COLORS drop-down box. 
2. Highlight a color and you will see a preview of your slide will look. 
3. Once you click on a color it will apply to all slides. 

To change the background color of the presentation: 
1. From the DESIGN TAB click on the BACKGROUND STYLES drop-down box. 
2. Select a color from the drop-down menu or click on BACKGROUND to add a gradient, texture 

or pattern fill. 

To reorder slides within a presentation: 
1. From the VIEW TAB choose SLIDE SORTER. 
2. Drag the slide to be reordered to the appropriate location. 
3. From the VIEW TAB  choose  NORMAL after the slides have been properly ordered. 

Tip: You can also reorder the slides in the preview tab on the left side in NORMAL view. 

To resize a text box or a picture: 
1. Select the object to be resized. 
2. Drag one of the object’s handles until it is properly resized. 
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Using Microsoft PowerPoint 2007: 
Formatting [continued] 

 

To bold text: 

1. Select the text to be bolded. 
2. Choose the BOLD button  on the HOME TAB. 

To italicize text: 
1. Select the text to be italicized. 
2. Choose the ITALIC button  on the HOME TAB. 

To underline text: 
1. Select the text to be underlined. 
2. Choose the UNDERLINE button  on the HOME TAB. 

To change the text font: 
1. Highlight the text. 
2. Select a new font from the FONT drop-down list on the HOME TAB. 

To change the text size: 
1. Highlight the text. 
2. Select a new font size from the FONT SIZE drop-down list. 

To change the text color: 
1. Highlight the text 
2. Select a color from the FONT COLOR drop-down list.   

To increase or decrease line or paragraph spacing: 
1. Highlight the text. 
2. Choose the LINE SPACING drop-down menu  from the HOME MENU. 
3. Make the desired selection or click on more for additional options then click OK. 
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Using Microsoft PowerPoint 2007: 
Formatting [continued] 

To change text alignment: 
1. Highlight the text. 
2. From the HOME TAB choose the desired alignment option (Left/Center/Right/Justify). 

To add bullets to text: 
1. Highlight the text to be bulleted. 
2. Select the BULLETS button  on the HOME TAB. 

Tips: To apply custom bullets, or to change the appearance of existing bullets, choose 
BULLETS drop-down menu. A bullet is added each time the ENTER key is pressed. 

Finishing Touches                                            

To add a transition between two slides: 
1. From the ANIMATIONS TAB click on a transition option in the TRANSITION TO THIS SLIDE GROUP. 
2. You can scroll through all options by moving the scroll bar on the right of the transition 

options box.  To see all options at one time click the MORE arrow at the bottom of the scroll 
bar. 
Tip: Select APPLY TO ALL to apply a transition to all of the slides in a presentation.  

To check the spelling in the presentation: 
1. Select the SPELLING button  on the REVIEW TAB. 
2. Follow the prompts to correct any misspelled words. 

To preview slide animation: 
1. From the ANIMATIONS TAB select PREVIEW.  
2. To edit, choose CUSTOM ANIMATION, Modify as needed and click PLAY. 
3. When the preview is complete, close the CUSTOM ANIMATION Task Pane.  

 

 

 

 

 



Infusing Technology into Social Studies 2007 Appendix                                          FUTUREKIDS, Inc. 

Copyright © 2007 FUTUREKIDS, Inc.  A 45 

Using Microsoft PowerPoint 2007: 
Finishing Touches [continued] 

 
To view the slide show presentation: 

1. From the SLIDE SHOW TAB choose FROM BEGINNING or FROM CURRENT SLIDE. 
2. Hit the SPACEBAR to transition between slides more quickly. 

Tip: Press the ESCAPE key to end the slide show and to return to Normal View. 

To set slide show options: 
1. From the SLIDE SHOW TAB choose SET UP SLIDE SHOW. 
2. Select the desired options and click OK. 

To change the page setup of the presentation: 
1. From the DESIGN TAB click on PAGE SETUP. 
2. Make the appropriate changes and click OK. 

To print a presentation: 
1. From the MICROSOFT OFFICE button choose PRINT  
2. Choose the appropriate options in the Print dialog box and click OK. 
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Spreadsheet Basics 
 

A spreadsheet application allows users to enter data, such as numbers and formulas, into an 
electronic worksheet and to use this data to perform multiple calculations.  A document created 
by this type of program is called a spreadsheet. 

The most popular spreadsheet applications are Microsoft Excel 2007 and Lotus 1-2-3. Programs 
such as AppleWorks and Microsoft Works contain spreadsheet components.  The Cruncher, by 
Knowledge Adventure, is a spreadsheet program for young children. 

 
 

  
 

Related Terms: 

absolute cell reference: a cell reference that does not change when a formula is copied or 
moved; contains a $ symbol before the column letter and row number 

active cell: the cell currently selected in a spreadsheet, identified by its black border 

cell: a rectangle in a spreadsheet, formed by the intersection of a row and a column, which can 
contain text, numbers or a formula 

cell reference: the coordinates of the column and row position of a cell, or a cell address 

column: a vertical line of cells in a spreadsheet, identified by a letter 

column heading: a letter at the top of a column that can be clicked to select the entire column  

column label: text at the top of a row that indicates the type of information in that column 

name box formula bar column 

cell 

row 

active cell 

row heading 

column heading select all 
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Spreadsheet Basics [continued] 

formula: a mathematical equation that performs a calculation in a cell; formulas follow a 
specific structure beginning with an equal sign (=) followed by the elements to be calculated (the 
operands) and the calculation operators 

formula bar: the bar at the top of a spreadsheet that displays the information contained or being 
entered in a cell 

function: a ready-to-use formula that performs common calculations, such as averages and sums 

name box: the box in a spreadsheet that lists the column letter and row number of a selected cell 
or a range of selected cells 

range: a single cell or a rectangular group of adjacent cells within a spreadsheet 

row: a horizontal line of cells in a spreadsheet, identified by a number 

row heading: a number at the far-left side of a row that can be clicked to select the entire  
row of cells 

row label: text at the left side of a row that indicates the type of information in that row 

worksheet: a spreadsheet containing cells in columns and rows 

Important symbols used in spreadsheet formulas: 

= equal sign: used at the beginning of each formula entered (e.g., =A2+B2-C2) 

+ addition sign: adds values (e.g., =A1+A2); also can be used at the beginning of a formula 
instead of an equal sign 

- subtraction sign: subtracts values (e.g., =B3-B4) 

* asterisk: multiplies values (e.g., =C2*C6) 

/ slash: divides values (e.g., =D1/D3) 

: colon: used to indicate a consecutive range of cells in a row or column (e.g., 
=SUM(A2:A10), indicating the sum of the values in cells A2 through A10) 

, comma: used to indicate a series of non-consecutive cells in a formula, (e.g., 
=SUM(B6,C12,D15), indicating the sum of the values in cells B6, C12 and D15) 

( ) parentheses: used in functions to indicate a range of values or cell references to be calculated 
(e.g., =AVERAGE(F1:F6), indicating the average of the values in cells F1 through F6) 
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Spreadsheet Basics: Charting Terminology 
chart: a visual representation of data  

labels: words or numbers, often found along the X axis and Y axis, which identify information in 
a chart 

legend: the part of a chart in which the colors or patterns used in the chart are displayed with the 
items they represent 

series: the basic unit of information in a chart, often contained in a single row or column. 

values: numeric entries within a spreadsheet 

X series: the labels and data charted along the X axis, or horizontal axis 

Y series: the labels and data charted along the Y axis, or vertical axis 

Bar chart: compares data or values horizontally without reference to trends over 
time 

Column chart: compares data or values vertically without reference to trends 
over time 

Line chart: shows trends or changes in values over time 

Pie chart: shows the ratio of individual values to a total, or parts to a whole 
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Using Microsoft Excel 2007 

To enter data into a cell: 
1. Click the desired cell. 
2. Use the keyboard to enter numbers or text; the entry will also appear in the Formula bar. 
3. Press the ENTER key to accept the entered information and to advance to the cell below.  

To edit the contents of a cell: 
1. Double-click the cell. 
2. Make the desired changes. 
3. Press the ENTER key. 

Tip: To replace the entire contents of a cell, single-click the cell and enter the new data. 

To increase the width of a column manually: 
1. Place the pointer on the right side of the heading of the column to be increased.  
2. When the pointer takes the shape of a double arrow, hold down the mouse button and drag to 

the right to widen the column. 
Tip: To make a series of columns the same width, select the appropriate columns, from the 

HOME TAB choose FORMAT, THEN WIDTH. Enter the desired width in the Column Width 
field and click OK. 

To change the width of a column using the AutoFit feature: 
1. Click the column heading to select the entire column.  
2. From the HOME TAB choose FORMAT, then WIDTH.  On the WIDTH drop-down menu choose 

AUTOFIT SELECTION. 

To select a range of cells: 
1. Click the first cell in the range and hold down the mouse button. 
2. Drag to highlight the desired cells in the range, then release the mouse button. 

To delete a row or column: 
1. Click the appropriate row or column heading to select the entire row or column. 
2. From the HOME TAB choose DELETE to delete the entire row or column.  

Tip: To delete a row or column’s contents without actually removing the cells from the 
spreadsheet, press the DELETE key on the keyboard instead of DELETE on the HOME TAB. 
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Using Microsoft Excel 2007 [continued] 

To insert a row: 
1. Click a cell in the row below where the new row will be inserted.  
2. From the HOME TAB choose the INSERT drop-down menu, and choose INSERT SHEET ROWS. 

To insert a column: 
1. Click a cell in the column to the right of where the new column will be inserted. 
2. From the HOME TAB choose the INSERT drop-down menu, and choose INSERT SHEET 

COLUMNS. 

To insert a new worksheet: 
 From the HOME TAB choose the INSERT  drop-down menu, and choose INSERT SHEET.  

Tip: To name the new worksheet, double-click the appropriate tab in the bottom-left corner 
of the screen and enter a new name.  

To protect a worksheet: 
1. From the HOME TAB choose the FORMAT drop-down menu then PROTECTION V  PROTECT 

SHEET. 
2. Enter a password (if desired) and select OK. 

Formulas and Calculations       

To enter a formula: 
1. Enter the equal sign followed by the desired formula, then press the ENTER key. 
2. Examples of basic formulas:   

• =45+67  
• =C4-C5 (the contents of C4 minus the contents of C5) 
• =D3*D6 (the contents of D3 multiplied by the contents of D6) 
• =A1/2 (the contents of A1 divided by 2) 

To copy a formula from one cell into a series of cells: 
1. Starting with the cell that already contains the formula; select the entire series of cells into 

which the formula will be placed. 
2. In the HOME TAB,  choose the FILL drop-down button  
3. You may fill DOWN, RIGHT, UP or LEFT. 
4. Click one of the highlighted cells to confirm that the cell references in the formula were 

updated properly. 
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Using Microsoft Excel 2007: 
Formulas and Calculations [continued] 

To sum a series of cells: 
1. Click the appropriate cell. 
2. Enter the sum formula into that cell.  
3. Sample sum formula: =SUM(E4:E8).  The contents of cells E4 through E8 will be added, and 

the sum will be displayed in the cell that was initially selected. 
 or 
1. Highlight the cells to be added. 
2. Choose the AUTOSUM button  on the HOME TAB, and the calculated total will be placed in 

the cell immediately below or to the right of the selected range. 
 or 
1. Click the cell in which the calculated sum should be displayed and choose the AUTOSUM 

button  on the HOME TAB. 
2. Accept the default cell range, or enter the corrected cell range in the formula bar. 
3. Press the ENTER key to accept the formula. 

To create a chart: 
1. Select the cells to be included in the chart. 
2. Choose the INSERT TAB then in the CHART GROUP choose a chart option. 
3. From the DESIGN TAB you may edit the specific features of your chart. 

To resize a chart: 
1. Click the chart to select it. 
2. Drag the handles to resize the chart. 

To reposition a chart: 
1. Click the chart to select it. 
2. Drag the chart to reposition it on the worksheet. 

To change the colors in a chart: 
1. Click the chart. The DESIGN, LAYOUT and FORMAT TABS will appear in the Ribbon. 
2. When you click on a specific area of the chart, this will be noted under the CURRENT 

SELECTION GROUP of the FORMAT TAB.  You may now edit the colors of the chart by choosing 
SHAPE FILL. 
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Using Microsoft Excel 2007: 
Formulas and Calculations [continued] 

To create an absolute cell reference: 
1. When entering a formula, place a dollar sign ($) before both the column letter and the row 

number of the cell or cells to be designated as absolute references. A sample formula would 
be =SUM($A$5:B6).  
Tip: In the above example, if the FILL or the COPY and PASTE commands are used to place the 

formula into additional cells, cell A5 will be referenced regardless of the new formula’s 
column and row position.  However, because the second cell in the formula is 
designated as a relative cell reference, it will change according to the location of the 
cell in which the formula is placed.  

To insert a function: 
1. Click the appropriate cell. 
2. Choose the FUNCTION WIZARD  from the FORMULAS TAB. 
3. Select the appropriate option from the Select a Function list and click OK. 
4. Verify that the correct cell range is shown in the Number1 box and make any necessary changes.  
5. Click OK. 

Formatting           

To bold text within a range of cells: 
1. Select the cells. 
2. Click the BOLD button  on the HOME TAB. 
 
To underline text within a range of cells: 
1. Select the cells. 
2. Choose the UNDERLINE button  on the HOME TAB. 

To italicize text within a range of cells: 
1. Select the cells. 
2. Click the ITALIC button  on the HOME TAB. 
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Using Microsoft Excel 2007: 
Formatting [continued] 

To format a spreadsheet by applying Format as Table: 
1. Select the cells to be formatted. 
2. On the HOME TAB choose FORMAT AS TABLE.   
3. Select a table style. 

To format numbers in cells as percentages: 
1. Select the cells to be formatted. 
2. On the HOME TAB choose the drop-down box in the NUMBER GROUP then choose PERCENTAGE 
3. You can also select the Dialog Box Launcher  in the NUMBER GROUP to open the FORMAT 

CELLS box.  On the NUMBER tab, select percentage from the Category list.  If necessary, 
change the value in the Decimal Places box, then click OK. 
Tip: This procedure can also be followed to customize appearance of existing percentages. 
or 

1. Select the cells to be formatted. 
2. Click the PERCENT STYLE button  on the NUMBER GROUP of the HOME TAB. 

To format numbers in cells as currency: 
1. Select the cells to be formatted. 
2. On the HOME TAB choose the drop-down box in the NUMBER GROUP then choose CURRENCY 

from the list. 
3. You can also select the Dialog Box Launcher  in the NUMBER GROUP to open the FORMAT 

CELLS box.  On the NUMBER tab, select CURRENCY from the Category list.  If necessary, 
change the value in the Decimal Places box and select different options from the Symbol and 
Negative Numbers drop-down lists, then click OK. 
or 

1. Select the cells to be formatted. 
2. Choose the CURRENCY STYLE button  on NUMBER GROUP of the HOME TAB. 

To format cell values with commas in the thousandth place: 
1. Select the cells to be formatted. 
2. Choose the COMMA STYLE button  on the NUMBER GROUP of the HOME TAB. 

To display cell values with an additional decimal place: 
1. Select the cells to be formatted. 
2. Choose the INCREASE DECIMAL button  NUMBER GROUP of the HOME TAB. 
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Using Microsoft Excel 2007: 
Formatting [continued] 

To display cell values with one fewer decimal place: 
1. Select the cells to be formatted. 
2. Click the DECREASE DECIMAL button  on the NUMBER GROUP of the HOME TAB. 

To change the font of characters within a cell: 
1. Select the cell(s) to be formatted. 
2. Choose the desired font from the Font drop-down list on the FONT GROUP of the HOME TAB. 

To fill a cell with color: 
1. Select the cell(s) to be formatted. 
2. Click the FILL COLOR drop-down arrow  on the FONT GROUP of the HOME TAB and 

choose a color from the pop-up menu. 

To change the color of characters within a cell: 
1. Select the cell(s) to be formatted. 
2. Click the FONT COLOR drop-down arrow  on the FONT GROUP of the HOME TAB and 

choose a color from the pop-up menu. 

To sort rows: 
1. Select the cells to be included in the sort.  
2. From the EDITING GROUP of the HOME TAB choose SORT & FILTER. 
3. From the SORT & FILTER drop-down list, select CUSTOM SORT to specify the column by which 

the information should be sorted.  
4. If you want to sort by column header, check MY DATA HAS HEADERS. 
5. As appropriate, click either A TO Z (ASCENDING ) or Z TO A (DESCENDING) from the ORDER 

drop-down list 
6. If sorting according to another column, click ADD LEVEL then make the desired selections in 

the Then By group(s). 
7. Click OK. 

or 
1. Select the cells to be included in the sort.  
2. Click the SORT A TO Z  button or the SORT Z TO A  button on the EDITING GROUP of the 

HOME TAB. 
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Using Microsoft Excel 2007: 
Formatting [continued] 

To add headers or footers to a printed worksheet: 
1. Choose FILE V PAGE SETUP. 
2. Select the HEADER/FOOTER tab. 
3. Choose the desired header text from the HEADER drop-down list or the desired footer text 

from the Footer drop-down list, then click OK. 
 or 
1. Click the CUSTOM HEADER or CUSTOM FOOTER buttons, enter the desired text in the 

appropriate column and choose OK.  
2. Click OK again. 

To insert a picture into the worksheet: 
1. From the INSERT TAB choose the PICTURE logo.   
2. Locate and select the desired graphics file and select INSERT. 
 or 
1. From the INSERT TAB choose the CLIP ART logo.   
2. Enter a keyword or keywords in the Search For box, then press the ENTER key or choose GO. 
3. Click on the desired clip art.  It will be automatically inserted into the spreadsheet. 

To change the page orientation: 
1. On the PAGE LAYOUT TAB choose ORIENTATION. 
2. From the drop-down menu select PORTRAIT or LANDSCAPE. 

To modify print options: 
1. On the PAGE LAYOUT TAB you can modify print settings from the PAGE SETUP GROUP. 
2. You can also access all PAGE SETUP options by pressing  in the PAGE SETUP GROUP. 
3. Select the SHEET TAB, then enter or choose the desired print options. 
4. Click OK to return to the spreadsheet or select PRINT. 
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Database Basics 
Data is information that can be processed and from which conclusions can be inferred. A 
database is a collection of related information. A database application is a computer program 
that allows users to enter, update, organize and retrieve information. Popular database 
applications today include Microsoft Access 2007, FileMaker Pro, Lotus Approach and 
Microsoft Visual FoxPro. There are also database components in AppleWorks and Microsoft 
Works. Database programs designed for children include Tabletop Jr., Tabletop Sr. and 
ClarisWorks for Kids. 

Although most databases today are stored on computers, databases can also be stored in paper 
form, such as a Rolodex or index cards. A box of index cards containing recipes is an example of 
this type of database. A field is the location reserved for a category of information within a 
database. Fields in a recipe database could include recipe name, ingredients, preparation time, 
directions and serving size. A record is a complete unit of categorized information. In the recipe 
example, each recipe written on a single index card would be a record. Form is the term often 
used to describe the display of one record at a time. Many users prefer to use a form when 
entering information into a database. 

 
 

A table is a way of displaying information in a database in which records appear in rows and 
fields appear in columns. The basic layout of a database table is similar to that of a spreadsheet.  
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Database Basics [continued] 

Sorting is rearranging data so it appears in ascending or descending order, either alphabetically 
or numerically. To sort information in a database, a field must be specified. A database can also 
be sorted by multiple fields. 

A filter is a set of criteria applied to records to show a subset of the records. Mathematical 
operations can be applied to build the criteria, including greater than (>), less than (<), greater 
than or equal to (>=), less than or equal to (<=) and not equal to (<>). And, or and not are 
Boolean operators, which are used to specify the logical relationship between values. All of 
these terms can be used to broaden or narrow a filter. 

Specifying criteria with a query is a method that can be used to indicate what records should be 
retrieved. Queries are more flexible and more advanced than filters, although both queries and 
filters can perform the same basic functions. If desired, queries can also be saved so the search 
results can be accessed in the future. 

Mail merge allows information in a database to be inserted into a word processing document to 
create individualized letters, envelopes and labels. The most common way that mail merge is 
used is to personalize form letters. 

A report is a way of printing the information in a database. There is considerable flexibility in 
the generation of reports. All aspects of the layout, as well as which fields and records are 
included, can be specified. 
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Using Microsoft Access 2007 
 

 

 
A table in Datasheet View can be used to add, edit or view the data in a table. Also in this view, 
it is possible to print the table, to sort or filter the records, to modify the appearance of the data 
and to insert or delete columns (fields) and rows (records). 

 

 

 

In Design View, an existing table’s fields can be added, deleted or customized. Also, a new table 
can be created from scratch.  
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Using Microsoft Access 2007 [continued] 
 

 
A form in Form View displays one record at a time, and this view is often used to enter and edit 
information within a database. In Form View it is also possible to sort and filter records. 

 

 

 

The appearance of a form can be modified in Design View.  The label text can be edited and 
formatted.  Fields can be added, moved and resized.  Text color, background colors and graphics 
can be added, and header and footer text can be inserted. 
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Using Microsoft Access 2007 [continued] 
 

 

 
A report in Print Preview is displayed the way that the report will be printed. A report is an 
effective way to present data in a printed format.  
 

 

 
The appearance of a report can be modified in Design View.  Label text, header and footer text, 
graphics and colors within a report can be altered in this view, with formatting options similar to 
those available for a form in Design View. 
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Using Microsoft Access 2007: Basic Database 
Management, Editing and Formatting 

 
To create a new database: 
1. From the MICROSOFT OFFICE button   choose NEW.  
2. In the NEW BLANK DATABASE Task Pane, select BLANK DATABASE.  
3. Enter a name in the File Name box on the right hand side of the screen.  Click on the file 

folder button  to navigate to the location where the database should be saved, click OK and 
then choose CREATE. 

 
To rename a table or a form within a database: 
1. In the Database window, select the appropriate icon and right-click the name of the file to be 

changed. 
2. Select RENAME and enter the new name. 
3. Press the ENTER key on the keyboard. 
 
To copy text: 
1. Highlight the text to be copied. 
2. Select the COPY button  on the HOME TAB. 
 
To cut text: 
1. Highlight the text to be cut. 
2. Select the CUT button  on the HOME TAB. 
 
To paste text that has been cut or copied: 
1. Position the cursor where the text will be inserted. 
2. Select the PASTE button  on the HOME TAB. 

Tip: The most recently copied or cut text will be pasted. 
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Using Microsoft Access 2007: Creating Tables 
 
To create a table: 
1. In the Datasheet view, click the TABLE button  on the CREATE TAB.  
2. To enter the first field name, double-click the field name Add New Field. 
3. Enter the name for the first field then press the ENTER key to add another field. 
4. Repeat until all the necessary fields have been added. 
or 
1. In the Design View, click the TABLE DESIGN button  on the CREATE TAB. 
2. Enter the appropriate field names and click the SAVE button.   
3. Enter the table name and click OK.  
 
To switch between Design View and Datasheet View of a table: 

 Select the VIEW button  on the HOME TAB. 
Tip: The VIEW button toggles between the DESIGN icon  and the DATASHEET icon  

depending upon the current view. 
 
To choose a primary key in a table: 
1. In Design View, position the cursor in the row to be designated the primary key. 
2. Click the PRIMARY KEY button  on the DESIGN TAB in the TOOLS GROUP. 

Tip: Each entry in the primary key field must be unique. 
 
To change a field’s data type in a table: 
1. In Design View, position the cursor in the data type field to be changed. 
2. Select the desired data type from the DATA TYPE drop-down menu on the DATASHEET TAB. 
 
To change a field size in a table: 
1. In Datasheet View, position the pointer on the field name’s right or left border. 
2. When the pointer takes the shape of a double-arrow, drag to widen the field.  
 
To select an entire field (column) in a table: 

 Click the field name at the top of the column. 
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Using Microsoft Access 2007:  
Creating Tables [continued] 

 
To add a row (record) to a table: 

 In Datasheet View, select the NEW button  in the RECORDS GROUP on the HOME TAB. 

Tip: The new record will be inserted at the bottom of the table. 
 
To add a field to a table: 
1. In Datasheet View, position the cursor in the column to the right of where the new column 

will be inserted.  
2. Select the INSERT COLUMN button  on the DATASHEET TAB. 

or 
1. In Design View, position the cursor in the row above where the new row will be inserted. 
2. Select the INSERT ROWS button  on the DESIGN TAB. 
 
To delete a row (record) from a table: 
1. In Datasheet View, position the cursor within the record to be deleted. 
2. On the HOME TAB, click the drop-down arrow next to the DELETE button  and select 

DELETE RECORD.  
3. Click YES to confirm the deletion. 

or 
1. Select the record to be deleted by clicking in the box to the left of the first field.  
2. Click the DELETE button  on the HOME TAB. 
3. Click YES to confirm the deletion. 

Tip: Once a record has been deleted, it cannot be retrieved. 
 

To delete a column (field) from a table: 
1. In Datasheet View, select the column to be deleted by clicking on the field name at the top of 

the column. 
2. Click the DELETE button  on the HOME TAB. 
3. Click YES to confirm the deletion of the field. 
 or 
1. In Design View, position the cursor in the row to be deleted. 
2. Choose the DELETE ROWS button  on the DESIGN TAB. 
3. Click YES to confirm the deletion of the field. 
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Using Microsoft Access 2007:  
Creating Tables [continued] 

 
To change the gridline layout in a table: 

 In Datasheet View, click the GRIDLINES button  on the HOME TAB and make the desired 
selection. 

 
To change the gridline color in a table: 
1. In Datasheet View, click the Dialog Box Launcher button  on the HOME TAB in the bottom 

right-hand corner of the FONT GROUP to open the DATASHEET FORMATTING box. 
2. In the Datasheet Formatting dialog box, make the desired selection from the GRIDLINE COLOR 

drop-down list and click OK. 

Creating Forms          
 
To create a form: 
1. On the CREATE TAB in the Database window, click the MORE FORMS drop-down arrow and 

select FORM WIZARD.   

2. Make the appropriate selections to create the form. 
 
To add a record to a form: 
1. In Form View, click the NEW button  on the HOME TAB. 

or 
2. In Form View, choose the NEW (BLANK) RECORD button   in the bottom-left corner of  

the window. 
 

To delete a record from a form: 
1. In Form View, display the record to be deleted. 
2. On the HOME TAB, click the drop-down arrow next to the DELETE button  and select 

DELETE RECORD.  
3. Click YES to confirm the deletion. 

Tip: Once a record has been deleted, it cannot be retrieved.  
 
To advance one record in Form View: 

 Select the NEXT RECORD button  in the bottom-left corner of the window. 
Tip: To advance to the final record, select the LAST RECORD button.   
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Using Microsoft Access 2007:  
Creating Forms [continued] 

 
To view the preceding record in Form View: 

 Select the PREVIOUS RECORD button  in the bottom-left corner of the window. 
Tip: To advance to the first record, select the FIRST RECORD button.    

 

Sorts, Filters, Queries and Reports    
 
To edit an existing table, query, form or report: 
1. In the Navigation Pane of the Database window, select the appropriate icon for the file to be 

edited. 
2. Right-click the file to be edited and choose OPEN or DESIGN VIEW. 
 
To sort a table or form by one field: 
1. In Datasheet View or Form View, position the cursor in the field to be sorted. 
2. Select either the ASCENDING button  or the DESCENDING button   in the SORT & FILTER 

GROUP on the HOME TAB. 
 
To sort a table or form by more than one field: 
1. In Datasheet View or Form View, click the ADVANCED FILTER OPTIONS button   on the 

HOME TAB. 
2. Select ADVANCED FILTER/SORT from the menu. 
3. Position the cursor in the Field box in the grid’s first column. 
4. From the drop-down list that appears, select the field to be sorted. 
5. Position the cursor in the corresponding Sort box. 
6. Select ASCENDING or DESCENDING from the drop-down list. 
7. In the neighboring columns in the grid, choose additional fields to sort. 
8. After all of the fields have been set, click the ADVANCED FILTER OPTIONS button and select 

APPLY FILTER/SORT. 
Tip: The field farthest to the left in the design grid will be sorted first. 

 
To remove a sort or a filter from a table or form: 

 In Datasheet View or Form View, click the REMOVE ALL SORTS button  on the HOME TAB.
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Using Microsoft Access 2007:  
Sorts, Filters, Queries and Reports [continued] 

 
To perform a filter in a table or form: 
1. In Datasheet View or Form View, click the ADVANCED FILTER OPTIONS button.   
2. Select ADVANCED FILTER/SORT from the menu. 
3. Position the cursor in the Field box in the grid’s first column. 
4. From the drop-down list that appears, select the field to be filtered. 
5. Position the cursor in the corresponding Sort box. 
6. Select ASCENDING, DESCENDING or NOT SORTED from the drop-down list. 
7. Position the cursor in the corresponding Criteria box. 
8. Enter the desired value or expression. 
9. Click the ADVANCED FILTER OPTIONS button and select APPLY FILTER/SORT. 

Tip: To perform additional sorts or filters on the filtered data, click on the small filter 
graphic in the field which has been filtered.  A pop-up menu will appear. 

 
To create a query: 
1. In Datasheet View, on the CREATE TAB click the QUERY DESIGN button.   
2. In the Show Table window, choose the table to be used in the query on the TABLES TAB and 

click ADD.  Close the Show Table window. 
3. Position the cursor in the Field box in the grid’s first column. 
4. From the drop-down list, select the field to be included in the query. 
5. Make the desired selection from the Sort drop-down list and enter the desired value in the 

Criteria box. 
6. In neighboring columns in the grid, add other fields to be included in the query and enter the 

desired sorting and criteria information. 
7. Select the RUN button  from the DESIGN TAB. 
 
To save a query: 
1. Click the SAVE button  on the QUICK ACCESS TOOLBAR on the top left. 
2. Enter a query name and select OK. 
 
To create a report: 
1. Click the REPORT WIZARD button  on the CREATE TAB. 
2. Follow the instructions in the Report wizard and select FINISH when completed. 
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Using Microsoft Access 2007 [continued] 
 
To start a mail merge document: 
1. Launch Microsoft Word 2007. 
2. On the MAILINGS TAB, click START MAIL MERGE and select STEP BY STEP MAIL MERGE WIZARD 

from the drop-down menu.  
3. Choose a document type from the Mail Merge pane.  For example, select the DIRECTORY 

document type to create a continuous document of entries, such as a bibliography.  
4. At the bottom of the Mail Merge pane, click NEXT: STARTING DOCUMENT to continue to the 

next step.  
5. Select the starting document and click NEXT: SELECT RECIPIENTS. 
 
To link the mail merge document to an Access database: 
1. Choose the USE AN EXISTING LIST radio button then click the BROWSE button to locate the data 

source for the recipients. 
2. In the FILES OF TYPE list, choose ALL DATA SOURCES then locate the desired database file.  
3. Select the table or query containing the desired data and click OK. 
4. Review the list of recipients to include and click OK. 
5. Click NEXT: WRITE YOUR LETTER. 
 
To add merge fields to the mail merge document: 
1. Position the cursor where the first field will be placed on the page.  
2. Select the desired item to merge from the Mail Merge pane.  
3. Verify that the example is correct.  If it is correct, click OK to close the window.  If it is 

incorrect, click the MATCH FIELDS button to fix any errors.  
4. Continue this process for all desired merge fields.  
 
To merge the mail merge document with the data source: 
1. Click the NEXT: PREVIEW YOUR LETTERS button.  At the top of the Mail Merge pane, use the 

double arrows to preview all of the documents.  
2. Click the NEXT: COMPLETE THE MERGE button.  Individual documents may now be edited if 

desired.  The merged documents can also be printed now. 
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Using Microsoft SharePoint 
Designer 2007 

N 
 
 

 
 

 

 

To open an existing Web project: 
1. Select FILE V OPEN. 
2. Locate the Web (.html, .htm, .asp) file containing the first page of the Web project 

and click OPEN. 

To create a new Web page: 
1. Choose FILE V  NEW V  PAGE. 
2. In the New dialog box, choose GENERAL for a standard HTML page, or choose 

one of the CSS Layouts or Frames Pages for specific needs. 
3. Click OK. 
Tip: ASP.Net options are for advanced programmers.  

To save a Web project: 
1. Choose FILE V SAVE. 
2. Locate the folder in which you wish to save the Web project and click SAVE. 
3. When the Save Embedded Files dialog box appears, verify that all component 

files are saved in the Web project folder and click OK. 
Tip: A Web project is composed of one or more linked HTML files, each 

representing one page of the project, along with files containing any 
components embedded in the HTML pages, such as pictures or music.  The 
collection of files that make up a Web project is typically organized in one 
folder for convenience. 

Open 

Save 

Preview in 
Browser 

Hyperlink

Standard Toolbar 

Formatting Toolbar 

New 
Page/Web 

Insert 
Picture 
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Using Microsoft SharePoint Designer 2007: 
Inserting Objects 

 

To insert a hyperlink to a file: 

1. Highlight the image or text that will serve as the starting point for the hyperlink. 
2. Choose INSERT V HYPERLINK. 
3. In the Insert Hyperlink dialog box, click the BROWSE THE WEB button  or the 

BROWSE FOR FILE button  to locate the destination file, or ending point, for the 
hyperlink and click OK. 

To insert a hyperlink to a location within a page: 
1. Mark the destination, or ending point, for the hyperlink by highlighting an image 

or text and selecting INSERT V BOOKMARK. 
2. Enter a name for the bookmark and click OK. 
3. Create the hyperlink by selecting the starting image or text for the hyperlink and 

choosing INSERT V HYPERLINK.  
4. Delete any text in the Address box. 
5. Click BOOKMARK.  Select the bookmark name from the Select Place in Document 

dialog box and click OK twice.  

To insert a picture: 
1. Choose INSERT V PICTURE V CLIP ART. 
2. Locate and click the desired clipart picture and select INSERT from the popup 

menu. 
or 
1. Choose INSERT V PICTURE V FROM FILE. 
2. In the Picture dialog box, locate the desired picture file and click INSERT. 
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Using Microsoft SharePoint Designer 2007: 
Inserting Objects [continued] 

To insert sound or music: 
1. Choose FILE V PROPERTIES. 
2. On the GENERAL TAB, select the BROWSE button in the Background Sound group. 
3. Locate the desired music or sound clip and click OPEN. 
4. Make sure that the FOREVER checkbox is selected or choose a number in the Loop 

spin box, then click OK. 

To insert a button: 
1. Choose INSERT V INTERACTIVE BUTTON. 
2. In the Interactive Buttons dialog box, choose a button from the Buttons list. 
3. Enter the text that should appear on the button in the Text box. 
4. Select the BROWSE button to locate a destination for the button’s hyperlink. 
5. Choose a font and text size on the FONT TAB. 
6. Select the colors and size of the button on the IMAGE TAB and click OK. 

To insert a horizontal line: 
1. Choose TASK PANES V TOOLBOX.  The TOOLBOX will appear to the right of the 

main .htm pane. 
2. Double-click on HORIZONTAL LINE. 

To insert scrolling text: 
1. Choose INSERT V WEB COMPONENT.  Make sure DYNAMIC EFFECTS is selected 

under Component Type and select MARQUEE under Choose an Effect. Click 
FINISH. 

2. Enter the text in the Text box. 
3. Select LEFT or RIGHT for the direction and click OK. 
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Using Microsoft SharePoint Designer 2007: 
Inserting Objects [continued] 

To insert a background picture: 
1. Select FORMAT V BACKGROUND. 
2. On the FORMATTING TAB, select the BACKGROUND PICTURE checkbox. 
3. Click the BROWSE button. 
4. Locate the desired picture and click OPEN.  
5. Click OK to close the Page Properties window. 

 

Designing a Page or Web Project       

To choose a background color: 
1. Select FORMAT V BACKGROUND. 
2. On the FORMATTING TAB, click the BACKGROUND drop-down arrow, choose a 

color and click OK.  

To preview a Web page as it would appear in a Web browser: 
 Choose FILE V PREVIEW IN BROWSER and select the appropriate browser from the 

list. 
or 

 Click the arrow next to the PREVIEW IN BROWSER button  on the Standard 
Toolbar and select the appropriate browser from the list. 
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Miscellaneous Topics: 
Creating a Screen Shot 

 

A screen shot is a graphic image of what appears on the computer screen.  Screen shots can be 
helpful in acquiring an image of something on the screen for incorporation into another 
document.  Remember that the screen shot will include everything that appears on your monitor. 

Follow the steps below to create, insert and size a screen shot.  

1. Choose an image that you want to insert into another document. You may want to choose 
a graphic, a picture file, or the desktop itself. 

2. Press the PRINT SCREEN key on the upper right side on the keyboard to copy the image on 
the screen to the Clipboard.  Note: The screen shot shows everything that appears on the 
computer screen. If you only want one small part or area of the screen shot, launch Paint 
by selecting START V PROGRAMS V ACCESSORIES V PAINT. Select EDIT V PASTE. Choose 
the SELECT tool or the FREE-FROM SELECT tool and select only the area that you want. 
Select EDIT V COPY or EDIT V CUT and close Paint. 

3. Open the application into which you want to insert the screen shot, for example Word 
2007.  

4. From the MICROSOFT OFFICE button  in the top left corner choose NEW. 
5. From the HOME TAB click on the PASTE button. 

6. Your screen shot will have the Windows frame around it. To eliminate the frame and 
insure that you have exactly the image desired, click on the image. 

7. Go to the PICTURE TOOLS/FORMAT TAB. 

8. Click on the CROP tool  from the SIZE GROUP.  

9. Position the CROP tool on the handles of the screen shot and crop unneeded portions of 
the image. 

10. If you desire to change the size of the image, adjust the vertical and horizontal 
measurements on the SIZE GROUP on the FORMAT TAB. An alternative method to re-size 
the image is to click on the image, position the cursor at any corner and drag the image to 
the desired size. 
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Miscellaneous Topics: Troubleshooting Tips 
 
Common problems and solutions: 

Problem: After the computer starts up, a blank screen appears. 

Potential Solutions: 
Be certain that the monitor is turned on.  Check for the lights on the surge protector (if 
applicable), the system unit and the monitor indicating that electricity is traveling through that 
component. Check the cable connections to and from each component, in case they have become 
loose. 
If these measures do not solve the problem, insert a boot disk and restart the machine.  An 
emergency boot disk is packaged with diagnostic programs such as Norton Utilities.  A boot disk 
can also be created in Microsoft Windows by selecting the ADD/REMOVE PROGRAMS icon from the 
Control Panel, choosing the STARTUP DISK tab and following the directions.  If the computer does 
not start using a boot disk, the problem may be with the hardware.  The appropriate hardware 
vendor should be contacted for service instructions. 
 
Problem: When attempting to print, nothing happens. 

Potential Solutions: 
Verify that the printer is turned on and check the cable connections. Look at the lights on the 
printer to see whether an error is indicated. If so, check the printer manual for interpretations and 
solutions: the printer could be out of paper or have a paper jam. Check the printer status by 
choosing START V SETTINGS V PRINTERS, then double-clicking the printer in question. Try 
printing another document or printing from another program (such as WordPad) to see whether 
the problem is with the particular file or application. 
 
Problem: The computer is frozen. 

Potential Solutions: 
If possible, select the CANCEL or CLOSE button.  If the computer is still not responding, press the 
CONTROL, ALT and DELETE keys simultaneously.  From the Close Program dialog box, select the 
application that is not responding and click END TASK.  If the computer is still frozen, the 
CONTROL, ALT and DELETE key combination can be used to restart the computer.  The reset 
button on the computer system unit may need to be used to restart the computer. If the reset 
button does not work, turn the computer off, wait 15 seconds or so and turn it back on.  Windows 
should detect that the computer was not shut down properly and will execute the Scandisk 
program to check the hard drive for errors.  If the computer freezes each time the same particular 
action is performed, it may help to reduce the number of files or applications open at one time. 



FUTUREKIDS, Inc.                                          Infusing Technology into Social Studies 2007 Appendix 

A 74                    Copyright © 2007 FUTUREKIDS, Inc. 

Miscellaneous Topics: 
Troubleshooting Tips [continued] 

 
Problem: A “not enough memory” error message appears. 

Potential Solutions: 
Try restarting the computer and launching the program again.  If the message still appears, 
disable the programs that automatically start up.  To do so, select START V SETTINGS V 
TASKBAR & START MENU.  Choose the START MENU PROGRAMS tab, then the ADVANCED button 
and select the PROGRAMS folder.  Move the shortcuts from the Startup folder into another folder, 
and restart the computer.  If the error message continues to appear, try removing unnecessary 
files (such as unnecessary or backed-up documents) from the hard drive to free space that 
Windows can use for memory management. 
 

Problem: A “not enough disk space” message appears when installing a program or when 
copying files to the hard drive. 

Potential Solutions: 
Right-click the RECYCLE BIN icon on the desktop, and choose EMPTY RECYCLE BIN . Check the 
amount of free hard drive space by right-clicking the HARD DRIVE icon in Windows Explorer and 
selecting PROPERTIES.  Choose the TOOLS tab and select CHECK NOW to check the hard drive for 
errors that may be taking up space.  To free some hard drive space, back up files to floppy disks 
or delete files that are no longer needed.  
To help prevent this type of problem, consider compressing the hard drive before it becomes too 
full.  To do so, select START V PROGRAMS V ACCESSORIES V SYSTEM TOOLS V DRIVESPACE. 
 

Problem: No sound is heard from the speakers. 

Potential Solutions: 
Verify that the speakers are turned on and check the volume knob and the cable connections.  Be 
certain that the speakers are connected to the correct jack (often labeled Out or Speaker Out).  
From the Control Panel, double-click the SOUNDS icon and determine if sound is heard when the 
name of a sound is highlighted and the PLAY button selected.  From the Control Panel, double-
click the MULTIMEDIA icon, select the AUDIO tab and adjust the Playback volume control. 
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Miscellaneous Topics: 
Troubleshooting Tips [continued] 

 
Problem: A software program does not run properly. 

Potential Solutions: 
First, create backups of any document files created by the program.  Double-click the 
ADD/REMOVE PROGRAMS icon in the Control Panel window, choose CHANGE/REMOVE and follow 
the instructions to uninstall the program.  If problems still persist, right-click the HARD DRIVE 
icon in Windows Explorer and select PROPERTIES.  Verify that there is adequate hard drive space 
available.  Choose the TOOLS tab, then select CHECK NOW and DEFRAGMENT NOW.  Reinstall the 
program. 
 

Problem: An error occurs when copying a file or when installing software. 

Potential Solutions: 
The actual file being copied could be damaged.  Try copying the file or installing the program on 
other computers.  If the same error message occurs during the same process on a few different 
machines, the floppy disk or CD-ROM could be defective or could contain a corrupt file.  The 
appropriate software manufacturer must be contacted to receive replacement disks. 
 

Problem: The colors on the screen appear unnatural. 

Potential Solutions: 
The monitor display settings may need to be changed.  Double-click the DISPLAY icon in the 
Control Panel window and click the SETTINGS tab.  Choose a different option in the COLOR 
QUALITY drop-down list.  Also, from the SETTINGS tab, select ADVANCED and click the MONITOR 
tab to verify that the correct monitor is chosen.  If not, select CHANGE and choose another 
monitor. 
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Office 2007 Tips and Tricks 
 

The Ribbon           
The menus and toolbars in some programs have been replaced with the Ribbon, a panel that runs 
along the top of each application window.  

 

 

 

 

 

 

The Ribbon is divided into a series of tabs.  In Word, for example, you will see tabs for Home 
(the default tab view), Insert, Page Layout, References, Mailings, Review, and View.  There are 
also tabs that only appear when needed.  So, for example, if you insert a table in Word, you'll get 
a new Table tab, or if you insert a picture, you will see a Picture tab. 

Commands are organized in logical groups, which are collected together under the tabs.  
 The groups on each tab are organized to help you complete a task. 
The Ribbon can be found in Office Access 2007, Office Excel 2007, Office PowerPoint 2007, 
Office Word 2007 and Office Outlook 2007. 

Microsoft Office Button Quick Access Toolbar 

Tab 

Group 
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Office 2007 Tips and Tricks [continued] 
 
Microsoft Office Button         
The Microsoft Office Button  replaces the file menu. When you click the Microsoft Office 
Button, you see the same basic commands available in earlier releases of Microsoft Office to 
open, save, and print your file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Quick Access Toolbar         
Tools or commands that are not as readily available as you would like can be easily accessed by 
adding them to the quick access toolbar.  To add a button right click on a feature in a tab, then 
click ADD TO QUICK ACCESS TOOLBAR.  You may remove a button the same way, by right clicking 
and choosing REMOVE FROM QUICK ACCESS TOOLBAR. 
 
 
Saving a File            
Office 2007 saves files in a slightly different format, as compared to previous Office versions.  
To ensure you can access your 2007 files in other versions of Office, you must click on SAVE AS 
from the File menu.  Choose [Office Program] 97-2003 [File Type] from the SAVE A COPY OF 
THE [FILE TYPE] list.  Name the file and click SAVE. 
 
For example from Word, you would choose Word 97-2003 Document from the SAVE A COPY OF 
THE DOCUMENT list. 
 
 
 
 
 

Microsoft Office Button 

File 
Menu 

Quick Access Toolbar
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Glossary 
 

absolute cell reference: a cell reference that does not change when a formula is copied or 
moved; contains a $ symbol before the column letter and row number 
 
active cell: the cell currently selected in a spreadsheet, identified by its black border 
 
animation: a series of still images displayed in rapid succession to create the illusion of 
movement 
 
background: the layer in which text and images that appear in the same location on every page 
of a document are placed 
 
Boolean operators: words used to specify a logical relationship And, or and and not are Boolean 
operators 
 
bullets: symbols (often a solid circle or square) used to distinguish items in a list 
 
branching slide: a slide that is linked to another slide in a presentation, providing users with a 
choice of which slide to view next 
 
cell: a rectangle in a spreadsheet, formed by the intersection of a row and a column, which can 
contain text, numbers or a formula 
 
cell reference: the coordinates of the column and row position of a cell, or a cell address 
 
clip art: previously created digital artwork that is intended to be integrated into documents 
 
column: a vertical line of cells in a spreadsheet, identified by a letter  

column heading:  a letter at the top of a column that can be clicked to select the entire column  
 
column label: text at the top of a row that indicates the type of information in that column 
 
data: information that can be processed and from which conclusions can be inferred 
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Glossary [continued] 
 
database: a collection of related information 
 
database application: a computer software program that allows users to enter, update, organize 
and retrieve information 
 
digitalization: the process of transferring a film or video image to a format that a computer can use 
 
field: the location reserved for a category of information within a database 
 
filter: a set of criteria applied to records to show a subset of the records 
 
footer: the text or graphics that appear at the bottom of a page 
 
foreground: the layer in which the text and images that vary from page to page in a document 
are placed 
 
formula: a mathematical equation that performs a calculation in a cell; formulas follow a 
specific structure beginning with an equal sign (=) followed by the elements to be calculated (the 
operands) and the calculation operators 
 
formula bar: the bar at the top of a spreadsheet that displays the information contained or being 
entered in a cell  

frames: a term related to the viewing and layout style of a Web site in which two or more Web 
pages are loaded at the same time within the same screen; Web pages with frames contain scroll 
bars for each embedded page that can be viewed independently 
 
Function: a ready-to-use formula that performs common calculations, such as averages and 
sums 
 
Greek text: a block of nonsensical text that represents the size and position of text so the 
aesthetics of the page design can be evaluated 
 
grouping: joining together separate objects so the components can be manipulated as one object 
 
hot spot: an area on the screen that can be selected to trigger an action, such as playing a sound, 
animating a graphic or displaying a different slide 
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Glossary [continued] 
 
HyperText Markup Language (HTML): the special code that allows the Web browser to 
display the layout of a document 
 
HyperText Transfer Protocol (HTTP): the Internet standard that enables access to documents 
on the World Wide Web 
Importing: the process of inserting text or graphics that originated in one program into another 
program 
 
landscape: the page orientation in which the page is wider than it is tall 
 
layers: invisible sheets on which users can place text or graphics so the objects are independent 
of other objects on other sheets 
 
layout: the process of arranging text and graphics on a page 
 
layout guides: nonprinting lines that can be helpful when placing text and graphics within a 
document  
 
linking: connecting text frames so that the excess text from the first frame flows into the second 
frame 
 
mail merge: merging database information and word processing to create individualized letters, 
envelopes and labels 
 
medium: a single method used to communicate a message to an audience, including video, 
sound, text and graphics 
 
name box: the box in a spreadsheet that lists the column letter and row number of a selected cell 
or a range of selected cells 
 
picture frame: a movable and resizable placeholder for a graphic 
 
points: a font measure.  One inch is equal to 72 points, and one centimeter is equal to 28 points.  
Font sizes of 10 point or 12 point are common for text in the body of documents. 
 
Portrait: the page orientation in which the page is taller than it is wide 
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Glossary [continued] 
 
pull quote: a short phrase set in a larger type size that repeats information found within the 
article 
 
query: a method used to specify criteria to indicate what records should be retrieved from a 
database 
 
range: a single cell or a rectangular group of adjacent cells within a spreadsheet 
 
Record: a complete unit of fields (categorized information) 
 
row: a horizontal line of cells in a spreadsheet, identified by a number 
 
row heading: a number at the far-left side of a row that can be clicked to select the entire row of 
cells 
 
row label:text at the left side of a row that indicates the type of information in that row 
 
rulers:on-screen bars that measure the page horizontally and vertically 
 
scratch area:the nonprinting work area in which text and graphics can be placed before they are 
moved into a document 
 
slide: a screen in a PowerPoint presentation resembling an index card, on which users may 
arrange media elements 
 
slide master: a special slide that can be used to determine the layout and formatting of all slides 
in a presentation  
 
slide show: in presentation programs, several screens of information organized in a  
particular sequence  
 
smart tags: a set of buttons shared across Office 2007 applications, smart tags appear as needed 
to provide options for completing a task quickly 
 
sorting: rearranging data so that it appears in ascending or descending order, either 
alphabetically or numerically 
 
spreadsheet: a document created by a spreadsheet application  
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spreadsheet application: allows users to enter data, such as numbers and formulas, into an 
electronic worksheet and to use this data to perform multiple calculations  
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Glossary [continued] 
 
storyboard: a series of panels on which a set of sketches is arranged for planning purposes 
 
table: Information displayed in rows and columns 
 
task panes: located on the right side of the screen, allows users to access important tasks such as 
performing searches, opening documents, viewing the Clipboard, formatting documents and 
more 
 
text alignment: (also known as justification) refers to how text appears in relation to the left and 
right margins 
 
text frame: a placeholder for text, which can be moved or resized 
 
text wrapping: the way that text flows around a graphic 
 
transition: the special effect that occurs when one slide advances to the next in a presentation 
 
Uniform Resource Locator (URL): A Web page’s address, often beginning with http://www 
 
wizard: a Help feature that guides users through multi-step processes to create common 
documents 
 
Word wrap: a word processing feature that automatically moves continuing text to the line 
below when the previous line becomes full. 
 
Worksheet: a spreadsheet containing cells in columns and rows 
 

 
 
 

 

 


